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1  
INTRODUCTION 

1 . 1  T H A N K  Y O U  

Thank you for your interest in the bowtie methodology and BowTieXP software. Risk management 
professionals worldwide have discovered the value in implementing this methodology by using 
BowTieXP; a powerful and easy-to-use tool. 

1 . 2  S T R U C T U R E  O F  T H I S  D O C U M E N T  

This document is divided into the following parts: 
 
1. Step by step guides to get you started: 

• Chapter 2, Quick installation guide on page 11. This guide quickly describes how to install 
BowTieXP on your computer. 

• Chapter 3, Quick getting started guide on page 14. This guide briefly discusses bowtie 
methodology and then gives a step-by-step guide on how to create a bowtie diagram using the 
software. Some important software concepts are explained. 

 
2. Chapter 4, A deeper look at the bowtie method starting on page 40 gives a theoretical background 
and tutorial in bowtie methodology. The tutorial contains many examples on what to do and what 
not to do.  
 

Note: Due to the length of the theory chapter, we have made it into a separate document. Chapter 4 provides an 
overview of the contents. Contact us at support@cgerisk.com to see if you are eligible for a copy. 

 
3. In chapter 5, The different BowTieXP versions on page 41, we give an overview of what features 
are present in each version of BowTieXP so you can see the differences between the versions at a 
glance. 
 
4. A full task-based manual describing every detail about the software. All details and features are 
described in chapters that orient about a specific task: 

• Chapter 6, Introducing BowTieXP on page 50. 

• Chapter 7, Case File editing on page 62. 

• Chapter 8, Configuring the diagram on page 89. 

• Chapter 9, Case File analysis on page 100. 

• Chapter 10, Linking to documentation on page 112. 

• Chapter 11, Bowtie chaining on page 115. 

• Chapter 12, Getting data into BowTieXP, on page 118. 

• Chapter 13, Getting data out of BowTieXP on page 124. 

• Chapter 14, Working with templates on page 137. 

• Chapter 15, Overview of fields and purposes on page 140. 

• Chapter 16, Advanced Functionality:  
Visual Barrier Grouping on page 144. 

• Chapter 17, Advanced functionality: diagram display profiles on page 147. 

• Chapter 18, Advanced functionality: the Scrap Book on page 150. 

• Chapter 19, Advanced functionality: comparing files and parts of files on page 159. 

mailto:support@cgerisk.com
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• Chapter 20, Advanced functionality: type and property descriptions on page 165. 

• Chapter 21, Advanced functionality: Soob matrices on page 168. 

• Chapter 22, Advanced functionality: 
Live on/offline system states on page 184. 

• Chapter 23, BowTieServer oriented features on page 193. 

• Chapter 24, AuditXP on page 202. 

• Chapter 25, Compliance frameworks on page 226. 

• Chapter 26, LOPA (Layers Of Protection Analysis) on page 230. 

• Chapter 27, Introducing BowTieXL on page 245. 

• Chapter 28, Calculating with BowTieXL on page 253. 

• Chapter 29, IncidentXP and BowTieXP together on page 262. 
 
5. Technical installation reference and frequently asked questions: 

• Chapter 30, Installation reference on page 272. This reference describes all available options 
for installing and activating BowTieXP in all possible settings, as well as all prerequisites and 
operating system dependencies. 

• Chapter 32, Frequently asked questions on page 288. Various frequently asked questions and 
their answers are collected here. Most have to do with the technical details such as installation 
and activation. 

• Chapter 33, Support on page 298. 
 

Note: If you are a first-time user and want to get going quickly, we recommend reading the first part containing the 
quick guides. 

1 . 3  C H A N G E S  I N  T H I S  V E R S I O N  O F  T H E  D O C U M E N T  

Just like the software is changing due to improvements, the same is applicable for this user manual. 

You will find the latest changes made to this document in this subchapter. These changes are made 

based on addition of new features, changes in current features or feedback from our clients. 

The following changes have been made: 

• Added a couple of reports to the report overview. Chapter 13.2.2 – BowTieXP reports. 

• Changed the LOPA chapter and excluded parts relevant to the legacy LOPA plugin. Chapter 
26 – LOPA (Layers Of Protection Analysis). 

• Introduced two subchapters in the LOPA chapter related to the gap ratio calculation and use 
of LOPA data in BowTieXL. Chapters 26.7.3 - Gap ratio and 26.7.4 - LOPA calculations and 
BowTieXL. 
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2  
QUICK INSTALLATION GUIDE 

In this chapter, we will walk you through the steps to install BowTieXP. 

2 . 1  I N T R O D U C T I O N  

Installing BowTieXP onto your computer is in most circumstances very simple. If however, you run 
into trouble and want to have more detailed information about the installation procedure, about the 
software prerequisites and compatibility, this is available in chapter 30, the Installation reference, on 
page 272.  

2 . 2  I N S T A L L I N G  B O W T I E X P  

BowTieXP can run on 64 bits operating systems. BowTieXP requires the .NET framework v4.7 or v4.8 to be installed. 
If you run BowTieXP and the .NET framework is too old, BowTieXP tells you so. You can then download and install 
it: 
 
https://dotnet.microsoft.com/download/dotnet-framework/thank-you/net48-web-installer   
 
Note that Windows 10 Creators Update (1703) and later come with a new enough version of the framework already 
installed out of the box.  

 
Open an internet browser and navigate to: http://www.cgerisk.com/downloads/bowtiexp/  
Download and run the BowTieXP installer (.msi). 

2 . 3  A C T I V A T I N G  B O W T I E X P  

When you start BowTieXP for the first time, you are asked for either a trial code or an activation 
code: 

  

Figure 1 - Activation dialog 

 
If you have a valid trial code, you can enter that in the activation or trial code text box, and BowTieXP 
will run.  
 
If you have purchased BowTieXP, you will need to obtain an activation code to perpetually activate 
BowTieXP. Please copy the code shown in the current host id text box and paste it into an email to 
CGE Risk at support@cgerisk.com. We will then send you an activation code. After entering this code 
in the activation or trial code text box, BowTieXP will run forever. 

https://dotnet.microsoft.com/download/dotnet-framework/thank-you/net48-web-installer
http://www.cgerisk.com/downloads/bowtiexp/
mailto:support@cgerisk.com
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Note: CGE Risk offers leasing of licenses as well. In this case, the activation code will have an expiration date that 
matches the agreed lease period. After this period, the software will stop working and renewal of the lease contract 
has to be negotiated and agreed. 

 
2 . 3 . 1  A c t i v a t i n g  w i t h  a n  o l d  h o s t  i d  
Sometimes, due to the use of a laptop docking station, a switch in Windows version or changes in the 
computer hardware, it can happen that the host id changes. If that happens, your activation code will 
no longer match with the host id. If this happens, you will have to activate the software based on the 
original host id (the original host id that was used for creation of the activation code, the one you 
sent to CGE Risk).  
 
To do so, select the “Lock to this computer with an old host id” option from the “Lock to” dropdown 
menu in the Product Activation screen (see Figure 2). The screen will then display the current, as well 
as the activated host id (the one you sent to us initially) (see Figure 3). 
 
 

 

Figure 2 - Activate with original host id 

 

 

Figure 3 – Host id and activation code do not match anymore 

 
We do not need to send you a new code. You just need to tell it the host id which belongs to the 
activation code. You can do this by copy/pasting the old host id which was used to generate the 
activation code into the ‘activated host id’ field. The host id that was used to generate the activation 
code is always included in the same email as the activation code, usually in a bit of text that looks like 
Figure 4: 
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Figure 4 - Activation code email message 

 
The host id that was used to generate the activation code is the one pointed out by the arrow in 
Figure 4. When this host id is copied into the ‘Activated host id’ field, the software will pick it up and 
the match it to the activation code. This should result in an accepted code, returning the status ‘OK’. 
Now click the OK button, and the software should be activated once more (see Figure 5). 
 
Please note that BowTieXP will check what has changed on your computer. If too many parts have 
changed, or you are trying this on a different computer, the code will still not work and you will need 
to contact us for an updated code. 

 

 

Figure 5 – Changed host id 
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3  
QUICK GETTING STARTED GUIDE 

In this section, we will lead you through the steps needed for creating a simple bowtie diagram. 

3 . 1  A  B R I E F  D E S C R I P T I O N  O F  B O W T I E  M E T H O D O L O G Y  

Note: Look in the methodology manual (see Chapter 4) for a more thorough elaboration. 

 
The bowtie methodology is used for risk assessment, risk management and (very important) risk 
communication. The method is designed to give a better overview of the situation in which certain 
risks are present; to help people understand the relationship between the risks and organizational 
events.  
 
The strength of the methodology lies in its simplicity; the phrase “less is more” is certainly applicable.  
 
Risk management is all about risk-perception management, since most accidents happen because of 
actions or inactions of people.  People working in hazardous environments should be aware of the 
present organizational risks and should have an accurate understanding of their role in it. This can 
only be accomplished by sufficient risk communication adjusted to the abilities of that part of the 
workforce you want to address, leading to the establishment of operational ownership.  
 
Many risk assessments are done using quantitative instruments. These may be sufficient for certain 
types of equipment but are less valuable for organizational risk assessment. Human beings are less 
easy to predict than machinery and the operational combination of all factors present (think of 
people, equipment, time, weather, organizational factors, etc.) leads to even more difficulties. 
Making accurate predictions of the future in an environment that is as complex as the world itself, is 
simply impossible. In many organizations, the stakes of certain consequences (resulting from an 
accident) are too high to leave unmanaged. Therefore, it is wise to be prepared for ‘everything’; think 
of all possible scenarios and assess how your organization is prepared to deal with them. This is 
exactly what the bowtie method and BowTieXP will help you accomplish. 
 
Risk in bowtie methodology is elaborated by the relationship between hazards, top events, threats 
and consequences. Barriers are used to display what measures an organization has in place to control 
the risk. 

 
3 . 1 . 1  H a z a r d  
The word “hazard” suggests that it is unwanted, but in fact, it is the opposite: it is exactly the thing 
you want or even need to make business. It is an activity or state of something with the potential to 
cause harm but without it, there is no business. For example, the oil industry; oil is a dangerous 
substance (and can cause a lot of harm when treated without care) but it is the one the thing that 
keeps the oil industry in business! It needs to be managed because as long as it is under control, it is 
of no harm. 

 
3 . 1 . 2  T o p  e v e n t  
Thus, as long as a hazard is controlled it is in its wanted state. For example: oil in a pipe on its way to 
shore.  However, certain events can cause a deviation of or loss of control over the hazard. In bowtie 
methodology, such an event is called the top event. The top event is not a catastrophe yet, but the 
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dangerous characteristics of the hazard are now in the open. For example: oil is outside of the 
pipeline (loss of containment). Not a major disaster, but if not mitigated correctly it can result in 
more unwanted events (consequences). 

 
3 . 1 . 3  T h r e a t s  
Often there are several factors that could cause the top event. In bowtie methodology, these are 
called threats. These threats need to be sufficient or necessary: every threat itself should have the 
ability to cause the top event. For example: corrosion of the pipeline can lead to the loss of 
containment. 

 
3 . 1 . 4  C o n s e q u e n c e s  
When a top event has occurred, it can lead to certain consequences. A consequence is a potential 
event resulting from the release of the hazard, which results directly in loss or damage.  
Consequences in bowtie methodology are unwanted events that an organization ‘by all means’ 
wants to avoid. For example: oil leaking into the environment.  

 
3 . 1 . 5  B a r r i e r s  ( a l s o  k n o w n  a s  c o n t r o l s )  
Risk management is about controlling risks. This is done by placing barriers to prevent certain events 
form happening. A barrier (or control) can be any measure taken that acts against some undesirable 
force or intention, in order to maintain a desired state.  
 
In bowtie methodology, there are proactive barriers (on the left side of the top event) that prevent 
the top event from happening. For example: regularly corrosion-inspections of the pipelines. There 
are also reactive barriers (on the right side of the top event) that prevent the top event resulting into 
unwanted consequences. For example: leak detection equipment or concrete floor around oil tank 
platform.  
 
Note the terms barrier and control are the same construct and depending on industry and company, 
one or the other is used. In this manual, we will use the term barrier. 

 
3 . 1 . 6  E s c a l a t i o n  f a c t o r s / d e f e a t i n g  f a c t o r s / b a r r i e r  
d e c a y  m e c h a n i s m s  
In an ideal situation, a barrier will stop a threat from causing the top event. However, many barriers 
are not a 100% effective. There are certain conditions that can make a barrier fail. In bowtie 
methodology, these are called escalation factors. An escalation factor is a condition that leads to 
increased risk by defeating or reducing the effectiveness of a barrier. For example: earthquake 
leading to cracks in the concrete floor around a pipeline. 
 
Escalation factors are also known as defeating factors or barrier decay mechanisms – which term is 
used is dependent on industry and company. In this document, we will use the term escalation 
factor. 

 
3 . 1 . 7  A L A R P  
If you want to be completely sure that there is no risk present, you have to get rid of the hazard. 
However, since the hazard is part of normal business, this is simply not possible. We accept there is a 
risk and we try to do everything possible to keep the risk “As Low As Reasonably Practicable” 
(ALARP). For a risk to be ALARP, it should be demonstrable that the cost involved in reducing the risk 
further would be grossly disproportionate to the benefit gained. 
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What ALARP means is different for every organization; it depends on what risks an organization does 
or does not want to take and what an organization wants to spend (in time & money) on 
barriers/control measures.  

 
3 . 1 . 8  T e r m i n o l o g y  r e c a p  
The following terms should now be familiar to you: 

• The hazard, part of normal business but with the potential to cause harm, can be released by: 

• A top event, no catastrophe yet but the first event in a chain of unwanted events. 

• The top event can be caused by threats (sufficient or necessary causes). 

• The top event has the potential to lead to unwanted consequences. 

• (Proactive) barriers are measures taken to prevent threats from resulting into the top event. 

• (Reactive) barriers are measures taken to prevent that the top event leads to unwanted 
consequences. 

• An escalation factor is a condition that defeats or reduces the effectiveness of a barrier. 
 
We will be covering the following steps in the next sections: 

• A quick overview of the software layout, 

• Adding/defining a bowtie location, 

• adding a hazard and top event, 

• adding threats, 

• adding consequences, 

• adding barriers, 

• And adding escalation factors. 

3 . 2  T H E  B O W T I E X P  S C R E E N  

When starting BowTieXP for the first time, you will be asked a couple of questions and given some 
information: 

• If you agree to the End User License Agreement (EULA),  

• The version history / release notes are shown, 

• If BowTieXP can check for updates and some other preferences, 

• What language you want to use. 
After agreeing to the EULA, you can leave everything at their defaults. 
 
This screen is only shown the first time. Once it is finished, BowTieXP will start normally. 
 
After starting BowTieXP, the following screen will appear: 
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Figure 6 - Main application screen 

 
This screen consists of several parts that you will need to familiarize yourself with before you will be 
able to start building your case. They are explained below. Please note the titles in the various 
windows in the screenshot – throughout the documentation we will refer to these windows by those 
names. 
 
The windows we will need in this chapter are highlighted and discussed below. 
 

Note: Your screen layout might be slightly different if you are running a different edition of BowTieXP – some extra 
features will be available if you have purchased the advanced version and/or the IncidentXP and/or the AuditXP 
add-on. All features that are not in the standard version of BowTieXP will be marked in the text. 
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Screenshot with highlight Description 

 

Tree view – The Tree view window helps you easily 
navigate through your bowtie Case File. In this 
window, you have access to your Case File, 
including the lookup tables associated with your 
file, the activities, documents, and bowtie locations. 
It is also a quick and easy way to jump to different 
portions of your diagram by clicking on them in the 
Tree view – the diagram will follow.  
 
Note you can click on the ‘+’ or the ‘-’ icons to 
expand or hide the details associated with each 
item.  

 
 

 

Diagram – The diagram window is where the visual 
portion of your diagram will take shape. 
 
There are distinct shapes associated with each 
portion of the bowtie diagram that represent 
different aspects of your case. Think of the diagram 
window as your drawing board. 
 
 
 
 
 
 
 
In place editing (“quick edit”) – You can double click 
the name on a box, which lets you immediately 
change the name. This is also the default when you 
add a new diagram shape. You can also select the 
item by clicking it, and press F2 to quick edit the 
item. 
 
If you double click on the shape, not the text, you’ll 
get the full pop-up editor, showing all details. You 
can also bring the full editor up by right clicking the 
item and choosing “edit” as opposed to “quick 
edit”. Or you can click the little pen icon in the 
shape ( ). Or by pressing F4. 

 

 
 
The full (pop-up) editor looks like this, and allows 
you to edit all the details of an item, not just the 
name. 
 
 

 
If you would like to know more about the Tree view, diagram, and editor windows or any of the 
other windows not covered in this chapter; please refer to the rest of the manual - starting at 
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chapter 6, Introducing BowTieXP, and continuing in the next chapters, every component is described 
in detail. 
 

Some tips if you get lost: 
 
1. Pressing F2 allow you to change the name of the selected item. Double clicking the text does the same. 
2. Pressing F4 allows you to edit all the details of the selected item. Double clicking the border of non-text part 

of the shape does the same. 
 
3. Pressing Shift + F12 restores all windows to their default location – the layout as seen in the screenshots is 

restored. You can also press the star icon on the toolbar. 
 
4. If you cannot find your diagram, you have not selected a hazard/top event, or you have selected a different 

tab such as the case overview tab in the diagram window instead of the diagram tab. 
 
5. Pressing the ‘+’ symbol in the Tree view shows the hidden branches, pressing the ‘-’ symbol hides them. 

 
You are now ready to create your first bowtie diagram. A sample bowtie diagram is already created 
for you – you can change this to your liking. If you want to create a new one from scratch, follow the 
instructions below. 

3 . 3  Q U I C K L Y  A D D I N G  A  D I A G R A M  

As adding a new hazard is an often done job, you can go into the Diagram menu and choose the “Add 
new BowTie Diagram” option: 

 

 

Figure 7 - Add new Bowtie diagram 

 
This adds a new empty bowtie diagram in one go which you can then adjust to suit your purposes. 
Double click items to edit them. Look for the colored buttons on the diagram to add new items: 
 

 

Figure 8 - Blue buttons 
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3 . 4  S T E P  B Y  S T E P  -  S T E P  1 :  A D D  A  B O W T I E  G R O U P  

Each bowtie diagram belongs to a bowtie group. Using the shortcut in the previous paragraph, you 
might have noticed a new default bowtie group was created to hold the new default diagram. We 
will now explain how to make them step by step. It is very easy – just right click items to see what 
you can do to manipulate them. 
 
Adding a bowtie group is how you begin before adding your first bowtie diagram. BowTie Groups 
give structure to your set of bowties and allows you to group bowties that belong together under a 
container. BowTie Groups can be created for locations (e.g. Amsterdam, Rotterdam, London), for 
types of operations (e.g. Transportation, Storage, Processing) or any other grouping structure that 
makes sense. Each group can contain multiple bowtie diagrams, one diagram for each Hazard/Top 
Event combination. 
 
To create a bowtie group, go to the Tree view window and do the following: 
 

1. Right click your mouse on the tree node called bowtie group. 
2. Select ‘New BowTie Group…’ 

 
 

 

 
 
 

 

 

 

Figure 9 - Adding a BowTie Group 

 
 

3. The editor dialog box appears.  
4. Enter a bowtie group name in the name text box.  

 
Note: Notice the name field has a red exclamation mark next to it. This means it is a mandatory field and you must 
fill it in. 

 
5. Enter a more elaborate description, if desired. 
6. Press OK to add the bowtie group.  

 
This new BowTie Group will appear in your Tree view as shown in the figure below. 
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Figure 10 - Adding a BowTie Group - Tree view changes 

3 . 5  S T E P  2 :  A D D  A  H A Z A R D  A N D  A  T O P  E V E N T  

Now you need to add a hazard and a top event to your new bowtie group.  
 

1. Look at the Tree view. You will see the bowtie group you created in step 1.  
2. Right mouse click on the bowtie group node. 
3. Select New Hazard from the menu and the editor dialog will appear. 

 

 

 

 

 

 

Figure 11 - Adding a hazard & top event 

 
4. Enter a hazard name and a top event in the text boxes. 
5. Click on the ok button to save. 

 

Notice that your hazard and top event now appear in the diagram window. You are now ready to 
begin working with your bowtie diagram. 
 

 

Figure 12 - After adding a hazard & top event 

3 . 6  S T E P  3 :  A D D I N G  T H R E A T S  

Your Tree view window will now look like this:  
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Figure 13 – The selected hazard in the Tree view 

 
 
Your diagram window will look like this: 
 

 

Figure 14 - A minimal bowtie diagram 

 
Now you can start adding threats to your hazard/top event combination. This can be done directly on 
the diagram or via the context (right-click) menu. 
 
Move the mouse to the left of the red round top event shape. A little blue button will appear. 
Clicking this will add a threat. Notice the position of the mouse pointer: 
 

 

Figure 15 – Blue buttons (threats) 

 
The threat is immediately added to the left of your top event and ready to enter a name. Enter a 
name and hit the Enter key.  
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Figure 16 - The newly added threat 

 
 
You can also right-click the top event and find the Add -> New Threat menu item. 
 
Continue to add threats until you are satisfied you have covered them all. 
 

Note: Use the scroll bars and the zoom in/out buttons on the toolbar to navigate through your diagram. 
You can also use: 

• the mouse to click and drag in the background to pan around,  

• use the mouse wheel to scroll vertically 

• use the mouse wheel whilst holding down the shift key to scroll horizontally 

• use the mouse when whilst holding down the control key to zoom in and out 

 

3 . 7  S T E P  4 :  A D D I N G  C O N S E Q U E N C E S  

If your top event were to occur, you would want to have an understanding of possible outcomes and 
necessary reactions to such an event. Consequences in a bowtie diagram allow you to analyze both 
sides of a top event.  
 
You can add consequences to your diagram similar to how we added threats – click the red button on 
the right-hand side of the top event: 
 

 

Figure 17 - Red buttons (consequences) 

 
The consequence will appear and allow you to enter a name. Hit the Enter key. Now your diagram 
looks like this: 
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Figure 18 - The newly added consequence 

 
 

Note: You can also right mouse click on the top event in the diagram or Tree view. Then select Add → Consequence. 

 
You have now created the bare bones of your bowtie diagram. Next, you need to populate that 
diagram with information about the measures that are in place to prevent threats from triggering the 
top event, and what measures are in place to mitigate or prevent the consequences from becoming a 
reality if your top event has occurred. These measures are known as barriers. 

3 . 8  S T E P  5 :  A D D I N G  B A R R I E R S  

Now, you will add a barrier to your bowtie diagram. 
 

 

Figure 19 – Grey buttons (barriers) 

 
Click the grey barrier button next to the threat. The barrier will appear. Enter the name of your 
barrier and hit the Enter key.  
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Figure 20 - The newly added barrier 

 
Continue to add barriers to each threat or consequence until you feel your diagram is complete. You 
can add barriers to the left or right of existing items.  
 
You can reorder barriers by dragging them around. You can also reorder threats and consequences in 
the same manner.  
 

Note: You can also add a barrier by right-mouse-clicking on a threat in the diagram. You can also add barriers via 
the Tree view. Expand the threat and you will see a node titled “Barriers”. Right click that and select to add a new 
barrier. 

 

3 . 9  S T E P  6 :  A D D I N G  E S C A L A T I O N  F A C T O R S  

Escalation factors are conditions that lead to increased risk by defeating or reducing the effectiveness 
of barriers. To add an escalation factor to a barrier in your diagram, click the yellow button beneath a 
barrier: 
 

 

Figure 21 - Yellow buttons (escalation factors) 

 
If you have barriers in place to prevent this escalation factor from defeating this barrier, they can be added like how barriers 
are added to threats and consequences. 

3 . 1 0  B O W T I E  D I A G R A M  C O M P L E T E  

By following steps 1 through 6, you have now completed a simple bowtie diagram. With the diagram 
laid out, you can now add more variables to each part of the diagram in order to drill down to more 
specific tasks such as categorizing your barriers and attaching activities, document references and a 
host of other things. Some are described below. 
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3 . 1 1  T A K I N G  I T  T O  T H E  N E X T  L E V E L  

There is much more to the BowTieXP software than just drawing diagrams. In the next sections, we 
will give you the background needed for taking your analysis to the next level, and we will do this 
with examples. 
 
As you have seen in the previous sections, there are different kinds of information in each Case File, 
which are used in a variety of ways. In this section, we will explain the different types of data and 
how they interlink: some objects that you create have special ‘abilities’ such as being able to be 
referenced from other places. We will also talk about the theory behind some of these. 

 
3 . 1 1 . 1  N o r m a l  e n t i t i e s  
In the previous sections, you have created a sample diagram by adding a location, a hazard, threats, 
consequences, barriers and escalation factors. These items are known as normal entities and have no 
special abilities like the “special” items we will discuss next. Most normal entities are diagram parts. 

 
3 . 1 1 . 2  L o o k u p  t a b l e s  
One of the things you might have noticed on the editors is that the normal items have various 
properties, which might be plain text, such as names, descriptions and codes, but also various drop-
down lists such as e.g. the effectiveness rating on a barrier. 
 
The options available for the effectiveness ratings are defined in your Case File and you can modify 
them yourself. Like all data in the Case File, you can find them in the Tree view, in this case under 
Case File → BowTie Lookup Tables → Effectiveness.  
 
All the different reference information used throughout your Case File is defined under the “BowTie 
Lookup Tables” node. 
 

 

Figure 22 - Lookup tables 
 
Adding items here will make them available on the various drop-down boxes in the editor.  
 
Removing items here will remove them of course. If a value is in use, you will be warned and asked if 
you would like to select another value to replace it with, as you can see in Figure 23 - Deleting a 
lookup table value below. 
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Figure 23 - Deleting a lookup table value 

 
In BowTieXP, the following lookup tables exist: 
 

Lookup table type Description/usage 

Action Categories 
Activity Categories 
Activity Types 

Used on actions to categorize the different actions 
Used on activities to categorize the different activities 
Used on activities to categorize the different activities into 
different types 

BRF Codes Used on barriers to indicate the Basic Risk Factor (BRF) the barrier 
belongs to. For more information on basic risk factors and Tripod 
theory, refer to the methodology manual. 

Plot Plans 
Organizational Unit 
Types 
Organizational Units 

Used to add plot plans to organizational units. 
Used to categorize organizational units. 
Used on bowtie groups, audits and incident to indicate to which 
organizational unit the bowtie diagrams, audit fill outs and/or 
incident diagrams belongs to. 

Hazard Categories 
Hazard Type 

Used on hazards to categorize the hazard. 
Used on hazards to categorize and the hazards into different 
types. 

Build Phases Used to indicate the build phase of the bowtie. 

Threat Categories 
Threat Types 

Used to categorize and color-code threats. 
Used on Threats to categorize the threats into different types. 

Consequence 
Categories 
Consequence Types 

Used to categorize and color-code consequences. 
Used on Consequences to categorize the consequences into 
different types. 

Escalation Factor 
Categories 
Escalation Factor Types 

Used to categorize and color-code escalation factors. 
Used on escalation factors to categorize the escalation factors 
into different types. 
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Priorities Used on actions to prioritize them.  
 

Priorities must be listed from high to low. This is important for some 
reports, but mostly for BowTieServer, to be able to prioritize the actions 
correctly. 

 

Frequencies Used on activities to indicate the frequency of activity execution. 

Effectiveness Used on barriers to signify the effectiveness of the barrier in 
preventing the top event or consequence from occurring.  
 

Effectiveness must be listed from least effective to most effective. This 
is important for various reports, but mostly for BowTieServer, which 
uses the order to determine if things are improving (or not). 

 

Criticalities Used on barriers to signify critical barriers. 

Barrier Types 
Barrier Categories 

Used on barriers to categorize the barriers into different types. 
Used to categorize and color-code Barriers. 

Competencies Used on activities to show which competencies are needed to 
perform the activity. 

Job Titles 
 

Job titles are abstractions for people tasked with a certain 
responsibility. Another word for this concept could be post 
indicator.  
 
They are used on activities to indicate e.g. the person responsible 
for the activity and the person who signed off on the activity. On 
barriers and hazards, they indicate the accountable person. On 
hazards, they are also used for the sign off information. On 
actions, they are used to indicate the person who has to execute 
the intended action. 

User Systems 
 
 
 
 
Survey Types 

Used on barriers to show which systems (e.g. power supply 
system) are needed to operate a barrier. 
 

Note: User systems are only available in BowtieXP Advanced.  

 
Used to categorize surveys in different types  
 

Note: Survey types are only available in AuditXP. 

 
3 . 1 1 . 3  L i n k a b l e  e n t i t i e s  b y  e x a m p l e :  a c t i v i t i e s  
For some properties, it is not enough to be able to select only one value, you need to be able to 
assign multiple items from a limited list of items.  
 
Let us clarify this abstract idea with an example. 
 
In most organizations, there is a management system of activities/tasks, which define how your 
organization is run. Many of these management system activities are essential for keeping barriers 
working correctly – for example, an automatic fire suppression system needs regular maintenance, 
inspection and testing to ensure it will function correctly when needed.  
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To leverage the usability of your bowtie diagrams, mapping between your management system and 
your diagrams is important. It enables you to analyze which tasks and therefore which persons/posts 
are managing threats, how many different activities and therefore how many people are responsible 
for this and if any threat is sensitive to single points of failure in your management system.  
 
For example, a threat, which is controlled by barriers, which is supported by several activities, which 
all rely on the same person, might be considered more vulnerable than one with barriers and 
activities that are not all dependent on one person. 
 
It also allows for better communication on why certain activities are critical, which helps the persons 
responsible from understanding why they are to do the mentioned task and therefore ensuring 
better execution.  
 
To support this analysis, you can define management systems that contain a hierarchy of activities 
within BowTieXP. After creating / inputting this hierarchy of activities into BowTieXP, you can assign 
various activities to your barriers.  
 
See the example below: 
 

 

Figure 24 - An example activity hierarchy with multiple management systems 

 
After the hierarchy has been defined, we can now link the activities onto barriers. You can do this in a 
couple of different ways: Drag and drop and via the Editor. 

 

D r a g  a n d  d r o p  

All link assignments can be made using drag and drop, similar to how you move/copy files in 
Windows Explorer. 
 
To assign an activity to a barrier using drag and drop, ensure that the barrier you want to assign to, is 
visible in the diagram and the activity you want to assign, is visible in the Tree view.  

1. Left click the activity and keep the mouse button pressed down.  
2. Move the mouse over to the diagram whist holding the mouse button. You will see the mouse 

pointer indicate when it is valid to let go (Figure 25 - Assign Tree view values to the diagram) 
3. Release the mouse button when the mouse pointer is over the barrier where you want to 

assign the activity. 
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Figure 25 - Assign Tree view values to the diagram 

 
The link has now been made. You might have noticed the following popup when dropping the 
activity: 
 

 

Figure 26 - Diagram display popup 

 
If you click yes, the assigned activities will be shown on the diagram: 
 

 

Figure 27 - Activity linked to barrier 

 
If we missed the dialog, we can also manually adjust the display settings. To do so, take the following 
steps: 

1. Click the little eye icon on the barrier: 
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Figure 28 - Barrier display - eye-icon 

 
This will bring up a dialog that allows you to adjust display options for barriers. Note that all shapes 
have this little icon. 
 

 

Figure 29 - Set barrier display window 

 
Select the S column for activities – this will show the activities of the barrier in Short format. You can 
also choose L for Long format. 
 
If you have many settings to change, you can also open the diagram display options menu: 

1. Go to the diagram menu, 
2. Choose display options, 
3. In the tree, open the barrier settings. 
4. Select the ‘S’ or ‘L’ column radio button under barrier for activities. 

The diagram will change and show all the assigned activities below each barrier. Verify the link you 
just made. 
 



 

©  W O L T E R S  K L U W E R  |  C G E  R i s k  2 0 2 0  
C O N F I D E N T I A L  A N D  P R O P R I E T A R Y  

 

B O W T I E X P  S O F T W A R E  
M A N U A L  

 

P A G E  3 2  

 

 

Figure 30 - Showing activities on the diagram 

 
The same diagram appears when you click the eye-icon in the toolbar ( ) 
 
The second method is the method that also allows us also to remove the link: via the activity in the 

Tree view or via the barrier. 
 
In the Tree view, we can open it up further by clicking the plus sign, which will show all the child 
collections the activity has. Double click on the activity. On the top of this pop-up you see ‘Assigned 
to Barriers’. The screen will now look like the picture below. 
 

 

Figure 31 - Assigning activities to barriers 

 
The left column represents all the barriers in the casefile. The right column tells you to which barriers 
the activity you are currently editing is linked to. You can drag and drop barriers from the left column 
to the right column to link barriers with the activity. You can also select barriers and use the arrows 
in the middle to link with the activity. You can unassign barriers by bringing these barriers back to the 
left column. 
 
Note that items that are drawn in gray have already been assigned / moved to the right-hand side.  
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Below you find the explanation in how to add activities to barriers from the barrier editor. This 
process will create the same links but start at the other side of the link. 

 

E d i t o r  

Double click the shape of the barrier, or select the barrier and hit F4, to bring up the editor. Select 
the activities tab: 
 

 

Figure 32 - Editor window / activities tab 

 
The left-hand side of this screen shows all the items which can be linked to the barrier. The right-
hand side shows all the entities already assigned. To move items between the two sides, you can 
select them and press the relevant arrow icon between the two halves of the screen. You can also 
drag and drop items between the two sides. Alternatively, you can double click an item to assign or 
unassign. 
 
Note that items that are drawn in gray have already been assigned / moved to the right-hand side.  
 
Also, note that you can filter the items shown by typing information into the filters. You can also sort 
on each column by clicking the headers.  
 
When assigning document links and activities the screen described above is used, due to the 
hierarchical nature of these items. For flat data such as e.g. systems, the dialog looks slightly 
different, and can be seen below: 
 



 

©  W O L T E R S  K L U W E R  |  C G E  R i s k  2 0 2 0  
C O N F I D E N T I A L  A N D  P R O P R I E T A R Y  

 

B O W T I E X P  S O F T W A R E  
M A N U A L  

 

P A G E  3 4  

 

 

Figure 33 - The assign links screen showing flat data 

 
One thing to note is that now assigned items aren’t shown in gray on the left-hand side, but are 
removed and only visible in the right-hand side. 

 

D e l e t i n g  l i n k a b l e  i t e m s  

Note that when deleting an item that has been used, you will get a popup similar to the popup when 
deleting a lookup table item (see Figure 23 - Deleting a lookup table value on page 27): You are 
allowed to select an optional replacement value. 

 

O v e r v i e w  o f  l i n k a b l e  i t e m s  

Note that operational risk factors, operations and systems are part of the advanced edition. Compliance 
frameworks are part of AuditXP. 

 
 

Linkable entity type Description/usage 

Activity Described above. Activities are linked to barriers. Activities can 
be found/created under the Management Systems container on 
the top level of the Tree view. 

Document Link Document links are references to external documentation, which 
can be added to various elements in the Case File. Like all 
linkable entities, they are defined centrally and then referenced 
from other elements in the form of links. 
Linking to document links is possible to hazards, threats, 
consequences, barriers, escalation factors and activities. 
Document links can be found/created under the Document Link 
Groups container on the top level of the Tree view. 

Wiki Groups / pages Wiki pages are references to internal documentation, which can 
be added to barriers in the Case File. Wiki pages are often 
imported using the Wiki module in BowTieServer, but wiki pages 
can also be used for BowTieXP only. 

Operational Risk Factor Operational risk factors are used to specify certain dimensions of 
operations, which need to be considered separately in Soob 
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matrices from the operation as a whole, such as critical 
equipment and e.g. weather conditions. Operational Risk Factors 
can be found/created under the Operations and Risks container 
on the top level of the Tree view. See chapter 21,  
Advanced functionality: Soob matrices on page 168 for further 
details. 

Operation 
 
 

An operation in BowTieXP is used to describe a specific 
operation, which can take place in your organization and should 
be present on the Soob matrix. Operations can be found/created 
under the Operations and Risks container on the top level of the 
Tree view. See chapter 21,  
Advanced functionality: Soob matrices on page 168 for further 
details. 

Systems  Systems are used to visualize maintenance data on barriers. A 
system can contain sub-system and each system consists of 
multiple parts. These parts can either be online or offline (or the 
status is unknown). Systems can be found/created under the 
System groups container on the top level of the Tree view. See 
chapter 22, Advanced functionality: 
Live on/offline system states on page 184. 

Compliance frameworks Compliance frameworks are used to link objectives from the 
compliance framework to the bowtie to understand whether the 
framework is fully implemented using maturity levels. Objectives 
can be linked to barriers and activities. See chapter 24, AuditXP 
add-on on page 202 for details. 
 

3 . 1 1 . 4  S h o w  u s a g e  r e f e r e n c e s  /  b a c k l i n k s  
When an activity is referenced on a barrier, there’s a virtual arrow pointing from the barrier to the 
location in the Tree view where the activity is defined. The figure below demonstrates this. It shows a 
part of a bowtie diagram. Listed below each barrier are the activities assigned to that barrier.  
 
 

 

Figure 34 - Tree view and diagram, explaining links 

 
This arrow is called the link. We can also follow this arrow in the reverse direction, from the activity 
to all the barriers where it is used. These are called the backlinks. 
 
A similar concept applies to lookup table values.  
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For each linkable entity and each lookup table value, we can find out where they are used by 
showing us their backlinks / usage references.  
 
This is done by right clicking the item of which you want to see where it is referenced and selecting 
the option in the context menu called “Show usage references”. The Listview (that appears if not 
enabled already) will show all the places where the item is in use. 
 
See also section 7.9 starting on page 79, the Listview window. 

3 . 1 2  A C T I O N S  

Actions are one-time actions (and thus do not reoccur) on a bowtie. They can be used in several ways 
Two examples are to use them as TODO items when developing a bowtie, or as an improvement plan 
on an existing bowtie. 

3 . 1 2 . 1  A c t i o n s  a s  a  T O D O  l i s t  
Let us say you have a barrier in your bowtie, but you are unsure who is accountable for it. Creating an 
action lets you track all the elements in your bowtie that need more investigation. 
 

3 . 1 2 . 2  A c t i o n s  a s  i m p r o v e m e n t s  
You could also use actions as a more formal improvement plan. After completing the bowtie and 
seeing how your organization manages risk currently, there are often scenarios that could be 
improved by adding new barriers or improving existing ones. You can use actions to highlight those 
areas.  
 
Some examples of actions as improvements are: correcting an error in a procedure, adding a new 
smoke detector or changing the accountable party for a barrier. These are performed once to 
improve safety, but do not need to be repeated regularly.  
 
Actions to create a new barrier are usually displayed on the associated Threat or Consequence, while 
improvements on existing barriers are usually put on the barrier itself. 
 

3 . 1 2 . 3  T h e  d i f f e r e n c e  b e t w e e n  a c t i o n s  a n d  a c t i v i t i e s  
BowTieXP also allows you to add activities, and there is often confusion about the difference 
between actions and activities. Activities are used to describe regular recurring tasks like 
maintenance and training. These are part of your (safety) management system.  
 
Actions on the other hand, are one-off improvements on a (safety) management system or barrier. 
For example, an activity could be maintenance on an engine, an action for that activity could be to 
create a new checklist to make the maintenance less error prone. 

 
3 . 1 2 . 4  A d d i n g  a n  a c t i o n  
Adding an action is done by selecting any element in the bowtie and either clicking the action icon in 
the toolbar or right clicking on the element → Add → Action 
 
  

 

Figure 35 - Action button in the toolbar 
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Figure 36 - Add action by right clicking 

 

A c t i o n  p r o p e r t i e s  

The fields on an action are: 
 

• Code: the action code is displayed on the diagram. 

• Name: describes what the action is about. 

• Description: a detailed description of the action. 

• Category: categorizes actions (e.g. TODO’s or improvements). 

• External Reference: this field can be used to fill in a reference to an external action tracking 

system. 

• Action party: the job title is responsible for completing this action. The job titles are defined 

in the Lookup tables 

• Organizational Unit: indicates for which organizational unit this action is created. 

• Priority: gives a priority to an action. The list of priorities is defined in the Lookup tables 

• Target: gives the date before which the action must be completed. 

• Sign off comment: an optional field to provide comments when signing off an action. 

• Sign off authorized by: the job title that authorized the completion. 

• Sign off date: the date on which the action was signed off. 

• Completed: this box is ticked once the action has been completed. 
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Figure 37 - Add action window 

 

Visualizing actions 

Actions are visualized on the bowtie as post-it shapes. The code is also displayed.  
 

 

Figure 38 - Display of actions 

 
Go to Diagram → Display options and under Action Shapes, select either None to hide all actions, 
Overdue to show all uncompleted actions with the target overdue, Uncompleted to show only 
uncompleted actions or All to see both completed and uncompleted actions. 
 
In the Colors tab, you can also select Action Colors. Coloring can be done by Priority, Category and 
Overdue or Completed status. 
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3 . 1 2 . 5  A c t i o n  r e p o r t s  
Go to Tools → Reports and expand the Actions section to see the following action reports: 

• Actions in XL: a flat list of Actions, opens in Excel 

• Actions in BowTie context: Actions in BowTie context, with empty fill in lines, opens in Excel 

• Actions in BowTie context, condensed version: Actions in BowTie context, opens in Excel. No 

empty fill in lines, only listing the objects that actually have Actions descendants 

• Action of a selection of hazards: a report with all actions for particular Hazards, opens in 

Word 

• All actions: a list of all actions in alphabetical order based on code, opens in Word 

• Actions by action party: a report that prints out all actions sorted by Action party, opens in 

Word 

• Actions by priority and action party: a report with all actions sorted by Priority, opens in 

Word 

• Actions of a specific action party: a report with all actions for a specific job title, opens in 

Word 
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4  
A DEEPER LOOK AT THE BOWTIE METHOD 

Due to the length of this chapter, we decided to make it into a separate document. Please contact 
support@cgerisk.com to see if you are eligible to receive a copy. 
 
This document aims to educate the reader on the bowtie method as it is used in the industry at the 
moment. It is both a practical reference for everyday users of the method and a theory guide. This 
means that theoretical concepts are elaborated with practical tips and examples on how to use the 
method. 
 

Note: Another good source of bowtie information, guidelines and best practices is the book “Bow Ties in Risk 
Management: A Concept Book for Process Safety” that was a collaborative effort of the Center for Chemical Process 
Safety (CCPS) and the Energy Institute (EI). The book was co-authored by CGE Risk staff. 

 
Please find a rough outline of the chapters in the method manual below: 
 
1 Introduction 
2 Discussion of related methods 
3 The application of bowties, today and tomorrow 
4 Before getting started 
5 Building a Bowtie 

5.1. A Bowtie Diagram in 8 Steps 
5.2. Hazards 
5.3. Top Events 
5.4. Threats 
5.5. Consequences 
5.6. Barriers 
5.7. Escalation factors and escalation factor barriers 
5.8. Linking management system activities to barriers 
5.9. Escalation factor guidelines 
5.10. Completing barrier information 

6 Risk evaluation 
6.1. Overview of ALARP 
6.2. ALARP in Bowtie 

7 Bowtie implementation 
7.1. Implementation 
7.2. Monitoring 
7.3. Revisions and change management 

Appendix 1 Sample SMS outlines 
Appendix 2 A sample bowtie 
 
  

mailto:support@cgerisk.com
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5  
THE DIFFERENT BOWTIEXP VERSIONS 

In this chapter, a quick overview is offered of the extra functionality available in the various versions 

of BowTieXP. 

5 . 1  I N T R O D U C T I O N  

BowTieXP comes in three versions:  

• BowtieXP Standard Edition 

• BowTieXP Navigator Edition (read-only) 

• BowtieXP Advanced Edition 
 
The following add-ons are available: 

• Spreadsheet add-on (BowTieXL) 

• AuditXP add-on 

• IncidentXP add-on 
 
The IncidentXP add-on is an incident analysis add-on, which features the DNV BSCAT method, the 
Tripod Beta method, the Barrier Failure Analysis (BFA) method as ways of doing barrier-based 
incident analysis. IncidentXP also includes the non-barrier based Root Cause Analysis (RCA) and 
Kelvin TOP-SET RCA methods. Although RCA is not barrier-based by definition, IncidentXP allows to 
link RCA elements to bowtie barriers. IncidentXP can be used as a stand-alone tool, but is also 
available in combination with BowTieXP1, allowing you to link reactive incident analysis to proactive 
risk analysis (i.e. incident analysis diagram to bowtie diagram).  

5 . 2  N A V I G A T O R  E D I T I O N  

Not everybody who needs to access bowtie information needs to be a full licensed bowtie user. 
BowTieXP Navigator allows non-bowtie builders to access all information in a bowtie file (.btf), 
without being able to change the content. The workforce or management often uses the Navigator 
version. They need the bowtie information, but are not designated or trained to modify the bowtie 
diagrams. 
 

• Features which are present in the Navigator edition of BowTieXP: 
o Change display settings 
o All export functionality (generating reports, save diagram, print diagram) 

5 . 3  A D V A N C E D  E D I T I O N  

The advanced edition of BowTieXP offers many extras for the power users of BowTieXP. These extras 
consist of: 
 

• Extra features which are not present in the standard edition of BowTieXP: 
o File and tree compare 

 
1 Actually, BowTieXP and IncidentXP are both inside the same program. The license key determines what you get to see – 
BowTieXP, IncidentXP or both. 
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o Customizable type and property descriptions (terminology) 
o Relationship diagrams, including how bowties interrelate 
o Configurable Tree view filtering and tooltips 
o Barrier visual bundling, to group barriers together based on a similar characteristic 
o Diagram display profiles (switch quickly between modes) 
o Edit Advanced Filter criteria 
o Soob matrices (also known as MOPO or SimOps) 
o Live On/Off-line states based on barrier parts 
o Compliance frameworks 

 

• Enhancements to how you edit your data: 
o Edit multiple items at the same time 
o Automatic group detection – edit all the instances of the same barrier across many 

diagrams at once 
o The Scrap book 
o Import data from e.g. Excel files 
o Full import of data from other BowTieXP Case Files 
o Copy/paste between multiple files 

 

• Improvements in how you gain insight into your Case Files via extra reports and Case File 
overviews: 

o Advanced Case File overview perspectives 
o Advanced reports 
o Ability to search the contents of document links 

 
Note: For a more detailed overview on the differences between BowtieXP Standard and Advanced, please ask your 
CGE Risk contact to provide you with the BowTieXP Feature Matrix. 

 
5 . 3 . 1  S o o b  m a t r i c e s  
The Summary of Operation Boundaries matrix is a record of operations used to determine under 
which circumstances extra caution should be taken or work should no longer be allowed to proceed. 
This is to help the decision process of whether to proceed with operations when encountering 
suboptimal conditions. 
 
For a full explanation about Soob matrices, please refer to chapter 21,  
Advanced functionality: Soob matrices on page 168. This chapter describes what Soob matrices are, 
how they are used and constructed. 
 

5 . 3 . 2  T y p e  a n d  p r o p e r t y  d e s c r i p t i o n s  
Each Case File contains a large table containing the names of all object types and their properties 
present within BowTieXP. This allows customers to make slight adjustments to various names and 
allows them to tailor-fit the software to their company. For example, you could rename barriers to 
be labeled as controls.  
 
See chapter 20, Advanced functionality: type and property descriptions on page 165 for full details. 
 

5 . 3 . 3  R e l a t i o n s h i p  m o d e l s  /  d i a g r a m s  
The relationship diagram functionality can draw many different diagrams based in the data you have 
entered into your Case File, visualizing the relationships between the data. For example, barriers can 
be assigned activities, and activities have responsible persons. How do the responsible persons relate 
to the different hazards via the barriers and activities defined? 
 



 

©  W O L T E R S  K L U W E R  |  C G E  R i s k  2 0 2 0  
C O N F I D E N T I A L  A N D  P R O P R I E T A R Y  

 

B O W T I E X P  S O F T W A R E  
M A N U A L  

 

P A G E  4 3  

 

With the relationship model functionality, this question is answered easily with just a few clicks of 
the mouse. 
 
More than 20 different diagrams are offered. 
 
Now bowties can interrelate, you can also create diagrams showing how one bowtie flows into 
others: 
 

  

Figure 39 - Relationship diagram - Bowtie chaining 

 
You can also easily navigate from diagram to diagram using on-screen aids: 
 

 

Figure 40 - Bowtie chaining 

 
These are explored in depth in chapter 9.5, Advanced functionality: relationship models on page 105. 

 

5 . 3 . 4  C o m p a r e  f i l e s  s i d e  b y  s i d e  
On many occasions, you want to find out what your colleague changed in the latest revision of the 
Case File. Do you need to see what the differences are between two versions of the same Case File in 
your document management system? Then compare the files side by side, see the differences 
visually or generate a report of these changes. You can do it all with the file compare function in 
BowtieXP Advanced. 
 
See full details in chapter 19,  
Advanced functionality: comparing files and parts of files on page 159. 
 

5 . 3 . 5  T r e e  v i e w  f i l t e r i n g  a n d  T r e e  v i e w  t o o l t i p s  
The Tree view contains every available option for adding data into BowTieXP, some of which you will 
never use and some that you will only use during certain phases of bowtie building. You can make 
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the Tree view a lot compacter by temporarily hiding these collections and objects by means of the 
Tree view filter profiles. See section 7.11, Tree view filtering on page 80. 
 

Note for BowTieServer users: Tree view filtering profiles cannot be saved into the BowTieServer database. 

 
5 . 3 . 6  B a r r i e r  v i s u a l  b u n d l i n g  ( b a r r i e r  g r o u p i n g )  
Long lines of barriers can be reduced in size by bundling barriers together if they share a similar 
characteristic. This could be based on barrier type, job title, effectiveness, criticality or the barrier 
family name. 
 

 

Figure 41 - Barrier Families 

 

D i a g r a m  d i s p l a y  p r o f i l e s  

As the number of configurable display options has grown very large over the last years and setting up 
the wanted display can take quite some time, the diagram display profiles were introduced. 
 
Each Case File can hold a list of diagram display profiles, and you can easily switch between them 
using a drop-down box above the diagram. 
 
See chapter 17, Advanced functionality: diagram display profiles on page 147 for details. 
 

5 . 3 . 7  E n h a n c e m e n t s  t o  e d i t i n g  y o u r  C a s e  F i l e s  
Apart from the enhancements discussed above, the advanced edition also offers extra functionality 
for editing your Case Files, such as improvements to import functionality, the ability to find and 
replace and enhancements to working with multiple Case Files. 

Edit multiple items at once 

The advanced edition allows you to edit multiple items at once: 
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Figure 42 - Edit multiple items 

 
This allows you to edit a single property of multiple items at once – i.e. set the effectiveness or the 
responsible to the same value while leaving the descriptions untouched. Hold the control button on 
your keyboard to select multiple items. 

 

A u t o m a t i c  g r o u p  d e t e c t i o n  –  e d i t  a l l  t h e  i n s t a n c e s  o f  t h e  s a m e  

b a r r i e r  a c r o s s  m a n y  d i a g r a m s  a t  o n c e  

BowTieXP automatically recognizes barriers with the same code and name and allows you to edit all 
of them with the press of a single button. This simplifies keeping barriers in sync over multiple 
diagrams. 
 

 

Figure 43 - Edit barrier groups 

T h e  S c r a p  b o o k  

BowtieXP Advanced offers the Scrap book. A dockable window which allows you to: 
• Copy entities there to keep them around for a while, and later drag them back into any Case 

File (might be a different one). 
• Drop data files (Excel, BowTieXP) and read the info on them into BowTieXP. 
• Convert items from one type to another. 
• Items that cannot be given a place within the current Case File yet can be temporarily stored.  
• Store frequently used items - e.g. make a short list of frequently assigned activities. 

Items on the Scrap book such as bowtie groups, hazards and consequences serve as templates. When 
you drag an item from the Scrap book onto a bowtie diagram, a copy is made which is placed in the 
Case File. 
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Because the contents of the Scrap book are independent from your Case Files, you can use it to build 
a library of often-used templates. 
 
You can also place reference information on the Scrap book, such as activities or document links. 
When you drag these items onto a shape in the diagram, you add a link to the corresponding 
reference item in the Case File. 
 
Learn more about Scrap book in chapter 18, Advanced functionality: the Scrap Book on page 150. 

 

F i n d  a n d  r e p l a c e  

The advanced edition of BowTieXP allows you to do single or mass find and replace operations in 
your Case File. See section 9.4.1,  
Text find and replace on page 104 for details. 

 

I m p o r t  d a t a  f r o m  f i l e s  

BowtieXP Advanced offers more and different methods of getting data into BowTieXP, such as 
importing data from Excel and tab- and comma-delimited files. 
 
See section 12.2, Importing data from Excel on page 121. 

 

F u l l  i m p o r t  f r o m  o t h e r  B o w T i e X P  C a s e  F i l e s  

BowtieXP Standard edition is limited to importing only the diagrams and cannot import other details 
such as assigned responsibilities and activities. 
 
The advanced edition allows you to import everything from a Case File, including linked information 
such as activities on barriers and assigned responsibilities. It can also update data that is already in 
the Case File.  
 
See section 12.1.2,  
Importing entities with BowtieXP Advanced on page 119 for details. 

C o p y / p a s t e  b e t w e e n  m u l t i p l e  f i l e s  

Similar to importing data from a Case File, you can also start another copy of BowTieXP, open the file 
you would like to copy data from, and use copy and paste.  
 
See section 12.1.3,  
Copying entities from one file to another using the clipboard on page 120 for the details. 
 

5 . 3 . 8  E n h a n c e m e n t s  t o  g a i n  i n s i g h t  i n t o  y o u r  C a s e  
F i l e s  
BowtieXP Advanced does not only add enhancements to editing, but also to analyzing and gaining 
understanding and knowledge into the data and relations within your Case Files.  
 
Some extras here are specifically meant for the extra data you can put in using the other advanced 
options while others work on all data in your Case Files. 
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A d v a n c e d  C a s e  F i l e  o v e r v i e w  p e r s p e c t i v e s  

Note: for details on the Case File overview, see section 9.2, Case overview on page 100. 

 
The Case File overview has two extra perspectives: 

• “Operations”. The operations overview shows all operations that exist and where they are 
referenced. 

• “Management System (Activities, Barriers, Hazard categories)”. This overview shows a 
powerful alternate view of all defined activities, which allows you to drill down and see to 
which barriers they are assigned, drill down into the barriers’ parents all the way up to the 
hazard. A cumulative overview of the hazard categories is also shown. 

 

A d v a n c e d  r e p o r t s   

To accommodate the extra information, you can input in Advanced, and to gain some more complex 
insights into your data, the advanced edition has a number of extra reports: 
 
Eight extra reports: 

• “Activities linked to Barriers as hierarchical list” 

• “Activities of a specific Operation grouped by Activity. Responsible (Short version)” 

• “Activities of a specific Operation grouped by Activity. Responsible (Long version)” 

• “Required Competencies for a specific Operation, grouped by Activity. Responsible” 

• “Hazard register complete” 

• “Traditional Hazard register” 

• “Operations overview” 
 
For details, please refer to section 13.2.2, BowTieXP reports on page 125. 

5 . 4  C A S E  F I L E  S P R E A D S H E E T  A D D - O N  ( B O W T I E X L )  

BowTieXL introduces a Microsoft Excel compatible spreadsheet into BowTieXP, which exposes the 
majority of the information in the Case File as tabular data in this spreadsheet. This allows you to use 
that data to do spreadsheet calculations based on that data and feed the results back into your 
bowtie model. 
 
Apart from being able to do calculations based on the bowtie model data, you can also use BowTieXL 
to: 

• Store reference information in spreadsheets, which are stored in the Case File, 

• Add notes and calculations which serve as underpinning of the analysis in the Case File, 

• Add general reference information into the Case File, 

• Use the tabular representation of the bowtie model data to quickly edit data in bulk, 

• Use Excel formulas to create custom aggregated displays of data on the diagram, 

• And many more. 
 
See chapter 28.1, Introducing BowTieXL on page 245 and chapter 28, Calculating with BowTieXL on 
page 253 for details. 
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5 . 5  I N C I D E N T X P  A S  A N  A D D - O N   

IncidentXP is stand-alone tool allowing you to create incident analysis diagrams. It can also function 
in conjunction with BowTieXP, allowing you to create both incident diagrams and bowtie diagrams 
and relate those to each other. 
 
By mapping incidents onto proactive bowtie diagrams, more can be learned from incidents than 
when they remain isolated in the reactive domain. This deepening of the understanding works in two 
directions: 
 

1. By having the applicable proactive risk assessments on hand during the incident analysis, 
quicker barrier identification is possible and hindsight bias might be lessened, and more 
importantly, 

 
2. By identifying the proactively defined barriers that have failed, we are measuring real-world 

performance and helping identify weak spots in our barriers and management systems as well 
as discrepancies between pre-incident effectiveness assessment and actual barrier 
performance. 

 
There are five different methodologies available in IncidentXP: BSCAT, Tripod Beta, Barrier Failure 
Analysis (BFA), Root Cause Analysis (RCA), and Top-Set RCA. This makes IncidentXP a multi method 
investigation platform within BowTieXP. 
 
Each method adds a completely separate incident diagram, consisting of events and barriers (in the 
case of BSCAT, Tripod and BFA). Having a separate incident diagram allows for flexible mapping 
between the bowtie barriers and the incident barriers, allowing variation in detail level to exist 
between the incident investigation and the risk analysis. 
 
For more details on IncidentXP specifically, please refer to the IncidentXP manual available for 
download on http://www.cgerisk.com/downloads/bowtiexp/ 
 
For more details about IncidentXP in conjunction with BowTieXP, please see chapter 29, IncidentXP 
and BowTieXP together on page 262. 
 

 

Figure 44 - An IncidentXP timeline 

 
 

http://www.cgerisk.com/downloads/bowtiexp/
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Figure 45 - a BSCAT diagram 

 
 

 

Figure 46 - A Tripod Beta diagram 

 

5 . 6  A U D I T X P  A S  A N  A D D - O N  

With the AuditXP add-on, users can define verification questions for barriers. The questions can then 
be grouped into surveys (questionnaires) which can be sent out to individuals to get feedback on the 
effectiveness of barriers. Once the surveys have been filled out, the results can be graphically 
displayed on the bowtie diagram in the form of easy red and green bar charts. For more information 
about AuditXP, please refer to section 24. 

 

Figure 47 - AuditXP add-on 
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6  
INTRODUCING BOWTIEXP 

This chapter gives a quick overview of how the software is set 
up and will show how to get the most out it. 

6 . 1  I N T R O D U C T I O N  

In this chapter, we will discuss some design points about BowTieXP – how the software is designed to 
work and how to get the most out of it.  
 
It will cover starting and quitting the application, customizing the user interface, working with files 
and templates, importing Case Files, undoing and redoing modifications and other basic tasks. 
 
This chapter assumes you have basic knowledge of Microsoft Windows operating systems and 
bowtie methodology and helps you to more quickly create better Case Files. 
 

Note: The symbol → denotes menu traversal paths, e.g. Help → Release Notes refers to the menu option Release 
Notes in the Help menu. 

 

6 . 2  S T A R T I N G  A N D  E X I T I N G  B O W T I E X P  

6 . 2 . 1  S t a r t i n g  B o w T i e X P  
You can either start BowTieXP from the start menu, desktop shortcut, or by double-clicking a 
BowTieXP Case File. 
 

6 . 2 . 2  E x i t i n g  B o w T i e X P  
To exit BowTieXP, choose File → Exit or click the close button in the window title bar. If the open file 
has unsaved changes, you will be prompted to save those before continuing. 

6 . 3  C H A N G I N G  T H E  U S E R  I N T E R F A C E  L A N G U A G E  

BowTieXP has a multi-lingual user interface. In order to change the current language, you first start 
BowTieXP. Choose Help → Choose UI Language or press F9: 
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Figure 48 - Changing the UI language 

 

 

Figure 49 - Choosing a UI language 

 
After selecting your language of choice, click ok. BowTieXP will restart for these settings to take 
effect. 
 
The topmost one (Auto-detect / use Window settings) makes BowTieXP auto detect the language. 
 
At the time of writing, the following languages are available: 

• German 
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• English 

• Spanish 

• Spanish (Mexican) 

• French 

• Italian 

• Japanese 

• Korean 

• Norwegian (Bokmål) 

• Dutch 

• Polish 

• Portuguese (Brazilian) 

• Romanian 

• Russian 

• Turkish 

• Chinese (Simplified) 

• Arab 

6 . 4  W O R K I N G  W I T H  F I L E S  

The following section explains how to work with files within BowTieXP. 
 

6 . 4 . 1  B o w T i e X P  C a s e  F i l e s  
You can open BowTieXP files via File → Open on the main menu. After loading a file, the Tree view, 
diagram, case overview and all other windows in BowTieXP will be populated.  
 
Select a hazard in the Tree view window under a BowTie Group in order to make your diagram 
visible. 
 

Note: The way BowTieXP works with files is very similar to how you open and save files in Microsoft Word. Similarly, 
you can attach your BowTieXP Case Files to your e-mail messages, transfer them to an USB stick, etc. 

 
Creating a new file can be done by selecting File → New… By default, this will create a new file based 
on the built-in BowTieXP Case File template. If you have configured custom templates, you will be 
asked which template to base the new file on. For more details see chapter 14, Working with 
templates on page 137. 
 

 

Figure 50 - Choosing a new file template 
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6 . 4 . 2  I m p o r t i n g  T h e s i s ™  f i l e s  
 

Note: BowTieXP has support for importing Thesis™ versions up until version 6. Contact us for importing later 
versions. 

 
You can import Thesis™ files into BowTieXP by clicking on File → Import Thesis from the drop-down 
menu. After you have imported a Thesis™ file and saved it as a BowTieXP file, you can open it via the 
normal method (File → Open).  
 
If you already had a file open when choosing Import and have made changes, you will be asked 
whether you want to save your changes before continuing. 
 
Note that the Thesis import requires the 64 bits Microsoft Access driver to be installed. It can be 
downloaded from here: 
 

https://www.microsoft.com/en-us/download/details.aspx?id=13255  
 
Be sure to download the 64 bits version.  
 

Note: Check your imported Case File for a correct result of the import and make sure all relevant information is 
present. Not all information can be imported. 

6 . 4 . 3  S a v i n g  f i l e s  

To save the changes you made to a file, choose File → Save or choose the save button  on the 
tool bar. 
 
To save your changes under a different file name, choose File → Save As.  
 
To discard changes, choose File → Close and confirm that you will lose your changes. 
 
You can easily see if you have made changes to the current file by looking at the filename in the title 
bar at the top of your screen. If there are changes, an asterisk (*) is displayed after the filename. 
 

6 . 4 . 4  F i l e  r e c o v e r y   
BowTieXP automatically makes a backup copy of the current file every 10 minutes. This occurs to 
minimize the damage done by an unexpected shutdown of the software due to power failure, 
operating system crash or an unhandled exception in the software. 
 
If you start BowTieXP and it detects there is a backup copy, you will be prompted to save the backup 
copy to a different name. Then inspect the file to make sure you have not lost any data. 
 

Note: The auto save is done to a special directory and does not modify the original file you opened. After auto 
saving you can still abandon your changes by closing the file. 

6 . 5  T H E  U N D O  A N D  R E D O  S Y S T E M  

BowTieXP, like every modern Windows application, has an advanced undo and redo system, which 
tracks all your changes and allows you to undo any modifications. 
 
The undo and redo system in BowTieXP is unlimited, you can go back as far as you want and move up 
again to actions which you have just undone, enabling you to review your latest edits. 

https://www.microsoft.com/en-us/download/details.aspx?id=13255
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6 . 6  N A V I G A T I N G  A R O U N D  T H E  S O F T W A R E  

The picture below shows the main window of BowTieXP. It contains several sub windows, which 
display various aspects of a Case File and have different uses. 
 

 
 

Figure 51 - The default window layout of BowTieXP 

 
The table on the next page describes each portion of the main window and its purpose. You can find 
each window in View → Windows. More detailed information on each window follows in the table, 
and each will be addressed in more detail in the following sections. 
 

Window Purpose 

Tree view Window The Tree view window allows you to easily navigate through 
your diagram and to drill down to very specific parts. The Tree 
view is most useful for navigating between bowtie groups in a 
Case File, adding and deleting elements in your lookup tables, 
and defining and keeping track of activities. 
 

Note: Every piece of information present in the Case File has a place 
in the Tree view; it is the central directory of the Case File. 

 
You can use the export button in the top right-hand corner of 
the Tree view window to export the contents to an Excel file. 

Diagram Window The diagram window is where you usually build your bowtie 
diagrams by adding consequences, threats, barriers and other 
elements.  

Overview Window The overview window gives you a complete map of your current 
diagram.  
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If you have a large bowtie diagram, you can navigate around it 
quickly using this window. Just grab onto the green box and 
drag or expand it over the area you wish to focus on in the 
diagram window or drag a new box in an area you want to see 
in the main diagram window. 

Listview Window When you select an item in the Tree view, the Listview window 
displays a list of the item’s children.  
 
The Listview is made for working with multiple items at the 
same time. 
 
You can use the export button in the top right-hand corner of 
the Listview window to export things to an Excel file.  

Editor Window The editor window displays the details of the currently selected 
item. 
 
This allows you to easily edit your work by clicking on a part of 
your diagram in the diagram window or another item in the 
Tree view and then editing any information for the selected 
item in the editor window.  
 
You can edit and view details about your selection in various 
ways in BowTieXP:  

1. In place edit – double click the text in the diagram to 
change it 

2. In place edit – select an item and press F2 to change the 
text 

3. Popup editor – double click the non-text part of a shape 
to bring up the full popup editor 

4. Popup editor – select an item and press F4 to bring it up 
5. Popup editor – click the little pen icon on a shape to bring 

it up 
6. Docked editor – use the view menu to show the docked 

editor, and this window will show details for the 
currently item 

Scrap book Window Note: This functionality is advanced only 

 
The Scrap book window is like a clipboard on steroids – it allows 
very intuitive Case File editing using drag and drop. See chapter 
18, Advanced functionality: the Scrap Book on page 150. 

Quality Checks Window The quality checks window allows you to do different checks of 
your Case File to make sure it is complete and show areas that 
need more attention. 

Find Results Window The find results window is used to show the results from your 
search command. 

Case Overview Window The case overview window offers insight from different 
perspectives into the relations between the data in your Case 
File. 
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Color Legend The color legend shows an overview of the different colors in 
use on the diagram. 

Relationship Diagrams Note: This functionality is advanced only 

 
The relationship diagrams allow you to visualize the different 
relationships between data in your Case Files from different 
perspectives. 

Spreadsheets Note: This functionality is in BowTieXL only 

 
The spreadsheets are the heart of BowTieXL – they are a 
Microsoft Excel compatible spreadsheet into BowTieXP, which 
exposes the majority of the information in the Case File as 
tabular data in this spreadsheet.  
 
This allows you to use that data to do spreadsheet calculations 
based on that data, and feed the results back into your bowtie 
model. 

6 . 7  H O W  T O  C O N F I G U R E  Y O U R  M A I N  W I N D O W  

BowTieXP has a reconfigurable user interface built around dockable windows. You can: 
 

• Float windows on top of the main window and above the other dock windows. 

• Drag each window to dock it at another position in the main window. 

• Drag each window to resize it. 

• Set windows to automatically hide if not used. 

• Save and load your preferred layouts for various tasks. 
 
The sections on the following pages describe how to create the ideal working space for your needs 
when creating a bowtie diagram.  
 
To float a window or to change its docking position, click and hold the title bar of the window you 
wish to move, and whilst holding down the mouse button, move the mouse, dragging the window 
out of position. 
 
As shown in the graphic below, a transparent blue box will appear to represent the window once you 
drag it out of its original position.  
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Figure 52 – Re-docking the Tree view 

 
Arrow symbols will appear in the center of your screen and around the edges, as 
shown above and on the left. These arrows help you to position your window. 
They define different locations within BowTieXP where you can dock your floating 
window.  
 
Experiment by dragging the mouse pointer and the blue box over the different 

arrows. BowTieXP will show you the position of the selected window if you release your hold on it. 
This feature allows you to see what your new screen would look like with the window positioned in a 
new place without committing to the change.  
 
Find a suitable position for your window and release your hold on the title bar. The window will snap 
into place in the area you have chosen. 
 
If you wish to place a window between two windows, drag the blue box toward the solitary arrow on 
the selected edge of the screen. 
 
Remember, BowTieXP will always show you where the window will be located before you commit to 
the change. 
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Figure 53 - Re-docking the Tree view step by step 

 
 

Note: If you wish to float your window on your screen, just double-click the title bar. This allows you the freedom 
to manipulate its location anywhere it is convenient.  To re-dock, simply double-click the title bar again. 
 
Also, do not forget you can reset the windows to the default by pressing CTRL + SHIFT + F12.   

 

To configure a docked window to auto-hide you can click on the pushpin icon in the title bar ( ). 
When the pin is horizontal, the window disappears into a tab on the side of the main window. To 
make the window reappear, hover your mouse over it or click it. 
 

Note: Auto-hiding dock windows help you gain a lot of screen real estate.  

 
To close a window, click on the X icon in the title bar. 
 
You can reopen any closed window by clicking View → Windows in the drop-down menu and 
selecting the window you want to reopen. 
 
To save time, you can save your favorite layout for later use. This also allows you to have multiple 
layouts for different tasks. 
 
How to save a layout: Arrange the windows the way you prefer. From the drop-down menu, select 
View → Windows → Save Layout As… Name your layout and click Save. 
 
To restore the default screen layout: 
 
Select View → Windows → Defaults from the drop-down menu. 
 
OR 
 
Use the key combination CTRL + Shift + F12.  
 
Also, if you lose a window, select View → Windows on the drop-down menu to restore it to the 
layout. 
 

Note: To simplify this process, use the Layout A – Layout B option. This option allows you to switch quickly between 
two different layouts.  
 
To select Layout B, just go to View → Windows → Switch to Layout B or use the toolbar button. 
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6 . 8  C O N T E X T  M E N U S   

BowTieXP has context menus for each element in the bowtie software. When you right-click on an 
element, a menu appears with related actions. The graphic below is a context menu for a barrier: 
 

  

Figure 54 - The diagram context menu 

 
If you want to know how you can interact with an item, simply right-click it. 

6 . 9  T O O L B A R S  

Some windows have a toolbar at the top, which allows quick access to the most commonly used 
functions. Hover your mouse above a button and a tooltip will popup, which describes the function 
and mentions the keyboard shortcut, if the button has one. 
 
In the image below, the mouse is hovered over the Save button on the main application toolbar.  
 

 

Figure 55 – The main application toolbar with tooltip 

 
All toolbars are described in the relevant section about each window. The main application toolbar is 
described below. 

 
6 . 9 . 1  T h e  m a i n  a p p l i c a t i o n  t o o l b a r  
The main toolbar looks like this: 

 

Figure 56 - The main application toolbar 
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Note: In the default toolbar, some less frequently used buttons are hided. See section 6.9.2 Hide / unhide toolbar 
buttons on page 60. 

 
From left to right it contains the following buttons: 
 

Icon Description 

 
Open file 

 
Save file 

 
Undo 

 
Redo 

 
Navigate back in the Tree view 

 
Navigate forward in the Tree view 

 Copy 

 
Paste 

 
Show inter-process clipboard import errors (Advanced only) 

 
Switch to layout A 

 
Switch to layout B 

 
Restore default Dock layout 

 
Show diagram 

 
Show reports 

 
Server Explorer (BowTieServer only) 

 

6 . 9 . 2  H i d e  /  u n h i d e  t o o l b a r  b u t t o n s  
Any toolbar can be customized by clicking the small button on the far left (see Figure 57). Some more 

advanced functionality is actually hidden from view in these menus ( ). 
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Figure 57: Customizing a toolbar 
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7  
CASE FILE EDITING 

In this chapter, all the windows that pertain to editing your Case File will be discussed. 

7 . 1  I N T R O D U C T I O N  

After we have reviewed how the BowTieXP user interface works, how to create, open, close files and 
how we can navigate through the software, we will look into how we can build and edit our Case 
Files. 
 
In this chapter, we will discuss in detail among others the Tree view, the editor and the diagram. 

7 . 2  T H E  T R E E  V I E W  –  A N A T O M Y  O F  A  C A S E  F I L E  

The Tree view window contains all the information held in your Case File.  
 
You can expand and collapse details in this window by clicking on the plus/minus symbols. 
 
There are a number of main parts / top-level nodes in the Tree view window: Case File, BowTie 
Lookup Tables, incident Lookup Tables (only when IncidentXP is activated), Operations and Risks 
(only in Advanced version), Audits (only when AuditXP is activated), Document Links, Management 
Systems, Compliance Frameworks, System Groups, Wiki Groups, Incidents (only when IncidentXP is 
activated) and BowTie Groups. Each part is explained below. 
 

 

Figure 58 - The Tree view window 

 
Case File – This part of the Tree view presents your Case File, which contains all other elements of 
your BowTieXP file. 
 
BowTie Lookup Tables – The lookup tables define all the pick lists in your bowtie diagram - generic 
information used across the whole case. You can add or remove values from each of the tables as 
needed. The lookup tables allow you to tailor your bowtie diagram so that it fits your organization 
perfectly. 
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Incident Lookup Tables – The lookup tables define all the pick lists in your incident diagram - generic 
information used across the whole case. You can add or remove values from each of the tables as 
needed. The lookup tables allow you to tailor your incident diagram so that it fits your organization 
perfectly. 
 
Operations and Risks – The operations and risks section houses all the information pertaining to the 
summary of operational boundary matrix functionality. This is a part of the Advanced BowTieXP 
edition. See chapter 21,  
Advanced functionality: Soob matrices on page 168 for further details.  
 
System groups - System groups are used to visualize maintenance data on barriers. A system can 
contain sub-system and each system consists of multiple parts. These parts can either be online or 
offline (or the status is unknown). Data from systems like SAP or Maximo can be imported into 
BowTieXP to visualize real-time data on barriers. 
 
Document Links – Document links are references to external documentation that can be added to 
various elements in the Case File. If the information is available on-line, it can also be opened directly 
from within BowTieXP. 
 
Management Systems – A key feature of BowTieXP is the ability to define activities and sub-activities 
and link them to the barriers in your diagram. By right clicking the activities node, you can add, 
delete, and change the order of your activities. You can also insert information about objectives, 
management Actions, performance indicators, competencies and actions. 
 
Compliance Frameworks – Compliance frameworks are used to install standards like the ISO27000, 
API, JCI standard, into your bowties. Specific parts of these standards can be linked to barriers, with a 
view to tracking and demonstrating compliances. 
 
Audits – The Audits node contains the audits, if AuditXP is enabled. See chapter24 about the AuditXP 
add-on for further details. 
 
Wiki groups –Wiki pages are references to internal documentation that can be added to barriers in 
the Case File. They can be linked to barrier in the same manner as the document links. The main 
difference between document links and wiki pages is that the document links refer to external 
documents and wiki pages can actually contain documentation. Note that the wiki functionality is 
mostly useful for when working with BowTieServer, which can display this documentation properly. 
 
Incidents – The incidents node contains the incident diagrams, if IncidentXP is enabled. See chapter 
29, IncidentXP and BowTieXP together on page 262  for further details. 
 
BowTie Groups – This node contains information relating to hazards and bowtie diagrams. Here, you 
will add all your groups, which BowTieXP uses as a starting point for building risk management 
models. 
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Keyboard Shortcuts  

Right arrow Expand the currently selected node. 
Left arrow Collapse the currently selected node. 
* (on numeric keypad) Expands the selected node and all children recursively. 
/ (on numeric keypad) Collapses the selected node and all children recursively. 

 
You can export the contents of the Tree view to Excel by clicking the little Excel icon in the top right 
corner. 

7 . 3  E D I T I N G  T H E  L O O K U P  T A B L E S  ( T A X O N O M I E S  E T C . )  

All taxonomies in the form of dropdown selectors and link collections such as system and user 
systems are customizable and configurable in the software. The contents of those dropdown lists can 
be changed, deleted and added via the Tree view. To do so, find the relevant taxonomy in the BowTie 
lookup tables (or incidents lookup tables in case you want to define incident taxonomies). You can 
browse through the lookup tables by expanding and collapsing the nodes as described in the 
previous section. 
 

 

Figure 59 - Adding a new instance to a taxonomy list 

 
Once you have found the taxonomy node, right click the parent node of that taxonomy (green dot) to 
open the context menu in which a new instance within that taxonomy can be created. Newly created 
instances are added to the bottom of the list but can be reordered with the change order option in 
the right-click menu. 
 
In the example shown in Figure 59, you can see the green parent node “Barrier Types” with the 
currently existing children represented by the blue crosses. Right clicking will the parent node as 
indicated will add a new instance (blue cross) to that list. 
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7 . 3 . 1  A d d  l o o k u p  t a b l e  v a l u e s  
Once you hit the ‘add barrier type’ button a screen like in Figure 60 appears. You can fill in the code 
of this barrier type, this becomes useful when you want to display the values on your bowtie in the 
short description format.  
 

 

Figure 60 - Add barrier type 

 
The name of the barrier represents the long format in the display options. The description is not 
displayed on the bowtie, but this becomes useful in what is meant exactly with this barrier type. 
 
It is possible to indicate barrier types (or other lookup table values, e.g. effectiveness) with colors. 
You can do this when you click on ‘Choose’. A screen like the figure below appears. 
 

 

Figure 61 - Color pattern 

 
The pattern appears in the top bar of a barrier. You can choose any color when you use the little 
arrow on the right side of the colors. If you then click on ‘more colors’ you can be even more specific 
in the color you choose. 

 
 
7 . 3 . 2  D e l e t e  l o o k u p  t a b l e  v a l u e s  
If you want to delete values in the lookup table, you can right click on the value that you want to 
delete and right-click with your mouse and press delete or select the value and press delete on your 
key board.  
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If the value is already used in the bowtie than the software gives you a warning like the figure below. 
If you want to delete the value without a replacement, you choose –None-. If you want to replace it 
by another value, you can select the others in the list. 
 

 

Figure 62 - Deleting a lookup table value 

 
If the replacement value is not in this list, click cancel. First add the value to this list, then delete the 
old value. 

7 . 4  T H E  P O P U P  E D I T O R  A N D  T H E  E D I T O R  D O C K A B L E  

W I N D O W  

When you select an item in any window such as the Tree view, you can use the editor to change the 
name and fields of the selected item or node. 
 
In general, there multiple ways to edit items in BowTieXP: 

1. In-place edit 
a. Double click the text on a shape 
b. Select a shape and press F2 

2. The popup editor 
a. Double click the non-text part of a shape 
b. Select a shape and press F4 
c. Click the small pen icon on a shape 

3. The docked editor 
a. Make sure the docked editor is visible and select a shape in the diagram 

 
The docked editor is not visible by default to save screen space, but you can make it visible by 
selecting View → Windows → Editor. The docked editor is then always visible and will show the 
contents/details of the currently selected shape. 
 
 Here are screenshots of the popup and docked editors: 
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Figure 63 - The popup editor 

 

 

Figure 64 - the docked editor 

 
The popup editor is preferred as it only takes up screen space when needed and allows you to modify 
links at the same time. 
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7 . 4 . 1  U s e r  d a t a  
You might have noticed the editor has a tab page called user data. The user data editor allows you 
define and edit your own custom data on each selected item. For example, we can add numerical 
frequency fields to barrier effectiveness. 
 
Custom data is defined per object type. If we define a field called 'Frequency' on any effectiveness 
value, that field is immediately available on all effectiveness values. 
 

 

Figure 65 - User data editor 

 
The "Add Key" button allows us to define an extra field on a type. Once we define a new key name on 
a type, e.g. barriers, each barrier will now have this field.  
 
The delete key removes a field. Note that this will remove whatever is filled in on any object of the 
same type. 
 
The rename key allows you to change a key name. 
 
The key settings link allows you to set a default value for this key. This default value is then used in 
BowTieXL calculations for all items where a value has not been set. 
 

7 . 4 . 2  L i n k s  
Apart from the tabs called “Editor” and “User Data”, there are several other tabs as well, depending 
on your selection. These tabs are to edit the items linked / assigned such as document links. 
 

 

Figure 66 - Link assignment tab in the popup editor 
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The left-hand side shows all the items which can be linked to the barrier. The right-hand side shows 
all the entities already assigned. To move items between the two sides, you can select them and 
press the relevant arrow icon between the two halves of the screen. You can also drag and drop 
items between the two halves. 
 
Items that are drawn in gray have already been assigned / moved to the right-hand side.  
 
You can filter the items shown by typing information into the filters. You can also sort on each 
column by clicking the headers.  

7 . 5  T H E  D I A G R A M  

The diagram window is where you create your bowtie diagram. When you select a hazard or one of 
its sub items in the Tree view window, the diagram associated with that hazard will appear in the 
diagram window. The item you clicked in the Tree view will be selected in the diagram. 
 

 

Figure 67 - The diagram window 

 
When you move the mouse over the various shapes, some icons will appear and disappear: 

 

Figure 68 - Hovering on the diagram 
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The button allows you to add new items such as threats, consequences, barriers and escalation 
factors.  

 

Figure 69 - Miscellaneous icons within barrier elements 

 
The deck of items icon (left screenshot above) allows you to edit all barriers with the same name – 
same barrier group (Advanced only). This icon has an orange color when barriers in the same group 
have differences in property values. In case the elements are 100% identical, the icon will be 
transparent. The link icon on document links (right screenshot above) will open the link in the 
appropriate program. This could be a web-browser or a program like MS Word or Excel. 
 
The eye icon will allow you to adjust display options relating to the item: 

 

Figure 70 - The small eye icon 

Along the top of the diagram window is a button bar with shortcut options. Certain options on the 
button bar are enabled depending on which part of the diagram you have selected. Some 
infrequently used buttons are hidden by default. They can be added as described in section 6.9.2. 
 

 

Figure 71 - The diagram window toolbars 

 
Icon Description 

 
Zoom In 

 
Zoom Out 

 
Zoom 50% 
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Zoom 75% 

 
Zoom 100% 

 
Zoom To Fit Page 

 
Use animations while collapse/expand bowtie elements 

 
Enable/disable tooltips on shapes 

 

Visually bundle barriers by a similar characteristic, i.e. barrier families 
(Advanced only) 

 Select diagram display profiles (Advanced only) 

 
Configure profiles (Advanced only) 

 
Configure display settings 

 
Refresh/update diagram  

 
Create a new bowtie diagram 

 
Add action 

 
Copy diagram to clipboard 

 
Save diagram as… 

 
 

Note: there are several mouse and keyboard shortcuts to help you navigate and work with the Diagram Window – 
see the table: 

 
Shortcuts Function 

Scroll wheel Scroll vertically through the diagram. 

SHIFT + scroll wheel Allows you to scroll horizontally through the 
diagram. 

CTRL + scroll wheel Changes the zoom level. 

Arrow keys Scroll through the diagram. 

CTRL + arrow keys Scroll through the diagram per page. 

Press scroll wheel / middle button Brings up a scrolling caret similar to the one in 
Internet Explorer. 

Drag a rectangle with the right mouse 
button 

Zooms to that region. 
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Drag on the diagram with the left mouse 
button 

Scrolls the display. 

 
7 . 5 . 1  E x p a n d  a n d  c o l l a p s e  
All shapes on the diagram which have children have a small + or – symbol on the connection point 
where the links to the children meet. This is similar to the + and – symbols in the Tree view, allowing 
you to collapse parts which you do not want to see now. 
 
A faster way to quickly reduce the diagram in size is to use the expand and collapse level buttons, on 
the expand and collapse levels toolbar: 
 

 

Figure 72 - Expand and collapse levels toolbar 

 
 

Icon Description 

 Level 1: Show only the top event and hazard 

 Level 2: Show the top event, the hazard, threats and consequences 

 Level 3: Show the top event, the hazard, threats, consequences and barriers 

 The same as level 3 but also show the escalation factors 

 The same as level 4 but show escalation factor barriers too 

 Show all, including escalation factors on escalation factor barriers 

 
When clicking on these buttons, by default only the bowtie diagram that is currently in view will 
show the desired expansion state. To apply the desired expansion state to all the bowties in the 
casefile you can hold down the SHIFT key while clicking on a particular expand level button. 

 
7 . 5 . 2  D i s p l a y i n g  m o r e  i n f o r m a t i o n  
It is possible to present more details about the shapes on the diagram in a visual manner, leveraging 
the power of this representation in various means: 

1. By showing extra information in each shape, such as activities, document links, BRF codes. 
2. By coloring shapes with the colors and patterns defined on various properties such as 

effectiveness, barrier type, criticality, BRF code. 
3. By showing the risk assessments of top events and consequences visually on the consequence 

and top event shapes. 
4. Many more. 

 
If you want to adjust the display of a specific item, you can click the eye icon on the shape: 
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Figure 73 - Eye shape button 

 
This will bring up a dialog that allows you to adjust the coloring and display of extra information. 
 
All these settings are also available in the diagram display options dialog, along with some extra 
options. You can bring this dialog up by selecting Diagram → Display Options: 

 
 

Figure 74 - Diagram extra info options 

 
In this dialog, you can customize all aspects of how your diagram is rendered. All options are 
explained in detail in chapter 8, Configuring the diagram on page 89.  
 

7 . 5 . 3  F o n t s  
It is also possible to change the typeface of the different shapes, either by modifying the default font 
settings for all shapes, or by changing the fonts on specific shapes.  
 
Use this to make important parts of your diagram stand out. 

 

F i l t e r i n g  t h e  d i a g r a m  

In order to navigate around the diagram easier, and to tailor the display to your needs, there are 
several different filters available for you to use. 
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Figure 75 - Diagram filter selection toolbar 

 
Selection of the filter is done via the filter toolbar. Each filter is discussed below. 

S e l e c t i v e  v i s i b i l i t y  f i l t e r  

You can use this feature to simplify your bowtie diagram temporarily. This is useful when for example 
you are preparing a report and want to include subsets of diagrams in it. 
 
With selective visibility, you can make single items (e.g. a barrier) or items and their children (e.g. a 
threat and its associated barriers and escalation factors) invisible. There are three settings, accessible 
via the toolbar and the menu: 
 
Off – When you select this setting, all items become visible, but the selective visibility selection will 
be saved. 
 
Edit - When you select this setting, the items you marked as invisible will be shown in gray in the 
bowtie diagram. 
 
On - When you select this setting, all items marked as invisible will be removed from the diagram. A 
warning will be displayed in the diagram window. 
 
Reset – Reset your filter settings. 
 
You can make items invisible by choosing the item, right clicking and selecting Selective Visibility → 
Mark as Hidden. You can also make items invisible by clicking the item while holding down the ctrl 
key. 
 

 +  

Figure 76 - Selective visibility filter toolbar 

 
Icon Description 

 
Selective visibility off 

 
Edit / show selective visibility 

 
Selective visibility on 

 
Reset (all visible) 

 
Make a snapshot to the clipboard with selective visibility switched on. 
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A d v a n c e d  f i l t e r  –  i n  B o w t i e X P  S t a n d a r d  

The advanced filter shows only shapes on the diagram that have a reference of any form to the 
entities you have selected. This is best explained by example: 
 
Select the advanced filter as your filter. The entire diagram will disappear except for the top event 
and hazard. 
 
Now, right click an activity in the Tree view, and choose “Add to Filter”: All the barriers that have 
links to the chosen activity will now be displayed. This works not only for activities, but also for 
document links, job descriptions, effectiveness values, for everything that can have any relation with 
a shape on the diagram. 
 
You can also select items that do not have a value set, by adding the so-called 'null value' to the filter. 
In order to do so, right click the lookup table instead of an entry, and select "Add to Diagram Filter". 
 

 +  

Figure 77 - Advanced filter toolbar 

 
 
 
 

Icon Description 

Clear Clear the list of selected entities 

Edit Edit/show the list of selected entities 

 

A d v a n c e d  f i l t e r  –  I n  B o w t i e X P  A d v a n c e d   

The advanced filter, when running BowtieXP Advanced, is expanded with more options. It is a 
configurable filter, allowing you to specify multiple criteria to which a shape must conform to remain 
visible. 
 
For this example, open up the test Case File and select the advanced filter from the filter drop down. 
After selecting it, this toolbar will appear: 
 

 

Figure 78 - Toolbar Advanced filter 

 
The clear button clears all criteria and the edit button allows us to change criteria. We will examine 
an example later that makes this distinction clearer. 
 
Let us press the edit button. The criteria edit dialog is popped up. You must select ‘Add row’: 
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Figure 79 - Edit Advanced filter 

 
The first drop down allows us to choose to filter on diagram shapes or linked elements. The second 
drop down list allows us to pick the type of object we are looking for. Choose “critical”. The third 
drop down chooses on which (text) part of the object we want to filter. Choose “Name”. The last 
drop down is how we want to compare this field. Choose the “like” operator and this will allow us to 
search for a substring. Next, enter the search text – enter “High Critical”. 
 

 

Figure 80 - Edit Advanced filter 

  
 
Press “x”. The diagram will be filtered to show only the barriers with a “High Critical” value assigned: 
 

 

Figure 81 - Applied Advanced filter 
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As you can see, some shapes are grayed out – this is because they do not actually match the filter, 
but an item below it does. In this case, we must show the left-hand side barrier as otherwise we 
could not see the barrier on the escalation factor below it. 
 
We can adjust the filter strength by clicking the arrows in this toolbar button: 
 

 

Figure 82 - Advanced filter strength 

 
You can add as many criteria as needed. You can also specify how to join them – should items agree 
with all criteria? Or is it good enough if an item agrees with a single criterion? This is the AND mode 
and OR mode radio button at the top. 

 

I n c i d e n t  f i l t e r  

The incident filter allows you to filter the diagram down to all shapes that have relations with 
incidents. Including the status counts of the barriers that have been used in incidents. 
 

Note: This is only available if you have both BowTieXP and IncidentXP. See chapter 29, IncidentXP and BowTieXP 
together on page 262 & the IncidentXP Software Manual for more information. 

 
7 . 5 . 4  A u d i t  f i l t e r  
The audit filter will display audit information directly on the barriers in the bowtie. See chapter 24, 
AuditXP add-on on page 202 for more detail. 
 

Note: This is only available if you have both BowTieXP and AuditXP. 

 
7 . 5 . 5  E x p o r t i n g  t h e  d i a g r a m  
The created diagrams can be exported by three means: 

1. By saving them to disk as a picture  and by 

2. Copying them to the clipboard  and pasting them into the destination application and by 
3. Saving them as a picture via the menu bar in Diagram → Save Diagram As… 

7 . 6  O V E R V I E W  W I N D O W  

In the overview window, your entire bowtie diagram is displayed in miniature.  
 

 

Figure 83 - The diagram overview window 
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As some diagrams can be very complex and large in scope, the overview window allows you to 
quickly navigate to a particular section of your diagram. 
 
Left clicking and holding in this screen enables you to drag the green box around a part of the bowtie 
diagram. When the mouse button is released, your selection is displayed in the diagram window. 

7 . 7  T H E  S C R A P  B O O K  

Note: The Scrap book is advanced only functionality 

 
BowtieXP Advanced also offers the Scrap book. It is a bit like a clipboard on steroids, but much more. 
A dockable window that allows you to: 

• Copy entities there to keep them around for a while, and later drag them back into any Case 
File (might be a different one). 

• Exporting entities from Scrap book to Excel. 
• Drop data files (Excel, BowTieXP) and read the info on them into BowTieXP. 
• Convert items from one type to another. 
• Items that cannot be given a place within the current Case File yet can be temporarily stored.  
• Store frequently used items - e.g. make a short list of frequently assigned activities. 
• Build a reference library of elements. 

For details, please see chapter 18, Advanced functionality: the Scrap Book on page 150. 

7 . 8  C O P Y ,  C U T ,  P A S T E  A N D  P A S T E  S P E C I A L  

BowTieXP of course offers copy and paste clipboard functionality that works as you would expect. 
BowTieXP however, offers one extra clipboard feature not commonly seen – the paste special. 
 
Paste special allows you to paste not an entire element, but a subset of their properties. After 
copying an item onto the clipboard, you can right-click an item of the same type and select “Paste 
Special”: 
 

 

Figure 84 - Paste special 
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In the example you can see you can selectively paste items over the selected barrier, ranging from 
text fields (such as the description) to drop down items (such as effectiveness) to linked items (such 
as activities or document links). 

7 . 9  L I S T V I E W  W I N D O W  

The Listview window sums up underlying nodes of the selection you made in the Tree view window.  
 

 

Figure 85 - The Listview 

 
For example, when you click on activities, the Listview will display a list of all activities. 
 
The Listview is useful for working with multiple items at the same time. For example, you could select 
multiple activities all at once and drag and drop them onto a barrier in your diagram.  
 
There are multiple ways to select multiple items: 

• Click the first item you want to select. Then hold down the ctrl key and click other items you 
also want to select. This allows you to select items one by one. 

• Click the first item you want to select. Then hold the shift key and click the last item in the 
group that you want to select. This will select all items from the first to the last. 

 
7 . 9 . 1  E x p o r t i n g  t o  E x c e l  
In the upper right-hand corner of the Listview, you may have noticed a small Excel icon. Click this and 
the contents of the Listview will be exported to Microsoft Excel. 
 

7 . 9 . 2  U s a g e  r e f e r e n c e s  /  b a c k l i n k s  
The Listview is also used for another important function: the display of backlinks. 
 
When an activity is referenced on say, a barrier, there’s a virtual arrow pointing from the barrier to 
the location in the Tree view where the activity is defined. This arrow is called the link. We can also 
follow this arrow in the reverse direction, from the activity to all the barriers where it is used. These 
are called the backlinks. The backlinks are all the places where the item is used. 
 
A similar concept applies to lookup table values.  For each item, we can find out where they are used 
by showing us their backlinks.  
 
This is done by right clicking the item of which you want to see where it is referenced and selecting 
the option in the context menu called “Show usage references”. The Listview will show the usage 
references and indicate that it is doing so. 
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7 . 1 0  D R A G  A N D  D R O P  

Throughout the application, you can use drag and drop to assign links to objects. Almost every 
barrier that lists linkable entities supports grabbing one of those and dragging it towards where you 
want to link it. 
 
Drag and drop can also be used for creating and assigning document links. See section 3.11.3,  
Drag and drop on page 29 for more details. 

7 . 1 1  T R E E  V I E W  F I L T E R I N G  

This feature allows you to remove seldom used or unused elements from the Tree view. You can 
define multiple filters, allowing you to hide and show elements based on the task you are currently 
working on. 
 
To create or modify Tree view filter profiles, you open the “Customize Tree view” dialog box under 
Case → Edit Tree view Filter Profiles. 
 
 

 

Figure 86 - Edit Tree view filter profiles menu option 

 

The “Customize Tree view” dialog is shown.  
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Figure 87 - Customize Tree view dialog 

 
On the left-hand side, the available profiles are shown and there are buttons to modify the list. 
 
There is always one built-in profile present, which shows everything. This one cannot be modified. 
 
After creating a new profile, you can expand the items on the right and deselect the items you do not 
want to see. For example, if you do not regularly use the lookup tables, you can deselect it. It is 
located under the “Top level item visibility”. 
 
You can also deselect collections under items, using the nodes under the “Sub-collection visibility” 
item. If you never use objectives on your activities, you can simply hide them. 
 

 

Figure 88 - Tree view elements available for hiding 

 
After clicking okay, your changes are saved. After defining a profile, you will now get a new drop-
down box on the Tree view that allows you to select your filter profile. 
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Figure 89 - Tree view filter profile selection 

 
After selecting your modified changes, they are immediately applied.  
 

7 . 1 1 . 1  T r e e  v i e w  f i l t e r s ,  g r o u p i n g  b y  h a z a r d  
By default, the bowties in the Tree view are grouped by BowTie Groups. Additionally, users can group 
hazards in other ways by going to the Tree view and right clicking on a bowtie group (e.g. Oil & Gas) 
and selecting ‘Group hazards by …’.  
 

 

Figure 90 - Group hazards by Accountable 

 
After pressing OK, the Tree view will look like this.  
 

 

Figure 91 - Hazards grouped by Accountable 

 
Any combination of values is possible, e.g. Accountable + Type. Grouping by multiple values creates 
nested folders to subdivide the bowties as configured. If you want to remove the grouping you can 

either press the red X in or click on this icon  located in the top left of the Tree view once a 
grouping has been selected.  
 
It is also possible to group on bowtie groups level, please see chapter 16.  
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7 . 1 2  R I S K  M A T R I C E S  

Consequences (and top events) are assessed for their potential for harm in a given category and the 
chance of their occurrence using risk matrices. Each Case File contains up to eight risk matrices for 
this purpose, and they are fully configurable.  
 
Each matrix is used twice on each hazard: once for the inherent risk assessment, once for the 
residual risk assessment. 
 
Top events (Hazards) can also be assigned risk assessments. 
 
When adding or editing a consequence or a top event, the risk matrices can be brought up to assess 
the consequence by clicking on the appropriate button for each assessment. 
 
Configuring of the risk matrices is done via the Case → Edit Risk Matrices menu option. When you 
select one of the risk matrices out of the list, the risk matrix editor dialog box will appear. 
 

Note: You can clear all risk assessments in the Case File using the Case → Clear Risk Assessment options. 

 
 

 

Figure 92 - Risk matrix editor 

 
How to change the dimensions of the risk matrix: Right-click on the severity tables (vertical axis) or 
the frequency labels (horizontal axis) and select the appropriate option. 
 
How to edit the categories: You can edit, add or delete categories anywhere on the risk matrix by 
right clicking them.  
 

Note: The risk matrix category order should be from low impact at the top to high impact on the bottom, i.e. from 
green to red. The order is used to compare and sort items by risk score. See chapter 7.12.1 for more information. 

 
How to edit a cell label: right click the item and select the “Edit” option. 
 
Changing the risk assessment of a matrix position: 
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1. Select the risk category you wish to use in making changes to the diagram.  
2. Then, select the position within the graphic representation that you wish to change.   

 
For example, we want to change A1 from yellow – Incorporate Risk Reduction Measures – to green – No Impact. In the graphic 
below, notice that the green risk category has been selected.  

 

 

Figure 93 - Risk matrix editor with selected category 

 
3. Now select A1, the position you wish to change.  
4. Once you select it, the category color will change. 
5. Notice how in the graphic on the next page, the color of A1 changed from yellow to green once the new risk category 

was selected. 

 
 

 

Figure 94 - Risk matrix editor with changed cell 

 
By default, coordinates will first list the X value (horizontal, frequency) first followed by the Y value 
(vertical, impact). In the screenshot above, we see the coordinate of the selection is listed as A1. You 
can customize this by clicking the XY button behind the “Display assessment code as”, and the order 
will be reversed. 
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You can also use custom labels for the coordinates. 
 

Note: if you are not using some matrices, clear their name. This will make them disappear from the UI and on 
reports. 

 

7 . 1 2 . 1  R i s k  m a t r i x  c a t e g o r y  o r d e r  
The order of the risk matrix categories is important; they must be listed from low impact (green) to 
high impact (red). The order is used to compare and sort items by risk score. 
 
This is used in various reports and overviews, but it is most important when using BowTieServer – 
because BowTieServer uses the order to determine is things are improving or not. 
 
The risk matrix can still have completely custom zones, as illustrated in Figure 95 below, as long as 
the categories are ordered from low impact to high impact. 
 

 

Figure 95 - Risk matrix example 

 

7 . 1 2 . 2  A u t o m a t i c  H a z a r d  r i s k  a s s e s s m e n t  
Hazards risk assessment values can be configured to automatically set and follow the most severe 
values of the hazard’s consequences. 
 
By default, the hazard risk assessment for inherent and residual risk must be manually selected. 
However, when checking the box as indicated in Figure 96, the Hazard risk is automatically populated 
based on the worst case of the consequence risk assessments of that bowtie. For example: the 
worst-case residual risk for People coming from one of the consequences is D5. This populates the 
residual risk for People on the Hazard as D5. 
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Figure 96 - Automatic Hazard risk assessment 

7 . 1 3  A C C E P T A N C E  C R I T E R I A  

It is possible to define general acceptance criteria for threat barriers, escalation factor barriers, 
consequence barriers and barriers in general. These criteria can be accepted on each element. To 
give an example: acceptance criteria for a barrier could say that there should at least be someone 
accountable for the barrier, and it should have at least one activity. Threat criteria might say that a 
particular category of threats requires two different types of barriers before it is acceptable whereas 
another category might only require one type. 
 
To define acceptance criteria, edit a Bowtie Group and click the tabs next to Bowtie Group Name. 
The criteria are described as free text. 
 

 

Figure 97 - Bowtie group edit window 

 
To use the criteria, edit for instance a threat, at the bottom you will see two things. First, a “View 
Criteria” button, which will give you a popup with the acceptance criteria text Second, an 
“Acceptance criteria have been met” tick box. This will be ticked once the threat adheres to the 
criteria. 
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Figure 98 - Edit threat window 

 
In the quality checks (see section 7.15, Quality checks window on page 87), there are also several 
reports that will list all the elements that do not yet meet the acceptance criteria. 

7 . 1 4  T E X T  F I N D  A N D  R E P L A C E  

See chapter 9.4.1,  
Text find and replace on page 104. 

7 . 1 5  Q U A L I T Y  C H E C K S  W I N D O W  

You can find the quality checks hidden on the right side of the diagram in the default layout.  
 

 

Figure 99 - The quality checks window 

 
The quality checks can display a number of different reports pertaining to the quality and 
completeness of the bowtie case you are building. 
 
From the drop-down box at the top of the window, select the report you want from the list. Once 
you have selected a report, the window is populated with the results.  
 
To refresh the list of items, click the button with the blue circular arrow. 
 
If you select, for example, “Hazards where accountable has not been set” as shown in Figure 99, a list 
of all the hazards where no responsible party has been assigned is displayed.  
 
The quality checks are extremely helpful in identifying holes in your analysis. 
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7 . 1 6  R E V I S I O N  I N F O  

Each hazard has a revision info tab that can be used to display revision information on the bowtie 
diagram. Double click a hazard and go to the tab called revision info. As soon as you pick something 
from the “Revision Information Box Alignment” dropdown, the revision info will be displayed on the 
diagram. 
 

 

Figure 100 - Revision info 

 
The revision info will also be added to the diagram when exporting it as a picture. 
 

 

Figure 101 - Revision info text box 
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8  
CONFIGURING THE DIAGRAM 

In this chapter, we explore how to configure the diagram appearance. 

BowTieXP has a diagram that is configurable in many ways – there are loads of options to tailor the 

display to your needs. You can apply various colors and show all kinds of extra information. This 

chapter will explain all the various settings. 

Due to the large amount of settings, you can also configure those into profiles, allowing you to 

quickly switch between predefined settings. 

8 . 1  C H A N G I N G  S E T T I N G S  F O R  A  S I N G L E  T Y P E  O F  I T E M  

In the diagram, if your mouse is near or above an item, an eye-shaped icon will appear: 

 

Figure 102 - Eye-shaped icon 

 
If you click it, a dialog box will appear which allows you to customize the display of the item: 
 

 

Figure 103 - Set element display dialog box 

 
It lists all the fields that can be shown on the diagram as extra information boxes. This is done by 
selecting the button on the S or L column. S stands for Short format and L stands for Long format. 
 
You can also select which property is to be used to color the item – this is done by selecting the check 
box in the color column. For example, if we select to show the acceptance criteria have been met, 
the threat looks as follows: 
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Figure 104 - Acceptance criteria value shown on a threat 

 
You can adjust the display for all items on the diagram. If you need to configure more than one item, 
you can also use the large diagram display options dialog, discussed in the next section. 

8 . 2  C H A N G I N G  A L L  T H E  S E T T I N G S  

Modification of the current settings is done by clicking the eye-icon in the toolbar icon ( ). This 
brings up the current display settings. Modifying these does not change any of the profiles. 
 

 

Figure 105 - Diagram display options – “Show” 

 
This dialog consists of several tabs that allow you the change the appearance of the diagram. 

8 . 3  I N F O R M A T I O N  T O  S H O W  /  T H E  “ S H O W ”  T A B  

The first tab is about what texts to display, whether to display actions and risk assessments, and 
what extra information to display.  
 
The left-hand side of this dialog barriers various settings: 
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Figure 106 - Diagram display options – left-hand side of "Show" tab 

 

• If and where to show the hazard code. 

• If and where to show the BowTie Group name. 

• Whether or not to show actions, and if so which ones – only the uncompleted or overdue 
ones? 

• If the risk assessments on consequences and hazards should be shown – if so, which ones? Or 
both? 

• If activities should be shown as separate boxes in the diagram. 

• Causation Descriptions refers to IncidentXP. 
 
The right-hand side barriers which extra information to show on the diagram shapes: 

 

 

Figure 107 - Diagram display options – right-hand side of "Show" tab 
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For each bit of information present on an item there are three options: 

• S for Short format 

• L for Long format 

• Off to not display the information 
 
Here is an example of short format used on threats: 
 

 

Figure 108 - Short format example 

 
Here is an example of long format used on threats: 
 

 

Figure 109 - Long format example 

 
Note: Properties will always have a box on the shape, but it might be empty if no value has been assigned. Links 
(such as activities on barriers) will have one box per item – no extra boxes will appear if no items are linked. 

 
8 . 3 . 1  C o l o r s  t o  u s e  /  t h e  “ C o l o r s ”  t a b  
 
The next tab is about how to color the shapes. 
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Figure 110 - Diagram display options – “Colors” 

 
In the left-hand side of this page, we can configure which color to give actions, and if we want colors 
to appear in the extra info boxes (configured on the previous tab page). 
 
In the right-hand side of this page, we can select which property to use to color the main shapes. 
 
Here is an example - select to color barriers by their effectiveness: 
 

 

Figure 111 - Diagram display options - color barriers by effectiveness 

 
In addition, the shapes will change color: 
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Figure 112 - Example of using barrier effectiveness for coloring 

 
We can also show the effectiveness in an extra info box (select this on the first tab called “Show”).  
 
Then we can enable colors on the extra info boxes and get this result: 
 

 

Figure 113 - Example of showing barrier effectiveness as extra information (colored) 

 
If some colors lead to bad readability, we can also choose to display the color only in the little box on 
the left-hand side. This can be done in the ‘extra info color location’, under the “colors” tab: 
 

 

Figure 114 - Example of showing barrier effectiveness as extra information (colored as flag) 

 

8 . 3 . 2  F o n t s  t o  u s e  –  t h e  “ F o n t s ”  t a b  
 
The next tab allows us to set default fonts.  
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Figure 115 - Diagram display options – “Fonts” 

 
Click the button to bring up a font dialog. An example of the current font will be showed in the box. 
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8 . 3 . 3  S i z i n g  a n d  l a y o u t  –  t h e  l a s t  t a b  
 
The final tab contains various options related to sizing and layout: 
 

 

Figure 116 - Diagram display options – “Sizing & Layout” 

 
Dynamic sizing is the default but can sometimes look slightly messy due to the height difference from 
box to box. In this case, fixed sizing might look better. 
 

 

Figure 117 - Default dynamic sizing 
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Figure 118 - Fixed sizing with outside alignment 

 
 
The connector line thickness can be adjusted. 
 
If wanted, the threats and consequences can be aligned against the outside of the diagram. 
 
Vertical diagram compaction can be switched off if it is causing problems. 
 
The barrier color legend can be scaled down if needed. 
 
All diagram element sizes and distances are editable under “Diagram Element Dimensions”. 

 
It is possible to change the curved lines into straight lines. In the figure below the differences in the 
lines are shown.  
 

 

Figure 119 - Curved vs straight lines in the bowtie 

 
This setting is called ‘Draw bowtie edges as bezier curves’.  

8 . 4  A D J U S T I N G  L O O K U P  C O L O R S  

The colors used on the diagram are fully adjustable. They can be set using the editor in the Tree view. 
For example, to adjust effectiveness colors, we go into the Tree view into the lookup tables node, 
into the effectiveness node, where we double click the item we want to modify: 
 



 

©  W O L T E R S  K L U W E R  |  C G E  R i s k  2 0 2 0  
C O N F I D E N T I A L  A N D  P R O P R I E T A R Y  

 

B O W T I E X P  S O F T W A R E  
M A N U A L  

 

P A G E  9 8  

 

 

Figure 120 – Changing the effectiveness colors 

 
In the editor, we click on the “Choose” button to bring up the color picker dialog: 
 

 

Figure 121 - Color picker dialog 

8 . 5  A D J U S T I N G  L O O K U P  C O L O R S  F O R  U N A S S I G N E D  

V A L U E S  

The color used when no value has been assigned to a property can also be adjusted – Select Case -> 
Edit null value colors in the menu. This will bring up the following dialog: 
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Figure 122 - Null value colors 

 
Clicking an item will bring up the color picker dialog. 
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9  
CASE FILE ANALYSIS 

In this chapter, we take a look at the different methods for analyzing your Case File. 

9 . 1  I N T R O D U C T I O N  

The end purpose of building a Case File is of course to be able to analyze all the data and relations 
you have created in order to gain better understanding and insight. This chapter focuses on all the 
different methods BowTieXP offers for doing so.  
 
We will discuss the case overview, searching information and relationship diagrams. 

9 . 2  C A S E  O V E R V I E W  

You can find the case overview in the main menu: View →Windows → Case Overview. 
 
The Case File overview presents many views onto the data in the Case File from different 
perspectives (“overview”), allowing visualization of relationships, which might otherwise be less 
evident, and allowing you also to quickly finding related data. 
 

 

Figure 123 - The case overview 

 
All output from each overview can be exported to Excel by means of the “Export to Excel” button.  
 
The output is searchable by means of the “Expand by keywords” textbox along with the next and 
previous hit buttons. 
 
In addition, present are expand/collapse all buttons to reduce or increase the amount of on-screen 
information, as well as a button to navigate to the definition of the selected node in the main Tree 
view. 
 
When information in the Case File changes, the Case File overview will update automatically. If, for 
some reason, you want to rebuild the output you can do so with the “reset/reload” button. 
 
Using the drop-down menu on the toolbar, labeled Overview Perspectives, you can change the 
perspective. 
 
The other two case overview toolbars are shown below. 
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Figure 124 - The case overview toolbars 

 
 

Icon Description 

 
Execute expand by keyword operation by means of the keywords entered 
into the text box 

 
Go to previous keyword match 

 
Go to next keyword match 

 
Expand all  

 
Collapse all 

 
Go to definition in the Tree view 

 
Show relationship model of selected entity 

 
Reset/reload 

 
Export to Excel 

 

9 . 2 . 1  C l a s s i c  p e r s p e c t i v e  
The classic perspective lists all bowtie groups, hazards, threats and consequences present in the 
current file along with each consequence’s risk assessments. This overview is similar to a classic 
hazard register. 
 

9 . 2 . 2  M a n a g e m e n t  s y s t e m  p e r s p e c t i v e  
 

Note: This perspective is available in BowtieXP Advanced only. 

 
The management system perspective lists all defined activities, similar to the Tree view, but with 
some extra deduced information. 
 
For each activity, the associated barriers are listed, and for each barrier, you can drill down to see the 
threat, consequence, or escalation factor to which it belongs and you can keep drilling down all the 
way up to the hazard/top event. 
 
As each hazard has a hazard category, activities are associated with hazard categories via the barriers 
on which they are linked. All the hazard categories that an activity is associated with in this manner 
will have an “x” cross-mark in the hazard category column. 
 
The responsible persons are also listed. 
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Activities that do not have any relation with barriers are shown in a gray font.  
 

9 . 2 . 3  S y s t e m s  a n d  u s e r  s y s t e m s  p e r s p e c t i v e  
 

Note: This perspective is available in BowtieXP Advanced only. 

 
The systems and user systems perspective is similar to the management system perspective and lists 
where each system is used. 
 

9 . 2 . 4  J o b  t i t l e s  p e r s p e c t i v e  
This perspective lists all job titles present in the Case File and finds all activities and barriers where 
they are referenced.  
 
All barriers where an activity is referenced are also listed so you are able to drill down to all barriers 
which are related to a given job title, starting from that job title. 
 
Exporting this perspective yields a power overview of all barrier responsibilities per job title, which 
reveals accountability for barriers and activities that support barriers. 
 

9 . 2 . 5  O p e r a t i o n s  p e r s p e c t i v e  
Note: This perspective is available in BowtieXP Advanced only. 

 
The operations perspective lists all the operations defined in the file and which hazards, threats and 
consequences they are associated with. When a hazard is not directly associated with an operation 
but via one of its threats or consequences, it will be printed in a gray font. 
 

9 . 2 . 6  I n c i d e n t s  p e r s p e c t i v e  
Note: This perspective is available only if you have IncidentXP and BowTieXP both. 

 
The incidents perspective shows all the incidents in the file, finds, and aggregates information 
pertaining to those. It is a very powerful tool to analyze incidents individually, but also to analyze 
multiple incidents together. 

 
9 . 2 . 7  D o c u m e n t  l i n k s  p e r s p e c t i v e  
This perspective lists all document links defined in your Case File and where they are used.  
 

9 . 2 . 8  B a r r i e r  r e g i s t e r  p e r s p e c t i v e  
This perspective finds all barriers defined within your Case File and then counts the number of times 
each one appears.  
 
Barriers are matched by using the code and description fields. If these fields are identical on two 
different barriers, BowTieXP will list them as the same barrier. You can then expand each node to 
display where these barriers exist in your Case File. 
 

9 . 2 . 9  T h r e a t s  r e g i s t e r  p e r s p e c t i v e  
The threats register lists and aggregates all threats in the Case File, shows the number of times they 
occur, and where they are located.  
 

9 . 2 . 1 0  E s c a l a t i o n  f a c t o r s  r e g i s t e r  p e r s p e c t i v e  
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The escalation factor register lists and aggregates all escalation factors in the Case File, shows the 
number of times they occur, and where they are located. 
 

9 . 2 . 1 1  C o n s e q u e n c e s  r e g i s t e r  p e r s p e c t i v e  
The consequences register lists and aggregates all consequences in the Case File, shows the number 
of times they occur, and where they are located. 
 

9 . 2 . 1 2  A c t i o n s  p e r s p e c t i v e  
This perspective finds all actions present in the Case File and displays them in two groups: completed 
actions and uncompleted actions. 

9 . 3  Q U A L I T Y  C H E C K S  

The quality checks are also a valuable source of information about your Case File. The quality checks 
window can display a number of different reports pertaining to the quality and completeness of the 
bowtie case you are building. 
 
The quality checks window is extremely helpful in identifying holes in your analysis and finding 
locations where more attention is needed. 
 
For more details about the quality checks, please refer to section 7.15, Quality checks window on 
page 87. 

9 . 4  S E A R C H  B O X  

In the top right of BowTieXP there is a search box to search for words or elements within the Case 
File. It finds the exact location of a term or string of text within your Case File.  
 
After entering your search term or search string, BowTieXP gives you exact details of where each 
match was found in the results window, along with its name and the name of the field in which it was 
found. 
 
In the results window there is multi-edit (with BowtieXP Advanced) and drag and drop support. 
 
If you click on a result, BowTieXP will: 

1. Navigate to the location in the Tree view. 
2. Navigate to the location in the diagram, if it is an element in a diagram. 
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Figure 125 - The text find window 

 
 
It is possible to search for elements with a specific value. You can search either an ‘equal’ value or a 
‘like’ value of a bowtie element by using these formulas: 
 

• ‘Equal’ searching → =(bowtie element, “value”) 

• ‘Like’ searching → ~(bowtie element, “value”) 

• ‘Is not’ searching → <>(bowtie element, “value”) 

For example: You want to see every barrier that has ‘passive hardware’ as barrier type. When you 
enter =(barrier type, “passive hardware”), all barriers with the barrier type ‘passive hardware’ 
appear in the search box. 
It is also possible to search for empty values within an element by only typing two quotation marks 
without a word in it. For example, you can use =(code, “”) when you want to search for every bowtie 
element with an empty code field.  
This is useful for when you want to check if every entity has been filled in or when you want to see 
how many bowtie elements you have with a specific value. 

 
9 . 4 . 1  T e x t  f i n d  a n d  r e p l a c e  
You can also replace found values, either one at a time or all at once. To do this, click the arrow next 
to the search icon (Figure 126), and click the Text replace button at the bottom. Alternatively, go to 
Tools > Text Replace. 
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Figure 126: The Text replace button 

 
Specify what to find, what to replace it with, and click Find. The search results will list all matches, 
and you can replace values one at a time or all at once. 
 

 

Figure 127: The Text replace dialog 

 
Before doing a replace all operation it is prudent to at least do a cursory check of all the found items, 
although you can of course always undo the operation. 

9 . 5  A D V A N C E D  F U N C T I O N A L I T Y :  R E L A T I O N S H I P  M O D E L S  

After building a complete Case File, and adding all the relations, the relationship models allow you to 
analyze and navigate these relations visually, offering greater insight into your data. 
 
Accessing relationship diagrams is done via the context menu in the diagram or the Tree view. When 
right clicking an entity for which a relationship diagram can be drawn, you will see the menu entry 
for the relationship diagrams similar to the one shown below. 
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Figure 128 - Relationship diagram menu 

 
After selecting the desired relationship diagram, it will be shown as in the figure below. 
 

 

Figure 129 - Example relationship diagram 

 
In the relationship diagram, you can navigate to another relation by clicking any shape with the left 
mouse button. A menu will pop up allowing you to choose the relation to follow. For example, 
following the option highlighted in the screenshot above, we will go to the diagram pictured below. 
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Figure 130 - Example relationship diagram 

 
Right clicking any shape allows you to go to the item’s definition in the Tree view, go to another 
diagram, or to remove the clicked item from the diagram for presentation purposes. 
 
Toolbar buttons allow you to save the picture, copy it to the clipboard, and navigate between 
previously drawn relationship diagrams. 
 
The tables below list all the available relationship diagrams, grouped by the type on which they are 
available. 
 
The following relationship diagrams are available when an activity has been selected: 
 

Name Description 

Activity: Hazards. All the hazards associated to the activity, via barriers, 
threats, consequences and escalation Factors. 

Activity: Hazards, including child 
Activities 

Same as above, but also including the child activities. 

 
 
The following relationship diagrams are available when a Hazard has been selected: 
 

Name Description 

Hazard: Operations.  Collects all the operations linked on the hazard and its 
threats and consequences and shows them with the 
hazard. 

Hazard: Activities All the activities associated to the hazard, via barriers, 
threats, consequences and escalation factors. 

Hazard: BRF Codes.  This gathers all used BRF codes on all barriers beneath a 
hazard (via the threats, consequences etc.) and shows 
them. 

Hazard: Job Titles (Hazard 
Accountable and Barrier 
Accountable).  

Collects all the job titles used as barrier accountable 
persons and as hazard accountable persons and shows 
them together with the hazard. 

 
 
The following relationship diagrams are available when a threat has been selected: 
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Name Description 

Threat: Operations All the operations associated with the threat. 

 
 
The following relationship diagrams are available when a consequence has been selected: 
 

Name Description 

Consequence: Operations All the operations associated with the consequence. 

 
 
The following relationship diagrams are available when a job title has been selected: 
 

Name Description 

Job Titles: Activities.  Finds all the activities where the given job title is used. 

Job Titles: Barriers, Activities, 
Operations and Hazards.  

Collects all the activities, operations and hazards that 
are related to the selected job title and draws a 
diagram. 

Job Titles: Barriers. Finds all the barriers where the given job title is used. 

Job Titles: Operations. Finds all the operations where the given job title is 
used. 

Job Titles: Hazards, Operations. Finds all the hazards and operations where the given 
job title is used. 

 
 
The following relationship diagrams are available when an operation has been selected: 
 

Name Description 

Operation: Hazards Shows all the hazards the given operation is related to. 

Operation: Hazards, Threats and 
Consequences 

Shows all the hazards, threats and consequences the 
given operation is related to. 
 
See Figure 131 - Operation: hazards, threats and 
consequences for an example. 

Operation: Job Titles  Shows how the given operation is associated via 
hazards to job titles. 
 
See Figure 132 - Operation: job titles for an example. 

Operation: Job Titles (Simple) The same diagram as above but in a different format. 
 
See Figure 133 - Operation: job titles (simple) for an 
example. 

Operation: Soob Matrix Shows how the operation relates to a different one in a 
Soob matrix. 
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Figure 131 - Operation: hazards, threats and consequences 
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Figure 132 - Operation: job titles 
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Figure 133 - Operation: job titles (simple) 

 
 

 

Figure 134 - Bowtie Chaining 
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10  
LINKING TO DOCUMENTATION 

A lot of the information in a BowTieXP Case File has close relationship with documents already in 

existence. This chapter shows how to refer to it from BowTieXP. 

1 0 . 1  I N T R O D U C T I O N  

A lot of information present in a BowTieXP Case File is about matters that have already been 
documented elsewhere, and in a lot of instances within a Case File you will want to refer to that 
external information. For example, when assigning an effectiveness value to a barrier, you may want 
to refer to a specific analysis performed on that barrier.  
 
To solve this need, BowTieXP has included a Document Links section. Document links are pointers to 
external documentation that can be linked onto various elements within your Case File. In this 
chapter, we will explain how to make efficient use of them. 
 
Document links are defined in Document link groups as a hierarchy, and thereafter linked onto 
relevant items in your Case File. To create a document link you can navigate to the document link 
groups node in the Tree view, right-click it and select New Document Link Group. 
 

 

Figure 135 - Add New Document Link Group 

 
Give the group a name, for instance ‘Operational procedures’. Then right-click the group in the Tree 
view and select New Document Link., like in Figure 136. 
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Figure 136 - Add New Document Link 

 
A document link consists of a code, a name, a description and a location, like in Figure 137. The 
location defines where the actual document resides. This can either be a URL or a file path. 
 

 

Figure 137 - Document link editor 

 
If you click on the left Browse button, you can choose a document from your computer. The right 
Browse button guides you to a Sharepoint environment (if your organization makes use of 
Sharepoint, note that Sharepoint is no longer actively supported). 
 
After defining your document links, they can be linked onto bowtie elements by dragging and 
dropping from the Tree view or by using the editor screen as shown in Figure 138. 
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Figure 138 - Linking document links 

 
When assigned they can be shown on the diagram, and quickly accesses by means of the “Open” 
button: 
 

 

Figure 139 - Barrier showing documents links along with "open" button 

1 0 . 2  U S I N G  D R A G  A N D  D R O P  W I T H  W E B B R O W S E R  O R  F I L E  

E X P L O R E R  F O R  D O C U M E N T  L I N K S  

You can directly drop a URL or a file onto a bowtie element. BowTieXP will search through all 
document links to see if the file or URL is already known. If it is already known, the link is connected. 
 
If you drop an unknown file or URL onto a bowtie item, BowTieXP will pop up the editor and ask you 
to fill out some details. When you press ok, the new document link is added to the list of document 
links and the link is created. 

1 0 . 3  U S I N G  R E L A T I V E  P A T H S  F O R  D O C U M E N T  L I N K S  

If you locate the documents you will be linking to next to the .btf file, BowTieXP will create document 
links with relative paths. If you copy all the documents along with your .btf file, you will be able to 
open them anywhere. 
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11  
BOWTIE CHAINING 

At times you need be able to analyze the consequences of consequences within a bowtie frame, or 

the threats of threats. This is made possible with Bowtie chaining.  

1 1 . 1  C H A I N I N G  T H R E A T S / C O N S E Q U E N C E S  W I T H  T O P  

E V E N T S  

The software allows you to chain two or more bowties together. Chaining is the process of 
connecting bowties to create a sequence in which the top events logically follow each other. 
Chaining is done by connecting threats/consequences to top events. By doing so, a consequence in 
diagram X will be a top event in diagram Y, which can be a threat in diagram Z. 
 
Before you chain the bowtie diagrams, you must create all the bowties that you want to chain. On a 
threat or consequence (diagram X), there is an Equivalent Top Event dropdown in the threat editor. 
Select the top event that is the same as that threat/consequence (diagram Y): 
 

 
 

Figure 140 - Equivalent top event drop down 

 

1 1 . 2  D I S P L A Y I N G  A N D  N A V I G A T I N G  C H A I N E D  B O W T I E S  

In the display options, on the ’Show’ tab of the large eye icon , tick the bottom left two boxes 
under Equivalent Top Event: 
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Figure 141 - Diagram display options - Equivalent top event 

 
On the bowtie diagram, small shaped top events will appear next to the chained threat or 
consequence. Hover over one of the new top event shapes and you will see a little green button 
appearing in the bottom right corner. Click it to switch to that chained bowtie diagram. 
 

 
 

Figure 142 - Chained bowtie "Go to-button” 

 
1 1 . 2 . 1  B o w t i e  c h a i n i n g  r e l a t i o n s h i p  m o d e l  

 

Note: Relationship models are only available in BowtieXP Advanced. 

 
It is also possible to show the relation between the chained bowtie diagrams in a relationship model. 
Right click on the chained top event and chose ‘Draw relationship model → BowTie chaining’. For an 
extensive explanation about relationship models, see Chapter 9.5 Advanced functionality: 
relationship models. 
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Figure 143 - Draw relationship model - Bowtie Chaining 

 

 
 

Figure 144 - Relationship model - Bowtie chaining 

1 1 . 3  C H A I N I N G  B A R R I E R S  T O  O T H E R  B O W T I E  D I A G R A M S  

Barriers can also have an equivalent top event. Conceptually speaking, chaining barriers to top 
events is especially useful when the barrier has many escalation factors linked to it. In such a 
scenario it could be better to change the escalation factors to threats in the chained bowtie diagram. 
Please note that chained barrier will not appear in the relationship model diagram and is also not 
visualized on the bowtie except as an extra info box under the barrier, like in Figure 137 - Barrier 
linked to Top EventFigure 137. 

 

Figure 145 - Barrier linked to Top Event 
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12  
GETTING DATA INTO BOWTIEXP  

In this chapter, we examine various ways to get data into the BowTieXP application. 

1 2 . 1  I M P O R T I N G  E N T I T I E S  F R O M  O T H E R  B O W T I E X P  C A S E  

F I L E S  

It is possible to import entire diagrams from other BowTieXP Case Files using the File → Import 
Entities option. After choosing the file you want to import, the entity selection screen is brought up. 
The import functionalities you have access to depend on the type of license you have; BowtieXP 
Standard or Advanced. To find out which license you have, go to Help → About in the upper tool bar. 
See at Enabled Features if you have BowTieXP (which is the Standard version of BowTieXP) or 
Advanced BowTieXP. 

 
1 2 . 1 . 1  I m p o r t i n g  e n t i t i e s  w i t h  B o w t i e X P  S t a n d a r d  
If you have the BowtieXP Standard software version, the entity selection screen will look as pictured 
below: 
 

 

Figure 146 - Import entities window BowtieXP Standard 

 
By checking the boxes to the right of the listed entities, they are selected for importing.  
 

Note: You can right click items and choose to select the item and all its children. This is useful if e.g. you want to 
import all entities. 
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You can also import: 

• Diagram Display options profiles: Chapter 17 Advanced functionality: diagram display profiles  

• Tree view filter profiles: Chapter 7.11 Tree view filtering 

• Risk matrices: Chapter 7.12 Risk matrices 

• Tree view tooltips: Chapter 7.11 Tree view filtering 

• Type and property descriptions: Chapter 20 Advanced functionality: type and property 
descriptions 

 
Once your selection is complete, you can press OK to start the import. After completion, the screen 
will change and the results of the import operation will be shown, together with a legend at the top: 
 

 

Figure 147 - Import entities results 

 
Review all these results to ensure the import operation was done as you intended. Note that if the 
results are not as wanted, you can undo the entire import operation by pressing undo. 
 

Note: Referenced information (e.g. information linked to barriers such as effectiveness values, activities, etc.) is not 
imported . 

 
1 2 . 1 . 2  I m p o r t i n g  e n t i t i e s  w i t h  B o w t i e X P  A d v a n c e d  
 
This is similar to the import as described above, except for three important differences: 

• Reference information can also be selected to import.  

• Lookup table inconsistencies are resolved/will be assigned on the imported data. 

• Linked entities such as activities will be resolved / the links will also be imported. 
 
Let us clarify with an example – you want to import a hazard with some threats and barriers, and on 
those barriers, there are linked activities and assigned effectiveness values. Using BowtieXP 
Standard, it would only be possible to import the bare hazard, threats and barriers. Barriers would 
not have any activities assigned to them and the effectiveness values would all be set to “No Value 
Assigned”. 
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With BowtieXP Advanced, BowTieXP will try to resolve those items using data that is already present 
in your target file. This is done by looking for entities with the same name within the Tree view – to 
resolve an effectiveness value “Good”, BowTieXP looks through all effectiveness values in the target 
file for one named “Good”. If it is found, it will be used. If it is not found, it cannot be linked to the 
existing values. 
 
For the activities the same process is performed – all activities in the target file will be searched for 
ones with the exact same name within the Tree view. If one is found, that one will be aligned.  
 
The results of this search will be displayed after the import is completed. See below for an example. 
 

 

Figure 148 - Import errors 

 
As you can see, some barrier types and activities were not found in the target file. You can prevent 
this by first importing the reference data from the Tree view. Once that is successfully done, you can 
import the bowties with all its content. 

 
1 2 . 1 . 3  C o p y i n g  e n t i t i e s  f r o m  o n e  f i l e  t o  a n o t h e r  u s i n g  
t h e  c l i p b o a r d  
 
In BowtieXP Advanced, you can also copy information from one file to another.  
 
Note that resolving linked information such as activities on barriers, or effectiveness values on 
barriers, is done in the same manner as in the entity importer described in the previous section. 
BowTieXP gives you a warning of the unresolved errors. 
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Figure 149 - Clipboard link resolve errors 

 
Let’s clarify this with a small example: 

1. Start BowTieXP and open the test Case File (File → Open Test File).  
2. Start BowTieXP again and create a new file. 
3. Notice that there are two BowTieXP windows in your taskbar. 

 

 

Figure 150 - Two BowTieXP windows in the taskbar 

 
4. Switch to the test Case File and copy a barrier with an activity to the clipboard. 
5. Switch to the blank Case File and paste the barrier on a threat or consequence. 
6. A screen, like Figure 149 - Clipboard link resolve errors, pops up that shows the copy errors. 

 

1 2 . 2  I M P O R T I N G  D A T A  F R O M  E X C E L  

It is likely that you already have a lot of reference data structures that you would like to import into 
the Case File you are working on. Importing between BowTieXP Case Files is possible with all editions 
of BowTieXP, but for importing from external software such as Excel, you need the ‘Import external 
data’ function offered in BowtieXP Advanced. 
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Data can be imported from Microsoft Excel, comma separated formats, tab-delimited formats and 
.xml files. To start the import, select File → Import External Data. The import external data dialog box 
is displayed. 
 

 

Figure 151 - Import external data dialog 

 
You first need to select the type of data you want to import. The expected layout of the file is shown 
in the yellow text area. For example, if you want to import effectiveness levels, the description would 
read: 
 
“Records/rows with 3 fields/columns named: ‘Code’, ‘Description’, ‘LongDescription”. 
 
Our Excel sheet would have to look like this (note that formatting is ignored with the import): 
 

 

Figure 152 - Sample Excel file for importing 

 
After selecting the type of data to import and reviewing if our input data is in the correct format, we 
can select the file we want to import. Click on the “…” button under 2. ‘External data file’ to open a 
file selection dialog box. After selecting the file, we can optionally choose the worksheet we want to 
import. 
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Next, we are offered the choice if we want to skip existing entities, or add them all as 

new. When ready to import click the “Import data” button. The import will begin and 

progress will be shown in the black status area. We need to review this to see if any 

errors occurred. After the import is completed, a dialog will appear to tell you if the 

import went successfully, like in Figure 147. 

 

 

Figure 153 - Finished import external data dialog 

 
When importing hierarchical data, BowTieXP automatically recreates the multi-level structure based 
on the code field. When adding e.g. the following activities:  
 
A1, A2, A1.1, A1.2, A1.3 and A2.1 
 
BowTieXP will detect and create, based on the separator characters, the following structure: 
 

• A1 
o A1.1 
o A1.2 
o A1.3 

• A2 
o A2.1 

 
If you detect any errors you want to correct after importing, you can press the undo button to undo 
the entire import. 

1 2 . 3  I M P O R T I N G  D A T A  U S I N G  T H E  S C R A P  B O O K  

The Scrap book also offers many options for bringing information into your Case File, either from an 
Excel file or from other Case Files. The Scrap book is the ideal solution if you need to import parts of 
a Case File which you will use to build diagrams or add in the hierarchical information – you import 
all the elements and then quickly start building using drag and drop. 
 
For full details, please refer to chapter 18, Advanced functionality: the Scrap Book. 
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13  
GETTING DATA OUT OF BOWTIEXP 

In this chapter, we take a look at the myriad of methods to generate information for creating reports. 

1 3 . 1  I N T R O D U C T I O N  

Putting information into Case Files is useful, but it is even better to also have the opportunity to get 
all the information out of the Case Files in various perspectives and formats, in order to share them 
with your desired audience.  
 
In this chapter, the different methods for outputting information are discussed: 

• Which reports can be generated; 

• How to export information through Excel; 

• How to export information using the Clipboard function; 

• And how to print information from BowtieXP. 

1 3 . 2  R E P O R T I N G  

You can report information from a Case File in various ways using BowTieXP’s built-in reporting 
engine. Depending on the chosen report, the format will be either in Microsoft Word (rtf) or 
Microsoft Excel.  

 
1 3 . 2 . 1  G e n e r a t i n g  a  r e p o r t  
Follow these steps to generate a report: 
 

1. Select Tools → Reports from the drop-down menu or use the report button  from the 
toolbar. 

2. Click on the desired report.  

3. When you select and run a report, it is automatically opened in Word  or Excel . 
 
You can then save the report under a name and location of your choosing.  
 
Some reports are also available from the context within the bowtie file. These include a) the barrier 
overview report, which can be accessed by right clicking a barrier, b) the job title overview report 
through clicking on a job title and c) the document links overview through clicking on a document 
link (Figure 154 - Overview report from barrier). 
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Figure 154 - Overview report from barrier 

1 3 . 2 . 2  B o w T i e X P  r e p o r t s  
In this section, we present an overview of all the reports that are available to you. Depending on the 
report you choose, you may be asked to provide additional information before the report can be 
generated (such as which hazards/bowties or columns to use). 
 
Actions  

• Actions in XL 

• Actions in BowTie context 

• Actions in BowTie context, condensed version 

• Actions of a selection of Hazards 

• All Actions 

• Actions by Action party 

• Actions by Priority and Action party 

• Actions of a specific Action party 
 
Activities 

• (Advanced Only) Activities usage references by Hazard 

• List of Activities with Barrier context 

• Activities grouped by Activity Responsible 

• Activities grouped by Activities.Responsible of a single Hazard (Alt Format) 

• Activities grouped by Activities.Responsible of a single Hazard 

• Activities grouped by Hazard and Activities.Responsible (Alt Format) 

• Activities grouped by Hazard and Activities.Responsible 

• Activities by single Activity Responsible 

• All Activities 

• (Advanced Only) Activities linked to Barriers as hierarchical list 

• (Advanced Only) Activities linked to Barriers as hierarchical list - Filtered  

• Activities linked to Barriers ordered by Activity tree order. 

• (Advanced Only) Activities of a specific Operation grouped by Activity.Responsible (Short 
version) 

• (Advanced Only) Activities of a specific Operation grouped by Activity.Responsible (Long 
version) 

• Activities Responsible context overview 
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Audits 

• (AuditXP Only) Survey results shown on BowTie diagrams, using active filtering 

• (AuditXP only) Survey results in XL 

• (AuditXP Only) Survey results as follow up, quantitative version 

• (AuditXP Only) Questions linked to specific Hazards 

• (AuditXP Only) Question Overview 

• (AuditXP Only) Survey results shown on Barriers 

• (AuditXP Only) Survey results 

• (AuditXP Only) Individual Fill Outs 

• (AuditXP Only) Create empty Survey fill out form 

• (AuditXP Only) Fill Outs that apply to organizational units outside the bowtie group 
organizational unit context 

 
Barrier Types 

• Barrier Type count of a Bowtie Group 
 
Barriers 

• Barrier Organizational Unit Performance 

• Barrier overview report 

• Flat Barrier register with customizable columns 

• Barriers register with Activities 

• Barriers by Hazard summary sheets 

• Barrier register 

• Barrier Accountable context overview 

• Barrier Accountable context overview of a specific Hazard 
 
Competencies 

• (Advanced Only) Required Competencies for a specific Operation, grouped by 
Activity.Responsible 

Compliance Frameworks 

• (AuditXP Only) Compliance Frameworks 
 
Document Links 

• List of Document Links with Barrier context 
 
Escalation Factors 

• Escalation Factors sorted by Barrier Type 

• Escalation Factors with Barriers of type... 

• Escalation Factors without Barriers 
 
Hazards 

• Detailed Hazard report with optional report sections 

• Flat Hazard list with customizable columns 

• BowTie Chaining 

• BowTie Diagrams 

• Register 

• Report of all Hazards – Work sheet 

• Cut-out Diagrams 

• Register with Activities, Document Links and Systems 

• Traditional Hazard register 

• Report of a specific Hazard, long version 

• Report of all Hazards 
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• Short summary list of Hazards 
 
IADC HSE Case Guidelines 

• (Advanced Only) Hazard register complete 

• (Advanced Only) Hazard register without Activities 
 
Incident Diagram 

• (IncidentXP Only) Graphical timeline breakdown 

• (IncidentXP Only) Incident Timeline Event grid 

• (IncidentXP Only) Timeline Events 

• (IncidentXP Only) Report on all Incident Barriers 
 
Incident Diagrams Bfa 

• (IncidentXP BFA combined with BowtieXP Only) Barriers linked to Incidents 
 
Incident Diagrams BSCAT 

• (IncidentXP BSCAT combined with BowtieXP Only) Barriers linked to Incidents 
 
Incident Diagrams RCA 

• (IncidentXP RCA combined with BowtieXP Only) Barrier count per RCA Event Category 

• (IncidentXP RCA combined with BowtieXP Only) Barrier count per RCA Event kind 

• (IncidentXP RCA Only) RCA Event Category profile 
 
Incident Diagrams Tripod 

• (IncidentXP Tripod Beta combined with BowtieXP Only) Barriers linked to Incidents 

• (IncidentXP Tripod Beta Only) Tripod breakdown 

• (IncidentXP Tripod Beta Only) Tripod Overview 

• (IncidentXP Tripod Beta Only) BRF Code profile 
 
Incidents 

• (IncidentXP combined with BowtieXP Only) Incident Barrier State counts 
 
Job Titles 

• Job Title count per Hazard 

• Job Title Overview 
 
Lists 

• (IncidentXP RCA Only) RCA Event Categories 

• (IncidentXP BFA Only) BFA lists 

• (IncidentXP Tripod Beta Only) Tripod category lists 

• (IncidentXP BSCAT Only) BSCAT lists 

• (Advanced Only) BowTie register report for data export 

• Barriers 

• Document Links 

• Activities 

• Competencies 

• Job Titles 

• Systems 

• Threats and Consequences 
 
LOPA 

• (LOPA plugin Only) BowTie Method Overall 
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• (LOPA plugin Only) LOPA scenario overview and segments (BowTie method) per Hazard 

• (LOPA plugin Only) LOPA Classic Scenario Analysis 

• (LOPA plugin Only) LOPA classic summary with related open Actions 

• (LOPA plugin Only) LOPA Risk assessment summary sheet, opens in XL 
 
Operations 

• (Advanced Only) Operations overview 
 
Other 

• Lookup references 

• (Advanced Only) BowTie report from template 

• Color Legends 

• Report on Barrier BRF Codes 

• Contents of Case File overview 
 
Risk Assessment 

• Report Risk Assessment Matrix Definitions 

• Report Risk Assessment matrices (Top event) 

• Aggregated Top event Risk Assessments 

• Aggregated Risk Assessments 

• Aggregated Consequence Risk Assessments 

• Consequences ordered by Risk Assessment 

• Report Risk Assessment Matrices 
 
Systems 

• (Advanced Only) Systems linked to Barriers 

• Systems linked to Barriers Ordered by System lookup table order 

• List of systems with barrier context 

 
1 3 . 2 . 3  R e p o r t  f r o m  t e m p l a t e  
It is possible to define a company template report, complete with logos, fonts and other styling and 
fill that with information from a bowtie file, using tags that are inserted into the template. 
 
To create a custom template, follow these steps: 

• Open Word (for this example, we will use Word 2016). 

• Go to File > Options > Customize Ribbon. 
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• Make sure the “Developer” option is ticked in the Main Tabs section. 

 

Figure 155 - Microsoft Word - Customize Ribbon 

 

• Open the Developer tab. You can add fields with the “Aa” icon. The tooltip describes it as a 
“Plain Text Content Control”. 

 

 
 

Figure 156 - Microsoft Word - Plain Text Content Control 

 

• The field will look like this: 
 

 

Figure 157 - Microsoft Word - Plain Text Content Control (2) 

 

• To make sure the field is filled with the right data, select the field and click “Properties” in 
the ribbon.  
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Figure 158 - Microsoft Word – Content Control Properties 

 

• After naming the tag, you can insert one of the tags that are available (see Table below) in 
the Tag field. If you want to see these tags in the document, switch on the “Design Mode”.  
 
Available tags: 

1. BowTie.HazardRegister 
2. BowTie.BarrierRegister 
3. BowTie.AllDiagrams 
4. BowTie.Actions 
5. BowTie.JobTitles 
6. BowTie.Activities 
7. BowTie.DocumentLinks 
8. BowTie.Systems 
9. BowTie.ThreatsAndConsequences 
10. BowTie.ActivitySummaries 
11. BowTie.BarrierSummaries 

 
Add the tags to the Content Control Properties: 
 

 

Figure 159 - Microsoft Word – Content Control Properties (2) 

 

• Save your template and close Word. You cannot run the report while it is opened in Word. 

• In BowTieXP, go to Tools → Reports → Other → BowTie report from template. 
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Figure 160 - BowTie report from template 

 

• Choose the bowtie(s) you want to include in your report. After you have selected them, a 
dialog appears. 

 

 

Figure 161 - Selecting reporting template 

 

• Make sure “Use built-in template” is deselected and click “Browse” to select your template. 

• Click OK to run the report. 
 
You can edit and change the report, then update the tags by selecting the same word file again. All 
fields will then be updated, without changing any other information. 

1 3 . 3  E X P O R T  T O  E X C E L  B U T T O N  

In various places within the software, an Excel button is offered to export that particular information 
to excel. This is an overview of all possible options. 

 
1 3 . 3 . 1  E x p o r t i n g  t h e  T r e e  v i e w  
The Tree view can be exported listwise to Excel - by clicking the small Excel icon in the top right 
corner of the Tree view, all content is exported to Excel.  
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Figure 162 - Tree view export to Excel 

 
1 3 . 3 . 2  E x p o r t i n g  a  C a s e  F i l e  o v e r v i e w  
The Case File overview, discussed in section 9.2, Case overview, offers many views on the different 
relations throughout your data. These views can serve as material to base external reports on, by 
exporting its content to Excel. 
 
You can open the Case Overview by clicking on View → Windows → Case Overview. Select the 
Overview you want to see and export this one to Excel. 

 

 
 

Figure 163 - Caseoverview export to Excel 

 
1 3 . 3 . 3  E x p o r t i n g  a  q u a l i t y  c h e c k  l i s t  
Similar to the Case File overview, the quality checks (discussed in section 9.3, Quality checks) also 
offer various lists which can be exported to Excel and serve as a basis for reports. 
 
You can open Quality checks by clicking on View → Windows → Quality checks. Select the desired 
overview and export this to Excel. 
 

 

Figure 164 - Quality checks export to Excel 

 
1 3 . 3 . 4  E x p o r t i n g  t h e  l i s t v i e w  
T h e  l i s t v i e w  c a n  b e  u s e d  t o  e x p o r t  l i s t s  o f  v a r i a b l e s  t o  
E x c e l  a s  w e l l  –  f o r  e x a m p l e ,  t o  c r e a t e  a  l i s t  o f  a l l  j o b  
t i t l e s ,  y o u  c a n  s e l e c t  t h e  j o b  t i t l e s  c o n t a i n e r  i n  t h e  T r e e  
v i e w :  t h e  l i s t v i e w  w i l l  s h o w  a l l  t h e  j o b  t i t l e s  c o n t a i n e d  i n  
i t .  T h i s  l i s t  c a n  b e  e x p o r t e d  t o  E x c e l  b y  c l i c k i n g  t h e  E x c e l  
b u t t o n .  P l e a s e  r e f e r  t o  s e c t i o n  7 . 9 . 1 ,   
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Exporting to Excel for more details. 
 

 

Figure 165 - Listview export to Excel 

 
1 3 . 3 . 5  E x p o r t i n g  C a s e  F i l e  c o m p a r i s o n  
A Case File compare can be exported by using the export to Excel button in the center of the results 
window. Go to Files → Compare Case Files and run a comparison to find the button to export the 
compare results to Excel. Results can also be exported as a list format by going to the Script view tab 

and clicking the export button there and choose which export to run (as there are multiple 
options). 
 

 

Figure 166 - Compare Case Files export to Excel 

1 3 . 4  E X P O R T I N G  T H E  D I A G R A M S  

The main diagram as well as the relationship diagrams can be exported through various applications. 
There are three exports to choose from: 

• Save diagram as: this will export the diagram as a bitmap, such as .png or .jpg. (Diagram → 

Save Diagram As.. or use the  button) 

• Copy diagram to clipboard: this will copy the diagram to the clipboard as an .emf ( ) 

• Export to Visio: this will output the bowtie diagram as a .vsd Visio drawing  (Diagram → Export 
to Visio). Note that this export will only export the basic diagram picture and does not include 
any additional information such as reference data. Also, not every shape is supported. A valid 
Visio 2002 or higher is required to make use of this export functionality,since BowTieXP uses a 
Visio 2002 stencil to export the diagram towards. Make sure that your Microsoft Office Trust 
Center settings allow accepting and opening Visio 2002 stencil types. 

https://support.office.com/en-za/article/View-my-options-and-settings-in-the-Trust-Center-Privacy-Options-d672876e-20d3-4ad3-a178-343d044e05c8
https://support.office.com/en-za/article/View-my-options-and-settings-in-the-Trust-Center-Privacy-Options-d672876e-20d3-4ad3-a178-343d044e05c8
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Note that you can customize the view of the diagram for exporting by means of the selective visibility 
filter. See section 7.5.3, Selective visibility filter for details. 

 

1 3 . 5  E X P O R T I N G  T H E  C O L O R  L E G E N D  

If you are using colors on the diagram shapes, you can also copy the diagram color legend to the 
clipboard. Make sure you can see the legend by clicking on View → Windows → Color Legend and 

choose a variable to depict. Click on the copy to clipboard button  to export. 
 

 

Figure 167 – Exporting the color legend 

1 3 . 6  P R I N T I N G  

There are two main ways of printing a bowtie diagram using BowTieXP. In this chapter, we will 
discuss both methods, along with their respective advantages and disadvantages. 
 
The standard printing functionality for BowTieXP can be found in the File menu. It is sufficient to use 
for quickly printing a diagram. For more printing options, see Chapter 13.6.2,  
Printing with Copy to clipboard. Copy to clipboard has several advantages over the basic printing 
functionality. 

 
1 3 . 6 . 1  P r i n t i n g  f r o m  F i l e  m e n u  
To print a bowtie diagram, go to File → Print. The diagram you have currently selected will be 
printed. 
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Figure 168- Print in the File menu 

 
The print dialog is basic and should look familiar to other applications. It allows you to select a 
printer, the print range, the number of copies and printer specific properties before clicking OK to 
print. 

P r i n t  s e t u p  

There are several options in printing the diagrams in Print Setup. It is possible to shrink the diagrams 
to a single page, center the diagrams and set a zoom level. Go to File → Print Setup (Multipage 
On/Off…) to customize this. 

 

 

Figure 169 - Print setup 

P a g e  s e t u p  

It can be convenient to control the size and orientation of the paper to print on, so BowTieXP can 
optimize the size of the bowties. This can be controlled in the Page setup window (File → Page 
Setup). 

 

Figure 170 - Page setup 

P r i n t  p r e v i e w  

The print preview allows you to see what and how it will be printed. If the option ‘Shrink diagrams to 
fit on a single page’ in Print Setup (Multipage On/Off…) is not selected, you can click on 1, 2, 4, 6, 9 or 
12 to choose the number of pages to print your bowtie on.  
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Figure 171 - Print preview 

 
1 3 . 6 . 2  P r i n t i n g  w i t h  C o p y  t o  c l i p b o a r d  
You can find the Copy to clipboard button in the toolbar: 
 

 

Figure 172 - Copy to clipboard button in toolbar 

 
If higher quality export is required, it is possible to increase the resolution of the diagram that is 
copied to the clipboard. Go to Tools → Options → Reports. There is an option to increase the size of 
exported diagrams (see Figure 173 - Change size of diagram for copy to clipboard). The default value 
is 1, but it can be increased to a maximum of 4. 
 

 

Figure 173 - Change size of diagram for copy to clipboard 

 
Paste in PowerPoint, Word or any graphical program of your choice. 
 



 

©  W O L T E R S  K L U W E R  |  C G E  R i s k  2 0 2 0  
C O N F I D E N T I A L  A N D  P R O P R I E T A R Y  

 

B O W T I E X P  S O F T W A R E  
M A N U A L  

 

P A G E  1 3 7  

 

14  
WORKING WITH TEMPLATES 

BowTieXP contains a file template mechanism that allows you to distribute templates for new Case 

Files. This chapter explores this functionality. 

1 4 . 1  I N T R O D U C T I O N  

Every file you create using BowTieXP can be used as a template to create new files from. All that is 
needed is to place your template file in the right directory. The next time you want to create a new 
file, BowTieXP will ask you if you want to base it on any of the available templates. 
 

 

Figure 174 - Selecting a template 

 
In the example above, we see that we can create a new file either based on the built-in “NewCase” 
template or based on our own “Corporate Template” or “Training Template”. 

1 4 . 2  C R E A T I N G  A  T E M P L A T E  

In order to create a template, we first have to create a Case File containing all relevant information. 
The most important things are: 

• Lookup table values, notably the effectiveness values, barrier types 

• The activities hierarchy as defined within your organization, including other important related 
info such as job titles and activity categories 

• The (customized) risk matrices 

• Tree view filter profiles 

• Display profiles 

• Custom terminology 
 
If you plan to use Soob, you will want to set up the operations and related tables located under the 
“Operations and Risks” node. If you plan to use document links, setting those up in the right 
hierarchy is important. 
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Some organizations also work with reference bowties or have dedicated lists of hazards and top 
events. Such reference information is best put into a separate bowtie group, named e.g. “Reference 
Hazards”. 

1 4 . 3  I N S T A L L I N G  A  T E M P L A T E  

After creation of the file is complete, you will need to get it into the templates directory. The easiest 
way to do this is to select File → Save a Copy as Template. You can also place files in the template 
directory manually: Click the Help→Go to Templates directory to open the directory in Windows 
Explorer. 
 
Place your file in the templates directory and it will be available next time you create a new Case File. 

1 4 . 4  D E P L O Y I N G  T E M P L A T E S  A L O N G  W I T H  T H E  E X E  

You can also place the .btf files in a directory called ”Templates” located in the same folder as the 
executable. They will be automatically picked up and built-in templates will be hidden. 
 
This is handy for system administrators who want to deploy a template along with the software. 

1 4 . 5  D O W N L O A D I N G  T E M P L A T E S  F R O M  A  C E N T R A L  

L O C A T I O N / R E P O S I T O R Y  

Apart from manually placing files in the template directory, you can also configure BowTieXP to 
automatically download them from a central location and relocate them for you. 
 
BowTieXP can handle the following location types: 

• Normal file paths (drive letter, path and filename like Z:\path\to\file.btf) 

• UNC paths (network paths like \\servername\sharename\path\to\file.btf) 

• http or https URLs (www locations)  
 

Note: BowTieXP supports username and password embedded in the URL.  
Example: http://user:password@site.com/ 
Please be aware that these will be stored unencrypted on disk. 

 
Adding and modifying the entries is done by opening the template configuration by going to Tools → 
Options → Templates. Click on Configure automatic template downloading.. and choose the 
appropriate option such as add, edit, remove, etc. The interval between checking for updated 
templates is customizable. Granularity is in days. 

1 4 . 6  H I D I N G  B U I L T - I N  T E M P L A T E S  

Normally the built-in Case File is displayed too. Some companies may want to hide this to ensure the 
corporate template is used and the built-in template is not accidentally chosen. This can be 
accomplished by means of unchecking the “Use built in new Case Files templates too” checkmark 
under Tools → Options → Templates. 

1 4 . 7  F I L T E R I N G  O N  L A N G U A G E  

BowTieXP supports multiple languages and because of this, there’s a new Case File template built 
into BowTieXP for each supported language. Normally you will only see the one for the language that 
you are currently using. If you would like to see them all, you can uncheck the “Filter out known 
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languages” checkbox under Tools → Options → Templates. This will show all the available templates 
when you restart BowTieXP. 
 
This mechanism also works for your template files. If you want to work with templates in multiple 
languages, you can use this mechanism to do so. BowTieXP detects in which language a template file 
is supposed to emerge by means of the filename. If you format your filename correctly, BowTieXP 
will execute this accordingly. 
 
The format for the filename is: Filename.LanguageCode.btf 
 
The language code is separated from the filename by a period (‘.’). Language codes supported in 
BowTieXP at the current time are: 
 
 

Language Code Language 

De German 
En English 
Es Spanish 
es-MX Spanish (Mexico) 
Fr 
It-it 

French 
Italian 

Ja Japanese 
Ko Korean 
nb-NO Norwegian (Bokmal) 
Nl Dutch 
pt-BR Portuguese (Brazilian) 
Ro Romanian 
Ru Russian 
zh-CHS Chinese (simplified) 
  
  

 

 

Figure 175 - Localized templates 
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15  
OVERVIEW OF FIELDS AND PURPOSES 

This chapter highlights some of the commonly used data fields and their purposes. 

1 5 . 1  I N T R O D U C T I O N  

BowTieXP contains a large range of functionality and therefore has a large range of fields. Although 
most data fields can be renamed and customized to fit any need, the fields come with default names 
and are there with an intended purpose. In this chapter, some of the more commonly used fields are 
listed and their intended purpose is described. 
 

The grey background indicates that this field is mainly used or best used with BowTieServer. More information 
about those fields can therefore be found in the BowTieServer manual. 

1 5 . 2  F I E L D S  O N  B O W T I E  G R O U P S  

Name of field Intended purpose Examples and references 

BowTie Group Name Main information about the 
bowtie group. 

- 

Threat A.C. Define company criteria on 
how to correctly define a 
threat. If the element 
complies with the criteria, a 
box can be ticked. 

“A threat must not be a 
barrier failure. A Threat must 
lead directly to the Top 
Event.” 

Escalation Factor A.C. Define company criteria on 
how to correctly define 
escalation factors. If the 
element complies with the 
criteria, a box can be ticked. 

“Escalation factors must only 
be used to highlight 
exceptional circumstances.” 

Consequence A.C. Define company criteria on 
how to correctly define 
consequences. If the 
element complies with the 
criteria, a box can be ticked. 

“Consequences should be 
described as an occurrence 
rather than damage.” 

Barriers A.C. Define company criteria on 
how to correctly define 
barriers. If the element 
complies with the criteria, a 
box can be ticked. 

“A barrier should be 
individually capable to stop 
the incident.” 

Organizational Units Identify a site or department 
for which these bowties are 
relevant.  

Amsterdam, Paris, Drilling 
Rig A, Refinery, Maintenance 
Hangar 12 etc. Also, see 
Chapter 23.2. 
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User Data Define keys and specific 
values that are do not exist 
in the lookup table. 

- 

Attachments Used to upload files and 
pictures so they can be 
referred to in long 
description fields. 

For more information about 
attachments in description 
fields, please refer to the 
BowTieServer manual. 

1 5 . 3  F I E L D S  O N  H A Z A R D S  /  T O P - E V E N T S  

Name of field Intended purpose Examples and references 

General Main information about the hazard/top 
event. 

“Driving a car”, “Losing 
control over the car”, etc. 

Risk assessments Risk assessment for the hazard/top 
event. 

See chapter 7.12 Risk 
matrices. 

Sign off  
 
 
 

Workflow to indicate that a Build Phase 
has been completed and approved. 
 
 

Define Build Phases in 
Bowtie Lookup Tables 
 
 
 

Headers and 
Footers 

Display the header and footer when 
copying the diagram and paste it 
elsewhere. 

- 

Revision info Track how often the Bowtie has been 
updated plus room for notes and 
display the author of the bowtie. 

- 

Other Indicate for which modules and 
processes the Bowtie is used and to 
what global bowtie it is connected.  

- 

Lopa (LOPA plugin 
Only) 

Set the LOPA settings for the 
hazard/top event 

- 

Operations Indicate for which operations the 
Bowtie is relevant. Used in SOOB 
matrices functionality. 

See chapter 21 Advanced 
functionality: Soob matrices. 

Document links Link documentation to the hazard/top 
event. 

- 

User data Define keys and specific values that is 
not in the lookup table. 

- 

1 5 . 4  F I E L D S  O N  T H R E A T S  

Name of field Intended purpose Examples and references 
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General Main information about the threat. “Slippery road conditions”, 
Category: Environmental, 
etc. 

Lopa (LOPA plugin 
Only) 

Set the LOPA settings for the threat. - 

Operations Indicate for which operations this 
Threat can be expected. Used in SOOB 
matrices. 

See chapter 21 Advanced 
functionality: Soob matrices. 

   

Document links Link documentation to the threat. - 

User data Define keys and specific values that is 
not in the lookup table. 

- 

1 5 . 5  F I E L D S  O N  C O N S E Q U E N C E S  

Name of field Intended purpose Examples and references 

General Main information about the 
consequence. 

“Crash into water”, Medium 
concern, etc. 

Risk assessments Risk assessment for the hazard/top 
event. 

See chapter 7.12 Risk 
matrices. 

Lopa (LOPA plugin 
Only) 

Set the LOPA settings for the 
consequence. 

- 

Operations Indicate for which operations the 
consequence may be expected. Used in 
SOOB matrices. 

See chapter 21 Advanced 
functionality: Soob matrices 

Document links Link documentation to the 
consequence. 

- 

User data Define keys and specific values that is 
not in the lookup table. 

- 

1 5 . 6  F I E L D S  O N  B A R R I E R S  

Name of field Intended purpose Examples and references 

General Main information about the barrier. “Fire extinguisher”, 
Effectiveness: good, etc. 

Performance Used to set actual effectiveness values 
per organizational unit. 

London: very good, 
Amsterdam: good etc. 

Lopa (LOPA plugin 
Only) 

Set the PFD for the barrier. - 

Activities More specific detailed tasks that need 
to be executed in order for a barrier to 
be fully functional. 

Perform maintenance on 
valve, inspect valve, etc. 
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Systems Link systems to indicate that barrier is 
part of a collection or rely on certain 
systems. 

Fire suppression systems, 
evacuation plans, relies on 
electricity, relies on radio 
contact. 

Objectives Link objectives to indicate which 
barriers represent a part of a 
compliance framework. 

See Chapter 25 Compliance 
frameworks. 

User systems Link systems to indicate that barrier is 
part of a collection or rely on certain 
systems. 

See Chapter 22 Advanced 
functionality: 
Live on/offline system states. 

Questions Used for AuditXP. See Chapter 24 AuditXP add-
on. 

Wiki pages Link wiki pages to barriers. See Chapter 23.8 Wiki pages. 

Document links Link documentation to the barrier. - 

User data Define keys and specific values that is 
not in the lookup table. 

- 

Audit results View all results that are related to the 
questions linked to this specific barrier. 

- 

1 5 . 7  F I E L D S  O N  E S C A L A T I O N  F A C T O R S  

Name of field Intended purpose Examples and references 

General Main information about the 
Escalation Factor. 

“Forgetting to wear 
seatbelt”, category: human 
factor, etc. 

Document links Link documentation to the 
escalation factor. 

- 

User data Define keys and specific 
values that is not in the 
lookup table. 

- 
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16  
ADVANCED FUNCTIONALITY:  
VISUAL BARRIER GROUPING 

In this chapter, we will visually bundle together barriers that share a similar characteristic. 

1 6 . 1  I N T R O D U C T I O N  

When analyzing highly complex processes within an organization, the resulting bowties can become 
quite large and will have many different barriers on them. One way of keeping the overview is by 
using the Visual Barrier Grouping function, which visually bundles barriers together based on a 
common characteristic that those barriers have. This feature can be used to quickly get an overview 
of (amongst others) the distribution of barrier types and accountabilities throughout a bowtie. 

1 6 . 2  B U N D L I N G  C H A R A C T E R I S T I C S  

When clicking the grouping button on the toolbar ( ), you can select on which characteristic the 
barriers will be grouped. These characteristics can be assigned to barrier via the barrier editor. 
 

 
 

Figure 176 - Barriers bundled by the Barrier Type characteristic using the barrier families button. 

 
Most of these characteristics are the dropdown fields. However, the Family field is a free text field 
within the barrier editor that has been added for these bundling purposes. Barriers can be bundled 
by family name if those barriers share the exact same family name. 
 
You can enter the family name through the barrier editor. Double click on barrier top or use the 
pencil icon to open the barrier editor. Fill in the family name in the field highlighted in the picture 
below. 
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Figure 177 - Barrier editor family name 

 

 

Figure 178 - Family name bundling 

1 6 . 3  D I S P L A Y  O P T I O N S  O N  G R O U P S  

Once barriers are bundled, each individual bundle can be expanded by using the plus button that 
appears on top of the group when you hover over it. Collapsing them can be done via the minus 
button that appears when hovering over one of the expanded shapes. The small number next to the 
bundle shape represents the number of barriers contained in that bundle. 
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Figure 179 - Splitting out barrier bundles 

 
All bundles together can be expanded or collapsed using the buttons on the toolbar that appear as 
soon as a bundling characteristic is selected: 
 

 
 

Figure 180 - Expand and collapse all bundles 
 
A bundle shape does cannot contain any information on itself; it only displays the information of 
underlying shapes. For example, when displaying effectiveness values under a barrier bundle, the 
effectiveness’s of all the underlying barriers will be listed underneath. 
 

 

Figure 181 - Barrier bundle showing the effectiveness values of its barriers. 

 
Note: For consistency’s sake, barriers that are alone in a group will also be displayed as bundle with the name of 
the barriers’ characteristic. By pressing the plus symbol, its original name will be shown. 
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17  
ADVANCED FUNCTIONALITY: DIAGRAM 
DISPLAY PROFILES 

In this chapter, you’ll learn how to set up diagram display profiles to quickly switch between modes. 

1 7 . 1  I N T R O D U C T I O N  

As the number of configurable display options has grown very large over time and setting up the 
exact desired display over again  takes up quite some time, diagram display profiles were introduced. 
 
Each Case File can hold a list of diagram display profiles, enabling you to easily switch between them 
using the profile drop down box in the diagram toolbar: 
 

 

Figure 182 - The diagram display profiles drop-down box 

 
Note: it can be very handy to set up a profile per task – this allows you to progress with your work quickly. 

1 7 . 2  C R E A T I N G  A  P R O F I L E  

Due to the large number of settings, bundling these up into profiles saves a lot of time. To create a 
profile based on the current configuration, take the following steps: 

1. Press the profile button ( ) to bring up the profiles dialog box: 
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Figure 183 - Diagram display profiles window 

 
2. Right-click on Case File, select New and type in a name to add a profile that will be available 

for all bowties in that particular Case File. 
3. Double click the new profile that was added to the list. This will bring up the actual profile: 

 

  
 

Figure 184 – Edit display profile 

 
4. Press the “Load settings from current view” button to load the current configuration into the 

profile. 
5. You can further customize the profile or optionally add an advanced filter through the “…” button 

(Figure 184). To learn more about how the filters work, see chapter 7.5.3. 
6. Click OK to close the dialog. 
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The new profile is now available in the drop down to quickly switch to, and will be saved in your Case 
File. 
 
An additional feature is to create profiles that are only accessible within a specific bowtie group. To 
add these, instead of right clicking the Case File, right-click a bowtie group name to add a new 
profile. These profiles will only be available for the bowties within that group. To move profiles 
around, you can simply use drag and drop. 
 
It is also possible to select a profile that should be loaded automatically when the file is opened. This 
can be convenient to make sure people the data you want them to see. To select the profile that 
should be loaded on start-up, right-click a profile and select “Toggle Apply on load”. The second 
column will indicate with a small asterix sign which profile is currently set to auto-load. 

1 7 . 3  I M P O R T I N G  P R O F I L E S  F R O M  A  D I F F E R E N T  C A S E  F I L E  

Display profiles can also be imported from other Case Files using File → Import entities. 
 

 
 

Figure 185 - Importing diagram display profiles 
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18  
ADVANCED FUNCTIONALITY: THE SCRAP 
BOOK  

In this chapter, the different Scrap book functionalities will be explained  

1 8 . 1  I N T R O D U C T I O N  

BowtieXP Advanced also offers a functionality called the Scrap book. A dockable window that allows 
you to: 

• Copy entities there to keep them around for a while, and later drag them back into any Case 
File (might even be a different one). 

• Drop data files (Excel, BowTieXP) and read the info from them into BowTieXP. 
• Convert items from one type to another. 
• Items that cannot be given a place within the current Case File yet can be temporarily stored.  
• Store frequently used items - e.g. make a short list of frequently assigned activities. 

Items on the Scrap book such as Bowtie Groups, Hazards and Consequences can serve as templates. 
When you drag an item from the Scrap book onto a bowtie diagram, a copy is made which is placed 
in the Case File. Because the content of the Scrap book is independent from your Case Files, you can 
use it to build a library of often-used templates. You can also place reference information in the 
Scrap book, such as activities or document links. When you drag these items onto a shape in the 
diagram, you add a link to the corresponding reference item in the Case File. 
 

Note: Changes in the Scrap book do not support undo-redo.  

1 8 . 2  D I S P L A Y I N G  T H E  S C R A P  B O O K  

To view the Scrap book, select View → Windows →Scrap book (or ctrl + shift + s): 
 

 

Figure 186 - Displaying the Scrap book 
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The Scrap book will thereafter appear on the right-hand side of the screen: 
 

 

Figure 187 - The Scrap book 

1 8 . 3  B A S I C  S C R A P  B O O K  O P E R A T I O N S  

First, open the test Case File to have some data examples provided. Select File → Open Test Case 
File. Ensure you can see the barriers on the diagram (zoom level 3 or higher). 

 
1 8 . 3 . 1  D r a g g i n g  a  r e g u l a r  i t e m  o n t o  t h e  S c r a p  b o o k  
Select a barrier on the diagram by clicking it. Dragging is done as follows: press ALT on the keyboard, 
move the mouse over the item, press and hold down the mouse button, move the mouse until it is 
over the Scrap book. Now release the mouse button and the ALT button. As a result you have a copy 
of the barrier in the Scrap book. It is also possible to drag and drop from the Tree view to the scrap 
book. In that case holding ALT while dragging is not needed. 
 

 

Figure 188 - The Scrap book containing a single barrier 

 
We can now drag the barrier back into the Case File. For example, drag it back onto the diagram but 
drop it on top the first threat in the file labeled “Intoxicated driving”. The barrier is added to the 
threat. Note that you have to drop the item onto a ‘parent’ within the bowtie file to add it as a ‘child’ 
of that parent. 
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Figure 189 - Duplicated barrier 

 
You could say the Scrap book is similar to the clipboard, except it remembers also the additional 
reference data you copied onto it. In this example, the barrier has been copied in its entirety – all 
properties, children and attached links have been copied. We can see what extra information the 
barrier held on the Scrap book if we click the little plus sign next to it: 
 

 

 

Figure 190 - Barrier on the Scrap book showing children 

 
We see that an activity is linked to the barrier, as well as a document link. 
 

1 8 . 3 . 2  D r a g g i n g  a  r e f e r e n c e  i t e m  o n t o  t h e  S c r a p  b o o k  
We cannot only drag complete diagram elements onto the Scrap book, but also separate reference 
information (linkable items form the Tree view). 
 
For this example, first ensure to see the assigned activities on the diagram. Click on the small eye 
icon ( ) on a barrier and check the activities box for (S) Short description. Now we can see all the 
activities assigned to the barriers, alike the picture below: 
 

 

Figure 191 - Displaying barriers with activities (Short description) 

 
Open up the activities’ container in the Tree view and drag an activity onto the Scrap book. Now the 
Scrap book looks as follows: 
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Figure 192 - Scrap book with a reference item on it 

 
If we drag this item onto a barrier, we will assign the selected activity, just as if we dragged it from 
the Tree view, or used the activities’ assignment tab within the barrier editor. 
 

1 8 . 4  O R G A N I Z I N G  D A T A  I N  T H E  S C R A P  B O O K  

Data in the Scrap book can be reordered by dragging it around. You can drop an item onto another 
item so it becomes a child / sub item. 

You can also create groups to hold several items – press the new group toolbar button ( ) and 
enter a name. You can then drop items into it. Note that nested groups are not supported. 

 
1 8 . 4 . 1  I l l e g a l  c o m b i n a t i o n s  
When dragging items around you will see, the Scrap book does not limit what you can place 
underneath what – all kinds of illegal combinations are possible such as barriers under barriers. 
 
The Scrap book will let you know if a combination is illegal by means of overlaying a red exclamation 
point on the offending item, and a yellow exclamation point for all the higher levels – so at the top 
level you can also see something is not in order: 
 

 

Figure 193 - Scrap book with illegal combination 

 
If an item is in error, you cannot drop it anywhere. You must resolve the error first, by either 
removing or converting the offending item. 

1 8 . 5  C O N V E R T I N G  I T E M S  

Let us say we have made the following illegal combination: 
 



 

©  W O L T E R S  K L U W E R  |  C G E  R i s k  2 0 2 0  
C O N F I D E N T I A L  A N D  P R O P R I E T A R Y  

 

B O W T I E X P  S O F T W A R E  
M A N U A L  

 

P A G E  1 5 4  

 

 

Figure 194 - Scrap book with illegal combination 

 
The software provides you with a logical structure hint at the bottom of the Scrap book screen. We 
can resolve this error by means of conversion –right click an item to bring up the conversion menu 
and pick an option: 
 

 

Figure 195 - Scrap book hint and convert menu 

 
During conversion, all matching properties are kept and assigned, and everything else is placed in 
user data – nothing is lost. If we want to see all fields available, and whether they have been 
matched successfully, we can right click an item and choose view fields. All the matched items are 
depicted in bold; the rest will be placed in user data. 
 

 

Figure 196 - Scrap book view fields per item 

1 8 . 6  S C R A P  B O O K  F I L E  M A N A G E M E N T  

When you exit BowTieXP, the contents of the Scrap book are saved and will be available the next 
time you start BowTieXP. However, not all Scrap books are equally valuable – for instance if you are 
building a library of elements, you probably want to make backups regularly.  
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You can save contents of the Scrap book using the save ( ) button and load them using the open 

button ( ). You can also load files by dragging them onto the Scrap book. 

1 8 . 7  U S I N G  T H E  S C R A P  B O O K  T O  I M P O R T  D A T A  

You cannot only open bts (BowTieXP Scrap Book) files, you can also get items from Excel files. They 
must have the following format: 

• The first row contains the column headings 

• Each row after that represents an item to import 

• The first column must be the item type and its heading must be “Entity” 
 
Here is an example: 

 

 

Figure 197 - Sample Excel sheet for importing into the Scrap book 

 
The first row (row 1) contains the column headings / property names. The first column is called 
“Entity” and describes the type of each row.  
 
The second and third column describe any hierarchical relationships. Any entity with an Id can be 
referenced as a ‘parent’ by another entity in the ParentId column. For instance, a hazard with an Id of 
H1 can be referenced by a threat by putting H1 in the ParentId column of the threat. This means that 
the threat belongs to that hazard. The same can be done with barriers that belong to a threat. 
 
The other columns are the fields/properties we want to fill. If a column is not applicable for a certain 
type just leave it empty – for example, there is no field called “Top Event” on barriers so we leave it 
empty. 
 
Lookups such as effectiveness are resolved in the current Case File. Therefore, here is what happens 
after we drop it onto the Scrap book: 
 

 

 

Figure 198 - Scrap book after Excel import 

 
Looks like we forgot to set the entity for the fifth row – we can fix this easily, just right click the item 
and convert it to the correct entity. BowtieXP offers an alphabetic drop down list of all possible 
options. 
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Figure 199 - Converting items in Scrap book 

 
You can drag the items onto a diagram (make sure to use the ALT-key) to verify if all columns have 
been imported successfully. 
 
The Scrap book enables easy graphically oriented import of various data – it is for example a good 
method to import data from LOPA analyses and reconstruct that information onto bowties. 

1 8 . 8  D R O P P I N G  A  B O W T I E X P  C A S E  F I L E  ( . B T F )  O N T O  T H E  

S C R A P  B O O K  

To facilitate library building, you can also drop an entire BowTieXP Case File onto the Scrap book. 
When you do so you will be asked how you want the file to be handled, maintaining its hierarchical 
structure or group the file by item type: 
 

 

 

Figure 200 - Scrap book btf file handling question 

 
Depending on your choice, respectively the result will look either like the left or the right picture 
shown below: 
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Figure 201 - Scrap book after hierarchical vs grouped import 

1 8 . 9  E X P O R T I N G  T H E  S C R A P  B O O K  T O  E X C E L  

The Scrap book can be exported to Excel. This can be useful for various purposes, for example, if you 
want to adjust or modify multiple items simultaneously. 
 
To do this, make sure you have placed all relevant items in the Scrap book. Select the export to Excel 
icon . If you do not have the export to Excel button on your toolbar, it might need to be added via 

the ‘add or remove buttons’ icon in the Scrap book window (see Figure 202). 
 
After making certain adjustments in Excel, you can import the data back into the Scrap book by using 

the import/open file icon again . 

 

Figure 202 - Add or remove Scrap book buttons 

 

1 8 . 1 0   T O O L B A R  B U T T O N  R E F E R E N C E  

Icon Description 

 
Open a Scrap book file, Excel file, CSV file or BowTieXP Case File  

 
Save the current Scrap book contents as .btf file 

 
Export the entities in Scrap book to Excel 

 
Show last entity creation errors 

 
Toggle auto-creation of lookups (e.g. effectiveness) 
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Toggle auto-creation of linkable items (e.g. activities) 

 
Add a new group folder 

 
Add a new item 

 
Expand all 

 
Collapse all 

 
Expand to show illegal items 

 
Enter a text to expand by text 

 
Execute expand by text 

 
Delete selected item 

 
Clear all items 

 
Reload from disk 

1 8 . 1 1   I C O N  R E F E R E N C E  

Overlay Title Meaning Drag and drop behavior  

 

Red 
exclamation 

Item is not allowed in its 
current location or it is a 
linkable item that conflicts 
with another item on that 
level. 

Drag and drop is only allowed 
within the Scrap book pane 
internally or externally with the 
right mouse button (single item 
drag). 

 

Yellow 
exclamation 

Item contains one or more 
items that are invalid, in 
conflict or are non-matched 
links. 

Drag and drop is only allowed 
within the Scrap book pane 
internally or externally with the 
right mouse button (single item 
drag). 

 

Link sign Item represents a valid link 
to a linkable item within the 
current Case File. 

Drag and drop works as expected.  

https://svn.governors.local/trac/BowTieXP/attachment/wiki/BowTieScrapBookControl/wiki_linksymbol.png


 

©  W O L T E R S  K L U W E R  |  C G E  R i s k  2 0 2 0  
C O N F I D E N T I A L  A N D  P R O P R I E T A R Y  

 

B O W T I E X P  S O F T W A R E  
M A N U A L  

 

P A G E  1 5 9  

 

19  
ADVANCED FUNCTIONALITY: 
COMPARING FILES AND PARTS OF FILES 

In this chapter, we take a detailed look at the comparison functionality. 

1 9 . 1  I N T R O D U C T I O N  

BowtieXP Advanced allows you to compare parts of Case Files or entire Case Files and analyze the 
differences between them. This very powerful tool is often used in change tracking and compliance 
checking.  
 
For example, some companies have centrally defined how reference information in Case Files should 
look, and keep template files containing this information. Using the file comparison function, it is 
trivially easy to figure out if a Case File complies with the template. The same applies to reference 
bowties. 
 

Note: Please refer to Chapter 23.6 - Global – local linking in BowTieXP for an alternative way to compare bowties 
and keep corporate oversight. 

 
Change tracking is done in a similar fashion. If your company has a document management system, 
and the Case Files are checked in on a regular interval, you can easily track the development of the 
Case Files by means of the Case File compare. 

1 9 . 2  S T A R T I N G  A  C O M P A R I S O N  

There are two different methods of comparing data. The first method is comparing using the context 
menu, which means you can compare bowties within one Case File. The other method is comparing 
using the file menu. This allows you to compare data between two different bowtie Case Files. 

 
1 9 . 2 . 1  C o m p a r i n g  u s i n g  t h e  c o n t e x t  m e n u  
The first method of comparing is by selecting parts of the currently open Case File for comparison by 
right clicking in the Tree view. This allows you to only compare data from the current Case File. 
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Figure 203 - Marking part of a tree for comparison 

 
After selecting a branch for comparison, if we right click another place in the tree and a 
comparison makes sense (is possible), you have the option of comparing it: 
 

 

 

Figure 204 - Comparing parts of a tree 

 
After clicking, the comparison results are shown: 
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Figure 205 - Comparison results 

 
More on interpreting these comparison results will follow in the next sections. 

 
1 9 . 2 . 2  C o m p a r i n g  f r o m  t h e  f i l e  m e n u  
The second method of comparing is by means of the File → Compare Case Files menu entry.  This 
allows you to compare data in different Case Files. This menu option will bring up the comparison 
wizard. 
 

 
 

Figure 206 - Comparing Case Files menu option 
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It is not necessary to have a specific Case File already open – the comparison allows you to choose 
two files that are not your current Case File. Additionally, you can also compare different parts of the 
current file against that of other files. 
 

 
 

Figure 207 - Choosing what to compare 

 
The Tree view on the left lists all the bowtie groups and hazards in the currently open Case File. You 
can add files to this tree by one of the two browse buttons. The first button browses your computer 
and network; the second button allows you to browse SharePoint sites. 
 
After you have loaded the files you want to compare, you have the choice of either comparing the 
entire files, or just two bowtie groups or hazards. Select the first item to compare and click the upper 
“->” arrow button. It will be listed on the right in the box titled 'Compare…'. Select the item to 
compare it with and click the lower “->” arrow button. It will be listed on the right in the box titled 
'With'.  
 
In the example below, we are comparing two revisions of the same Case Files (stored locally): 
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Figure 208 - Two entire files marked for comparison 

 
Note the following:  

• "Current (open) case file" is selected in the tree and listed on the right. 

• "Road safety only.btf" is selected and listed on the right as well. 
The Compare button is enabled, signaling we can start the comparison. 

1 9 . 3  A N A L Y Z I N G  T H E  C O M P A R I S O N  

Here are the results of comparing the forenamed examples. 
 

 

 

Figure 209- File compare results 
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Items that differ between the two files are color-coded. You can switch the compared information 
from left to right by using the two-sided arrow button in the top middle of the comparison screen (

). 
 
In the example of the figure above, some elements have been changed (of which we can see three 
out of four pictures) and the barrier ‘ABS’ has been removed on the local Norwegian bowtie group.  
 
We can also report all the changes in a textual format - see the second tab page called 'Script view'.  
 

 

 

Figure 210 - Compare Case Files Script view 
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20  
ADVANCED FUNCTIONALITY: TYPE AND 
PROPERTY DESCRIPTIONS 

In this chapter, type and property descriptions are discussed: how to customize your Case File 

terminology. 

2 0 . 1  I N T R O D U C T I O N  

Each Case File contains a large table with names of all object types and their properties present 
within BowTieXP. This feature allows customers to make slight adjustments to various names and 
tailor-fit the software to their company. 
 
For example: In a bowtie diagram, you have barriers in place to prevent threats from causing the top 
event to occur. In some companies and industries, barriers are referred to as controls instead.  
 
Another example is that controls have a property, called a responsible person. This determines which 
person is responsible for managing the barrier’s functioning. However, in some industries or 
companies, the term responsible might not cover its exact legal meaning, and the property might be 
rather renamed to accountable.  
 

Note & Warning: Because editing these descriptions can lead to unwanted consequences due to the semantics of 
the terms that BowTieXP assumes, it is advisable to discuss your intended changes with CGE Risk – in this way, you 
can be sure that your changes will not have undesired impacts. 

2 0 . 2  U S E  I N  T R A N S L A T E D  C A S E  F I L E S  

It is also possible to have this customized terminology translated in a different language than the 
English default. If you create a new Case File in BowTieXP in a different language than English, the 
customized terminology will be offered in that language. If, for example, you run BowTieXP in 
Brazilian Portuguese, terms such as Barrier/Control and Top Event will be in Brazilian Portuguese 
(“Controle” and “Evento Principal” respectively). 
 
When you open this Brazilian Portuguese Case File in BowTieXP using the English user interface, 
translated terminology will still be Brazilian Portuguese. The content of the Case File will also be 
unaffected, regardless of the user interface language you choose. 

2 0 . 3  M O D I F Y I N G  T Y P E  A N D  P R O P E R T Y  D E S C R I P T I O N S  

For the most prominent terminology used in BowtieXP, a few common variants are used by the 
majority of companies. We have adopted these as presets, which can be found under Case > Apply 
Terminology. They can be translated via Case > Apply Translated Terminology. 
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Figure 211 - Presets for commonly used terminology and translating them 

 
Full control over all terminology is given through the property descriptions screen, go to Case → Edit 
Property Descriptions…. With this menu, you can rename any terminology in the software to your 
own fit.  The full editor can be found under Case → Edit Property Descriptions…: 
 

 

 

Figure 212 - The case menu 

 
This takes you to the following screen: 
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Figure 213 - Property descriptions screen 

 
In this screen, you can change all descriptions, plural descriptions, abbreviations. The first column 
cannot be changed since this is what BowtieXP is programmed with. 
 

Note: Changing linked values, e.g. Effectiveness, need to be changed under its own Object/Property, but also under 
the elements it is linked with (e.g. barriers). Use the + buttons to see what values are specifically linked to an 
object/property. 

 
 
The text used to denote when no value has been assigned can also be changed using Case → Edit 
Null Value Descriptions. This provides you with the following dialog box, in which you can determine 
what code and text to use to represent empty value fields: 
 

 

 

Figure 214 - The null value descriptions screen 
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21  
ADVANCED FUNCTIONALITY: SOOB 
MATRICES 

This chapter describes how to get up and running with Summary of operation boundaries matrices. 

2 1 . 1  I N T R O D U C T I O N  

This chapter is to help you get started with the Summary of operation boundaries (Soob) 
functionality in BowtieXP Advanced. BowtieXP Advanced is designed to make it easy to quickly set up 
a Summary of operation boundaries matrix and to manage large Soob matrices. 

2 1 . 2  W H A T  A R E  S O O B  M A T R I C E S ?  

The Summary of operation boundaries is a record of operations used to determine under which 
circumstances extra caution should be taken or work should no longer be allowed to proceed.  
 
This is to support the decision process of whether to proceed with operations when encountering 
suboptimal conditions. Suboptimal conditions can be many things, such as: 

• Doing several operations at the same time; 

• Some critical barriers are unavailable due to maintenance or disruption; 

• Barriers have compromised effectiveness; 

• Critical equipment is unavailable; 

• Weather conditions are becoming more extreme and closer to tolerable limits. 
 
When working close to tolerable limits, due to insights into the extra risk exposure, decisions can be 
made to supplement the operation with extra barriers or perhaps stop the operations all together. 
 
The Soob consists of three parts, which examine different aspects of operations: 

1. Operations versus Operations. This part of the Soob tells us which combinations of operations 
are within tolerability limits or technical limitations, and whether and how they can be 
combined. 

2. Operations versus Barriers under reduced effectiveness. This examines which operations are 
either allowed or aren’t when certain barriers have been defeated or function under reduced 
effectiveness. 

3. Operations versus Operational Risk Factors. Here we examine if operations are safe to proceed 
under different circumstances that influence the risk of doing these operations, such as 
weather conditions, missing out on critical equipment, etc. 

 
The Summary of operation boundaries (Soob) is very similar to the Manual of Permitted Operations 
(MOPO). MOPOs can easily be made using the Soob functionality in BowTieXP. You will find that the 
thinking behind Soob is much more dynamic then the static concept of a manual. 
 
The entire Soob can be divided across a number of different matrices, although they can also be 
listed wthin a single matrix. Because of this we refer to a Soob matrix in this manual and not to the 
whole Soob, which would be all these matrices combined. 
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Let us clarify the various parts of a Soob matrix with some examples.  
 

2 1 . 2 . 1  O p e r a t i o n s  v e r s u s  o p e r a t i o n s  
In this section we will examine which combinations of operations are within tolerability limits or 
technical limitations, and whether and how they can be combined. 
 
As a sample, marine operations on board a drilling rig are considered. Please note this description 
was not written by a drilling expert and should serve only as an example for explaining the different 
Soob matrix concepts. 
 

Operation Description 

Anchoring The anchoring of the rig is the operation where the rig’s 

anchors are dropped to maintain the rig’s position for a longer 

period of time. This is done by bringing the anchors out using 

e.g. a support vessel and dropping them a certain distance 

from the rig. After dropping the anchors, the anchor lines are 

tightened to fix the rig’s position. 

Ballasting (Change 

Draft) 

Changing the draft of the platform by taking on ballast. 

Bulk Transfer The transfer of bulk products such as drilling mud and cement 

onto the rig from a support vessel. 

Towing Changing the location of the rig by means of towing it with 

tugboats. 

Below is an example of the Operations versus Operations part of the sample Soob matrix we are 
examining. 
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SM1 Soob Matrix     

Operations     

   Op. Anchoring  ATP ATP ATP 

   Op. Ballasting (Draft Change) ATP  ATP ATP 

   Op. Bulk Transfer ATP ATP  DNP 

   Op. Towing ATP ATP DNP  
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The names and colors are explained in the table below. 
 

Name Color 

Do Not Proceed Red 
Proceed with Caution Yellow or Orange 
Authorized to Proceed Green 

 
We see that combining Bulk Transfer with Towing is not allowed, indicated by the red color and the 
code DNP (Do Not Proceed): Moving the rig whilst at the same time having a support vessel 
maintaining the same relative position to the rig is very dangerous and should not be attempted. We 
can also see that all other combinations of operations are authorized to proceed. 

 
2 1 . 2 . 2  O p e r a t i o n s  v e r s u s  b a r r i e r s  u n d e r  r e d u c e d  
e f f e c t i v e n e s s  
 
This part of the Soob matrix examines which operations are either allowed or aren’t when certain 
barriers have been defeated or function under reduced effectiveness. 
 
Below you see an example of this part of the matrix. In this sample, the hazards of having liquefied 
gas in a storage vessel near a road is considered, creating the possibility of an impact with a moving 
vehicle. 
 
For the operations we use the abstract operations A through D to demonstrate the possibilities of 
the Soob. 
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SM1 Soob Matrix 1     

Barriers Under Reduced Effectiveness     

     Loc. Hazardous Site     

          Haz. 5.4.4.6 Liquefied Gas in Storage Vessels in Production  

          Facility / Catastrophic failure of storage vessel 
    

               Tht. Vehicle Impact     

              Ctl. Protection provided around vessels against vehicle impact               

                   (bollards and kerbing) 
PWC NA ATP ATP 

                    Ctl. Vessels are double skinned providing resistance  

                    to impact 
NA NA NA NA 

                    Ctl. Vessel bases set in concrete annulus and bolted  

                    to concrete area 
NA NA NA NA 

                    Ctl. Examination carried out in accordance with Written  

                    Scheme of Examination 
NA NA NA NA 

 
Operations A through D have all been deemed relevant to the Threat of Vehicle Impact in the bowtie 
for the catastrophic failure of a storage vessel containing liquefied gas. We see that most barriers are 
not relevant – they have been classified as NA / Not Applicable.  
 



 

©  W O L T E R S  K L U W E R  |  C G E  R i s k  2 0 2 0  
C O N F I D E N T I A L  A N D  P R O P R I E T A R Y  

 

B O W T I E X P  S O F T W A R E  
M A N U A L  

 

P A G E  1 7 1  

 

We also see that if the barrier called “Protection provided around vessels against vehicle impact 
(bollards and kerbing)” is not functioning or is missing, operation B, C and D can continue, but for 
different reasons: Operation B can continue because the barrier is deemed Not Applicable for this 
operation. Operation C and D can continue because missing this barrier is applicable, but not 
essential for the safety of these operations, so we are authorized to proceed. 
 
Contrary to the other operations, we see that operation A can Proceed with Caution, in the situation 
where the road barriers are either missing, damaged or otherwise not up to par. For this operation, 
not having this barrier fully functioning apparently adds extra risk, but not so much to stop the 
operation altogether. 

 
2 1 . 2 . 3  O p e r a t i o n s  v e r s u s  o p e r a t i o n a l  r i s k  f a c t o r s  
 
For the last section of the Soob matrix, we return to our drilling rig example. We have defined several 
operational risk factors having to do with environmental conditions, such as visibility and sea state. 
On the horizontal axis, we again have our marine operations. 
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SM1 Soob Matrix 1     

Operational Risk Factors     

   Oof.: ENV Environment Conditions     

         Orf. Night Time ATP ATP PWC ATP 

         Orf. Poor Visibility (Fog) DNP ATP DNP PWC 

         Orf. Sea Sate > 8 ft PWC ATP PWC ATP 

         Orf. Strong Current > 3 kts ATP ATP ATP ATP 

         Orf. Wind Speed > 30 kts DNP ATP DNP PWC 

 
We see that anchoring, ballasting and towing can continue at night, but bulk transfer should Proceed 
with Caution.  
 
When visibility is poor, we should stop anchoring operations and bulk transfer. Towing should 
Proceed with Caution and ballasting can continue unhindered. In fact, ballasting is not affected by 
any of these conditions. Notice as well that strong currents have no effect on these operations. 

2 1 . 3  O V E R V I E W  O F  S E T T I N G  U P  A  S O O B  M A T R I X  

To set up your Soob matrix, work through the following steps: 
 
1. Creating Operations, this consists of the following steps: 

1. Defining Operation Categories (optional) 
2. Defining Operation Types (optional) 
3. Defining Operations 
4. Linking Operations to Hazards, Threats and Consequences (optional) 

 
2. Creating and Linking Operational Risk Factors (optional) 
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3. Creating Soob matrices, which consists of the following steps: 

1. Defining Soob categories 
2. Creating Soob matrices 
3. Linking operations to Soob matrices 

 
4. Populating / filling in the Soob matrices. 
 
All of these aspects can be found under the Operations and Risks node in the Tree view. 
 

 

 

Figure 215 - Tree view showing operations and risks node 

2 1 . 4  C R E A T I N G  O P E R A T I O N S  

The first step in creating a Soob matrix is defining which operations can be part of the Soob matrix. In 
order to do so, we first need to define the reference information we might be using on the 
operations themselves. Thereafter we can define the operations. It is of course possible to modify all 
the reference information at any time. 

 
2 1 . 4 . 1  D e f i n i n g  o p e r a t i o n  t y p e s  ( o p t i o n a l )  
Operation types can be used to categorize your operations. When you add or edit an operation, you 
can set to which operation type the operation belongs. Assigning operation types to operations is an 
optional step. 
 
Some operation types that we can derive from our example are: 

▪ Drilling 
▪ Marine 
▪ General 
▪ Administration 
▪ Lifting 

 
You can add operation types by right-clicking the Operation Types container underneath the 
Operations and Risks node in the Tree view. Choose New operation type. A screen alike the figure 
below appears. Fill in the code, name, description and a color if needed and click on OK. 
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Figure 216 - Adding operation types 

 

2 1 . 4 . 2  D e f i n i n g  o p e r a t i o n  c a t e g o r i e s  ( o p t i o n a l )  
 
Operations cannot only have been assigned a type; it is also possible to assign a category. These can 
be created in the Operation Category container and works exactly the same as creating Operation 
Types. The previous section explains how to add an Operation Category or Type. 

 
2 1 . 4 . 3  D e f i n i n g  o p e r a t i o n s  
 
Before being able to create a Soob matrix, we need to define what operations will be part of our 
Soob matrix.  Operations are defined centrally in the Operations container in the Tree view, and can 
be assigned to multiple matrices. 
 
Defining operations is done by adding them to the Operations container in the Tree view. It is located 
beneath the Operations and Risks node as well. 

 
Figure 217 - The add operation dialog box 

 
The operations are initially organized in the order in which you add them, but you can reorder them 
if you needed by right clicking the container and selecting ‘Change Order…’ from the menu. 
 
Operations can be defined hierarchical. This allows you to link only the top-level operation, through 
which all sub-operations will be available automatically. Note that only the sub-operations can be 
filled in. 

 
2 1 . 4 . 4  L i n k i n g  o p e r a t i o n s  t o  h a z a r d s ,  t h r e a t s  a n d  
c o n s e q u e n c e s  ( o p t i o n a l )  
 
If we want to examine the impact of missing or ineffective barriers for our operations, we will need 
to associate hazards, threats and consequences with those operations. By creating a link between an 
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operation and a hazard and top event, we are indicating that the operation is potentially exposed to 
that specific hazard and subject to one or more consequences of a top event.  
 
Link operations to entire bowties by linking them at the hazard level, or link an operation to only a 
part of a bowtie by linking them at the threat and/or consequence level. Only the relevant parts of 
the bowtie will be visible and editable in our Soob matrix. 
 
This linking is done is the same manner as all linking in BowTieXP. Go to the hazard, threat or 
consequence editor, and find the operations tab, in which you drag the operations to the right 
column.  

 
Figure 218 - Assigning oprations to threats/consequence/hazard 

 
You can also link operations using drag and drop from the Tree view immediately; simply drag the 
operation from the Tree view onto the hazard, threat or consequence in the diagram and drop the 
value. 

2 1 . 5  C R E A T I N G  A N D  L I N K I N G  O P E R A T I O N A L  R I S K  F A C T O R S  

( O P T I O N A L )  

If you want to analyze what kind of impact other operational risk factors have on your operations, 
you should define those factors. Operational Risk Factors are created by adding them into the 
Operational Risk Factors container in the Tree view, beneath the Operations and Risks node. Right-
click on Operational Risk Factor and choose New Operational Risk Factor. A dialogue like the figure 
below will appear. Fill in the details and click on OK. 
 

 

 

Figure 219 - Creating Operational Risk Factors 
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Note that operational risk factors can be nested so you can create groups. Some common values 
include: 

 
Figure 220 - Example operational risk factors 

 
After creating the operational risk factors we want to include in our Soob matrix, we need to 
associate them to their relevant operations. This is done similar to all linking within BowTieXP. The 
easiest way is to go to the operation in the Tree view, open up an editor screen, go to the 
Operational Risk Factors tab, and drag and drop the relevan Operation Risk Factors.  
 
The operational risk factors are often used for listing HSE-critical equipment. If it is used for HSE-
critical equipment, the criticality of the equipment can be categorized by populating the criticalities 
under the lookup tables in the Tree view. When adding new HSE-critical equipment as Operational 
Risk Factors, you can assign the criticality rating in the editor. 
 
An example of an equipment criticality rating scale: 
 

▪ SCE - Safety Critical Equipment/System 
▪ HEE - HSE Essential Equipment/System 
▪ OEE - Operations Essential Equipment/System 
▪ NEE - Non-Essential Equipment/System 

2 1 . 6  D E F I N I N G  S O O B  C A T E G O R I E S  

The Soob categories are the values that can be used in your Soob matrices, that indicate whether you 
can perform certain operations simultaneously or not. They can be customized in the Tree view 
under Case → Operations and Risks → Soob Categories. A Soob category consists of a code, a 
description and a color. 
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Figure 221 - The add Soob category dialog box 

 
Often a categorization similar to this example is used: 
 

Code Name Color 

DNP Do Not Proceed Red 
PWC Proceed with Caution Yellow or Orange 
ATP Authorized to Proceed Green 
NA Not Applicable White or Gray 

 
What is also commonly seen is that several ‘Proceed with Caution’ categories are defined, for 
instance: 
 

Code Name Color 

PWC1 Proceed with Caution #1 (clarification #1) Yellow 
PWC2 Proceed with Caution #2 (clarification #2) Yellow 
PWC3 Proceed with Caution #3 (clarification #3) Yellow 

 
In this latter case, each PWC category has specific notes on how to proceed. 
 
It can certainly be done this way, but it is not necessary to add clarifications to the ‘Proceed With 
Caution’ category in this manner: each cell within the matrix can have its own comments, 
instructions and document links with more detailed information. However, if you have many cells in 
which you want to place the same comments, adding a specific Soob category might be efficient. 

2 1 . 7  C R E A T I N G  S O O B  M A T R I C E S  

After defining the Soob categories, you are ready to create a Soob matrix. You can do so by adding a 
Soob matrix to the Soob matrices container in the Tree view.  
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Figure 222 - The add Soob matrix dialog box 

 
The code and name fields are mandatory, and you should think about which of the tree different 
types of Soob data you want to enter into this matrix: 

• Operations versus Operations 

• Operations versus Barriers Under Reduced Effectiveness 

• Operations versus Operational Risk Factors 
 
After clicking OK, the Soob matrix editor is opened, displaying an empty matrix: There are no 
operations assigned to the matrix yet. 
 

 
Figure 223 - Soob matrix editor with empty matrix 

2 1 . 8  L I N K I N G  O P E R A T I O N S  T O  S O O B  M A T R I C E S  

Assigning operations to the matrix is done by expanding the matrix in the Tree view, and right 
clicking the operations container. Select “Assign linked Operations” from the context menu. 
 

 
Figure 224 - Selecting to assign links 

 
After assigning operations to the Soob matrix, we get a logical matrix as a result: 
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Figure 225 - Soob matrix showing operations versus operations 

 
Filling in the Soob matrix is explained in the next section. Note that the order in which the operations 
appear is determined by the order in which the operations have been defined in the Tree view. 
When changing the order in the Tree view, the matrix will update to reflect your changes. 

 

Figure 226 - Order of operations 

2 1 . 9  P O P U L A T I N G  A  S O O B  M A T R I X  

After opening the Soob matrix, we can populate the matrix with the values (Soob categories) that we 
have set up. As mentioned before, the Soob matrix consists of three parts. Let us quickly review: 
 

▪ Operations versus operations. This part of the Soob matrix allows you to define whether 
operations can run simultaneously. 

▪ Operations versus barriers under reduced effectiveness. In this part of the matrix, you can 
define whether certain barriers are critical to an operation and must be available and fully 
functional before the operation can begin. 

▪ Operations versus operational risk factors. The operational risk factors part of the matrix is a 
part of the matrix that you can configure yourself with any risk factor that you find to be of 
crucial influence on your operations. Operational risk factors are used for e.g. weather 
restrictions and conditions and/or critical equipment. 

 
First, we will show how to proceed with the operations versus operations part of the matrix and 
show you how to edit the Soob matrix. The other sections of the matrix are edited in a similar 
manner, all of which will be discussed below. 
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2 1 . 9 . 1  B a s i c  S o o b  m a t r i x  e d i t i n g  
First, we need to select the cell of the combination of operations we are to consider. Let us start by 
considering operation A and operation C by clicking on that cell, as seen in the screenshot below. 
 

 
Figure 227 - Soob matrix with selected empty cell 

 
A drop-down arrow will appear in the right-hand side of the cell. If we click this arrow, we get a drop-
down menu, where we can select the appropriate Soob category. This is the reason to define those 
beforehand. 
 

 
Figure 228 - Choosing a Soob category for a cell 

 
After selecting the appropriate value, it is applied to both cells that refer to the combination of 
operation A and operation C. The chosen category is displayed by means of its code and color. 
 

Note: The combination of an operation with itself is not possible – it makes no sense and therefore the cells on the 
diagonal cannot be selected.  
 
If you need to define whether the same operation can be combined with itself, the operation is probably not 
specified in enough detail. For example, crane-lifting operations could be split out into crane lifting operations for 
crane A and for crane B, and their combined operation can then be specified. 

 

 
Figure 229 - Soob category has been applied 

 
Notice that after applying a Soob category to the cell, the editor still allows us to add a description. 
For instance, when a cell describes that combining operations A and B should ‘proceed with caution’, 
you probably want to add additional information about how exactly to proceed. 
 

Note: When a combination of operations has a Soob category assigned to it, we also refer to this combination of 
operations as a “Soob value”, a filled space in the matrix. 
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After completely filling in the matrix, it may look like this: 
 

 
Figure 230 - Filled Soob matrix 

 

2 1 . 9 . 2  E d i t i n g  t h e  o p e r a t i o n s  v e r s u s  b a r r i e r s  u n d e r  
r e d u c e d  e f f e c t i v e n e s s  s e c t i o n  
If you have linked an operation to a hazard/top event and enabled the operations versus barriers 
section in your Soob matrix, you will see that this section of the Soob matrix is now expanded with 
the hazard/top event and all the threats, consequences, escalation factors and barriers below them. 
 
If a cell is grayed out, that means that the barrier in question is part of a hazard/top event that is 
linked to at least one operation but not to the operation for which the cell is grayed out. 
 

 
Figure 231 - Enabled and disabled cells 

 
In the screenshot above we see that:   

• Operations B and C are linked at the threat level – all cells are enabled for one threat. 

• Operation A is probably linked to the entire hazard. 

• Operation D is not linked to this hazard or any of its threats. 
 
Tip: There could be some or even many barriers in your risk model that may not be critical or even 
relevant for an operation. Using a Soob category called ‘Not Applicable’ (or any similar value) helps 
you to identify those barriers as ‘Not Applicable’ to this operation. It is important to think it through 
though, because your operation is or could be exposed to the hazard and subject to one or more 
consequences of a top event. Using a Soob category called ‘Not Directly Applicable’ might be a good 
way to deal with those barriers that the operation indirectly relies on for the prevention of a release 
of the hazard, but that are not considered a direct part of the operational activities. 
 
If you unlink operations from hazard/top events, the structure of your Soob matrices will be 
automatically updated to reflect this change. Any values that you have assigned to cells (operations 
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vs. barrier) that are no longer linked are then lost. If a barrier is part of a bowtie of a hazard/top 
event that has been unlinked, those values are lost because they were a part of that link. 
 
BowTieXP will not provide you with a warning when you unlink operations. It does however allow 

you to recover from your mistake by undoing your change with the Undo button ( ). This will also 
recover all linked information that you lost by unlinking. 

 
2 1 . 9 . 3  E d i t i n g  t h e  o p e r a t i o n s  v e r s u s  o p e r a t i o n a l  r i s k  
f a c t o r s  s e c t i o n  
The operations versus operational risk factors section is edited in the same manner as the previous 
two sections. 

 
2 1 . 9 . 4  E x p o r t i n g  t o  M i c r o s o f t  E x c e l  
Although it is recommended to provide Soob matrices in BowTieXP format the matrix can also be 

exported to Microsoft Excel. Press the Export to Excel button ( ) to do so. 
 
It is recommended to provide matrices to consumers because BowTieXP has special features for 
navigating and searching through the matrices, and is capable of referencing all linked information 
easily. The matrices are less accessible from Excel. Remember that the navigator version of BowTieXP 
also supports all features for navigating the matrices. 
 
 
Microsoft Excel provides you with many formatting options, if you want to know more please contact 
support@cgerisk.com and we will provide you with some useful Microsoft Excel formatting tips. 
 

2 1 . 9 . 5  R e l a t i o n s h i p  m o d e l s  o f  o p e r a t i o n s  
Another useful feature of Soob in BowTieXP is that once the matrix has been populated with values, 
you can right-click on an operation in the Tree view and select to see its relationship diagram as 
shown in the screenshot below: 
 

 

Figure 232 - Relationship model menu 

 
You will see a mind map showing the Soob relationship that has been defined between this operation 
and the other operations. 
 

mailto:support@cgerisk.com
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Figure 233 - Example Soob relationship diagram 

Note: For more details on relationship models, see chapter 9.5, Advanced functionality: relationship models. 

 

2 1 . 9 . 6  S o o b  m a t r i x  e d i t o r  t o o l b a r  r e f e r e n c e  

This section explains all icon functionalities. If you miss any of the icons in the tool bar, use  to find 
the icon. 
 

 

 

Figure 234 - Expand / collapse toolbar 

Icon Description 

Keywords Enter the keywords to expand by here 

 
Execute expand by keyword operation by means of the keywords entered 
into the text box 

 Go to previous keyword match 

 Go to next keyword match 

 
Expand All  

 
Collapse All 

 
Go to definition in the Tree view 

 

 
Figure 235 - General toolbar 

 
 

Icon Description 

 
Reset/reload 

 
Export to Excel 

 
 

 
Figure 236 - Column filter and fill/paint toolbar 
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Icon Description 

 
Select either the column to display or the named selection of 
columns to display here: 
 
With the column filter, you can show only one operation vertically to 
allow you to focus on that one operation versus the other 
operations. By selecting <no filter>, you can show all operations on 
the columns again. 
 
You can also create sets of operations to work with. They are called 
Soob filtered views and are defined in the Tree view underneath the 
matrix. 

 
Copies one column to another. 

 
Replace one Soob category with another/fill. 

 
Select the Soob category to paint with here to enable this feature. 
After selecting a category, each cell you click will be assigned the 
selected Soob category. 

 
 
 

Icon Description 

 Enable the display of the row of the currently selected/hovered cell. 

 Enable the display of the column of the currently selected/hovered cell. 

 
Enable hot tracking: when this option is enabled, the row and column 
display will show the values for the cell currently under the mouse pointer. 
When it is disabled, they will display the information for the currently 
selected cell. 

 
Enable tooltips showing extra information for the cell under the mouse. 
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22  
ADVANCED FUNCTIONALITY: 
LIVE ON/OFFLINE SYSTEM STATES 

This chapter describes how to automatically determine whether a hardware barrier is on- or offline 

based on the barriers’ individual parts 

2 2 . 1  I N T R O D U C T I O N  

Many barriers found on modern industrial installations have hardware components in them. These 
hardware parts are often managed by maintenance management systems, which keep track of the 
states of these parts. If parts are taken out of commission or isolated for the time being, their status 
can go from ‘online’ to ‘offline’. If some parts are considered offline or the status is unknown, this 
can have an impact on the availability of a barrier function of which they are a part. 
 
With the live on/offline system states functionality, the effects of individual parts going on- or offline 
can be shown on the bowtie. For example, when a part’s status is updated to an offline status, a 
barrier can automatically turn red depending on a configurable logic model. If these parts states are 
updated regularly, the bowtie can show near real-time current state of the barriers. 

2 2 . 2  O V E R V I E W  O F  T H E  M O D E L  

In order to automatically determine whether a barrier should be considered online or offline, a 
decision tree can be constructed using a hierarchy of systems relying on a list of parts. 
 
In  
Figure 237 on the far right we see the individual parts. Parts are the lowest level of hardware 
components on which the organization can retrieve an online/offline/unknown state. They are 
defined in the parts table and have a code, name and on/offline or unknown status. They do not 
contain any decision logic. 
 

 

 

Figure 237 - Example model of parts, systems and barriers 
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Parts can be linked directly to systems and sub-systems. It is on the level of the systems where the 
decision logic is defined. On- or offline criteria can be defined with simple rules such as: 

• If more than x Equip. tags are online: online 

• If less than x Equip. tags are online: offline 

• If a percentage if online: online 
Using this logic, a hierarchy of systems can be created to determine the on/offline status of the main 
system, or barrier. 
 
See for example,  
Figure 237.The online criteria for System 1.2 (Gas detection type B) may be defined so that only one 
part may be offline at any time. In the figure, we see however that two of its parts are considered 
offline or unknown; therefore, the whole system is now considered offline. Furthermore, the online 
criteria for System 1 (Detection system) may prescribe that at least one of the subsequent systems 
should be operational. We can see that although system 1.2 is offline, system 1.1 is still online which 
is enough to consider system 1 online. 
 
The following sections will describe how to set up the entire system. 

2 2 . 3  C R E A T E  A  S Y S T E M  G R O U P  

In the Tree view you find the node System groups. Add a new system group by right clicking on 
systems group and fill in the code, name and description. It automatically creates two sub tabs; one 
for parts and one for systems.  

2 2 . 4  A D D I N G  S Y S T E M  P A R T S  

You can add parts by right clicking on the parts container and click on New part. The editor like the 
figure below will appear. You can fill in a code, name and select what its online status is. 
 

 
Figure 238 - Parts editor 

 
Note: Creating parts manually will take a lot of work. It is much more efficient to use the Scrap book to import a list 
of parts that you might already have created in Microsoft Excel. Please refer to Chapter 18 Advanced functionality: 
the Scrap Book. 

2 2 . 5  A D D I N G  A  H I E R A R C H Y  O F  S Y S T E M S  A N D  L I N K I N G  

T H E I R  P A R T S  

Once you have created a list of parts, you can add a hierarchical structure of systems. Right click on 
systems to add a new system. You can make a sub system by adding a system to the system that you 
have just created. The figure below shows a hierarchical structure and how to add a new sub-system. 
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Figure 239 - Creating a hierarchy of systems 

 
To link parts to systems, double click a system and go to the “parts” tab. The parts in the left column 
are all parts defined in the software, but that are not yet linked to the system. To link parts, you first 
need to select the parts you want to link. Use the arrows in the middle of the diagram or drag the 
parts from the left column to the right column. All parts in the right column are linked to this specific 
system. 
 
One part can be linked to multiple systems, allowing for re-use and maximum flexibility in the online 
calculations. 

 
Figure 240 - Linking parts to systems 

2 2 . 6  D E F I N I N G  O N L I N E  S T A T U S  C R I T E R I A  F O R  S Y S T E M S  

After double clicking a system, you can go to the “online criteria” tab to define the on/offline criteria 
for the system based on the direct ‘child’ elements (i.e. parts and/or systems) linked beneath the 
system. The configuration is done as follows: 
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Figure 241 - Define on / offline criteria 

 
On each system, there are two potential rules that can be enabled: 

• A minimum availability rule – at least N parts or subsystems must be online for the system to 
be online 

• A maximum unavailability rule – no more than N parts or subsystems may be offline if this 
system is to be considered online. 

 
Both rules can be configured in absolute numbers or in percentages. To toggle to percentages, use 
the tick box on the right of the numerical selector. Both rules can be active at the same time. You will 
get a choice whether the two criteria are both to be met or only one is to be met (AND/OR logic). If 
no rules are active, the part will be in the offline status by default. 
 
These rules will run from leaves to root in the systems hierarchy, calculating the status of each 
element by means of the part online/offline status. The online status for the following systems 
hierarchy can be made visible if we select the system group in the Tree view and look below that 
screen in the listview: 

 
Figure 242 - Systems status from Tree view depicted in listview 
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The listview (View → Windows → Listview) is useful to view the status of the system you selected in 
the Tree view. In the right-hand column, we see the status of the system itself. Green means the 
system is fully online, red means it is considered offline and amber means that the system has met 
the online criteria, but not all sub-systems are online. The notation behind the on/offline indicator 
shows how many of its directly linked systems and/or parts are online (left), offline (middle), or 
unknown (right). 
 
In the quality checks (View → Windows → Quality checks) (see section 7.15, Quality checks window), 
you can do several checks based on the online criteria. These checks are: 

• Systems that do not have any online criteria set 

• Systems with offline, unknown or amber status 

• Systems with online criteria set 

2 2 . 7  L I N K I N G  S Y S T E M S  T O  B A R R I E R S  

When a hierarchy of systems has been defined, the systems can be linked to barriers in the same way 
as any other link collection in the software. Make sure all online criteria are set for all (sub-)systems, 
to see the online status of the barrier. 
 
Linking a system to a barrier can be done in the systems editor or barrier editor. The figure below 
shows how to do this form the system editor. Go to the tab: ‘Assigned to Barriers’. Use the arrow or 
drag and drop the appropriate barrier from the left box to the right box. 

 
Figure 243 - Linking systems to barriers 

2 2 . 8  D I S P L A Y I N G  O N L I N E / O F F L I N E  S T A T U S  O N  T H E  

D I A G R A M  

All this results in a visualization beneath each barrier, showing the actual barrier status as well as the 
make-up – how many associated systems are online or offline. This display is configured via the 

display options by clicking the small eye icon ( ) in the bottom right-hand corner of the barrier: 
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Figure 244 - Set online status info via the barrier's 'eye' icon menu 

 

 

Figure 245 - Visualization of system status on barriers 

 
Only one system is linked on the barrier, in this case the automatic deluge system. The barrier is 
online, as that system has 2 sub-systems online, 0 unknown, and 0 offline. This can be deduced from 
the (2/0/0) context under the system display. The order is (Online/Unknown/Offline). 

2 2 . 9  U P D A T I N G  P A R T S ’  S T A T E S  

In order to do bulk updates of the parts’ status, you can use the functionality: Update existing data 
from external file (File → Update existing data from external file). 
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Figure 246 - Updating existing data from external file 

 

 
Figure 247 - Update existing data 

 
It shows the screen like the figure above. In the first section, you need to add the external data 
(Microsoft Excel) file you want to update and choose the correct sheet. The second section asks you 
if you want to update by ID values or Code values. 

- ID values are created by BowTieXP for each element. 
- Code values are created by the users when you fill in the code of the part. 

 
The imported Excel file could look like the figure below (This file is retrieved from Scrap book (View 
→ Windows → Scrap book)): 
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Figure 248 - Import Excel file for updating 

 

2 2 . 1 0   D I S P L A Y I N G  O N L I N E  S T A T E S  I N  T H E  C A S E  O V E R V I E W  

For an overview other than the bowtie’s graphical representation, a list-wise representation can be 
provided via the Case Overview. The states are part of the ‘Systems-User Systems’ overview (for 
details on the Case Overview, see section 9.2). 
 

 
Figure 249 - Case Overview for Systems that shows online/offline states 

 
The Case Overview can be used to drill down and analyze why systems are considered online/offline. 
The Case Overview is interactive, so it is possible to directly edit the barriers, systems and parts from 
this structure if required. In addition to its calculated online state, it also shows at what date/time 
the status has been updated and what the criteria are per system/barrier. 

2 2 . 1 1   D I S P L A Y  O N L I N E  S T A T U S  I N  R E L A T I O N S H I P  D I A G R A M  

For more complex barriers, the subsequent hierarchy of systems and parts can become very 
complex. To facilitate the analysis of why a barrier is considered online or offline, it is possible to 
draw a relationship tree that shows all sub systems and their children plus it highlights whether they 
are red, green or amber. The online status relationship tree can be displayed on any level within the 
hierarchy as long as a system has child elements. 
 
You can show the relationship diagram by right clicking on the system on a barrier or from the 
system in the Tree view. Choose Draw relationship diagram → ‘Online status overview’ as in the 
figure below. 
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Figure 250 - Online status overview for a barrier and a system 

 
The diagram that is produced will take the following form: 
 

 
Figure 251 - System relationship diagram 

 
Interacting with the model is possible by using the right click menu. The diagram can be copied using 

the copy-to-clipboard functionality in the top left corner ( ). The Filter button ( ) allows the 
relationship model to show the offline and their connected shapes. 
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23  
BOWTIESERVER ORIENTED FEATURES 

This chapter lists some of the features in BowTieXP that work best in combination with 

BowTieServer. 

2 3 . 1  I N T R O D U C T I O N  

Some features in BowTieXP are especially powerful when used in combination with BowTieServer. 
Some can also be used when using BowTieXP stand-alone but may not always be practical. 
 

This chapter will only briefly describe the features, but for a more detailed description, please refer to the 
BowTieServer manual. 

2 3 . 2  O R G A N I Z A T I O N A L  U N I T S  

Most large international organizations have operations on multiple sites, spread out over the globe. 
All of these sites may want to make bowties or in some cases even share bowties if they are dealing 
with similar risks. To keep track of which data is relevant for which location, organizational units can 
be created and assigned to various forms of data. 
 
In BowTieXP, these organizational structures are often tied to a geographical location, although it is 
also possible to define departments that are more abstract. The organizational units can be defined 
in the Tree view under the bowtie lookup tables similar to any other taxonomy. They are hierarchical 
in nature, so the following structures could be possible: 
 
North Sea 

• Drilling platform A 
o Drilling floor 
o Crew Quarters 
o Helideck 

• Drilling platform B 
o Drilling floor 
o Crew Quarters 
o Helideck 

 
Various features in BowTieXP and BowTieServer make use of the organizational units: 

• Barrier performance: Define the actual effectiveness of a barrier per organizational unit 

• Organizations can have in addition to a geographical location also a more detailed Plot plan 

• Link organizational units to bowtie groups to track which bowties are relevant for them 

• Link organizational units to Incidents to track which are relevant for them 

• Use them as filtering parameters in the AuditXP’s audit filter and IncidentXP’s incident filter 

• Use them as filtering parameters in various BowTieServer overviews 

 
2 3 . 2 . 1  O r g a n i z a t i o n a l  u n i t s  g r o u p i n g  
Users can group by organizational units in the Tree view by right-clicking and selecting ‘Group bowtie 
groups by…’.  
 



 

©  W O L T E R S  K L U W E R  |  C G E  R i s k  2 0 2 0  
C O N F I D E N T I A L  A N D  P R O P R I E T A R Y  

 

B O W T I E X P  S O F T W A R E  
M A N U A L  

 

P A G E  1 9 4  

 

 

Figure 252 - Grouping bowtie groups by organizational unit 

 
Pressing OK gives you the below view. The bowtie group ‘Maritime’ contains 3 bowties. Those 
bowties will be displayed for each organizational unit they apply to. Note that this does not mean 
that the bowtie gets duplicated, there are still only 3 maritime bowties. The bowtie MA-H.01 
Container on ship / Container falls from ship for the organizational unit Aberdeen is the same bowtie 
as the one for Auckland. The view simply gets duplicated, so it is easier for you to go down the list of 
bowties per organizational unit.  
 

 

Figure 253 Grouping on organizational unit 

 
To check how many links to an organizational unit a bowtie has you can right-click on the hazard and 
select ‘Go to definition’.  
 
It is also possible to group on hazards, please see section 7.11.1 Tree view filters, grouping by hazard.  

2 3 . 3  P L O T  P L A N S  

Because industrial installations can be quite large, merely a geographical location is not always 
practical. To get a higher level of detail, the image of a plot plan can be uploaded to achieve a higher 
level of detail. Even though the functionality is called “plot plans”, it can also be used to upload 
another picture such as an aerial photograph or any other schematic representation of the site. 
 
Another use of plot plans is to have a stable mapping for locations that themselves are mobile. For 
example, a maritime vessel may not always be in the same geographical location, but its plot plan will 
be the same no matter which geographical location. 
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Plot plans can be added in the Tree view, under bowtie Lookup tables. They are then used by various 
features: 

• Incident reporting: Pinpoint the location where the incident occurred. 

• Link organizational units to specific points on a plot plan 

2 3 . 4  C H A N G E  H I S T O R Y  L O G S  

When a user has permission to view change histories, a clock symbol will appear on all bowtie 
elements. Pressing this button will show the change log for that element, listing all changes that have 
been made in the past to this element. The same log is also accessible in the web UI of BowTieServer. 

2 3 . 5  B A R R I E R  P E R F O R M A N C E  D A T A  

In organizations that have operations in multiple locations, it is possible that they are dealing with 

similar risks regardless of the geographical location. It could therefore be possible that these 

locations share a bowtie on the same risk or require having the same barriers in place. However, 

even though the barriers must be the same, the effectiveness of the barriers may vary per location. 

To assess the actual effectiveness of the barriers per organizational unit, the barrier performance 

feature can be used. 

In this tab in the barrier editor, the effectiveness of the barrier can be determined for every 

organizational unit that has been linked to the bowtie group in which the bowtie diagram resides. 

The barrier performance per organizational unit can be displayed into the bowtie diagram, like in  

Figure 254. This can be done by checking the ‘Performances’ box in the display option (small or big 

eye icon). In addition, the diagram can be filtered down to only show barriers with performance 

values, by selecting the Performance Filter. 

 

 
Figure 254 Barrier performance per organizational 

 
When applying the performance filter, it is also possible to select the ‘organizational units’ 
dropdown. This dropdown allows you to modify the filter on performances per organizational unit.  
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Figure 255 - Organizational unit dropdown 

 
The dropdown uses color to highlight which organizational units are connected to the currently 
selected bowtie, as defined in the bowtie group to which that bowtie belongs.  
 

White background color: The currently selected bowtie does not have any organizational units 

connected to the bowtie, toggling these items therefore has no impact on the display of the bowtie.  

Dark green background color: These organizational units are linked to the currently selected bowtie. 

Toggling these will for instance reduce the number of performance items under a barrier (see  

Figure 256 - Performance on barrier).  

Light green background color:  This color shows that this colored organizational unit has a link to one 

of the organizational units below it. In  

Figure 256 - Performance on barrier’ this is the organizational unit ‘Europe’.  

 

 
Figure 256 - Performance on barrier 

 
In the example shown above, the barrier ‘Tyre pressure alarm’ has one performance item defined as 
‘Good (+)’ and 2 undefined effectiveness values (<NULL>), in this case for the organizational unit The 
Netherlands and its sublevels: Rotterdam and Amsterdam.  
 
It is possible to change what is being displayed by un-toggling either The Netherlands, Rotterdam or 
Amsterdam, or all of them. Clicking The Netherlands once, will instantly deselect both the parent as 
well as its children. The barrier will not show any performance data anymore (despite it’s ‘on’ status 
in the small eye icon).  
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Figure 257 – (Un)Toggling performance data on barrier 
 
 
Deselecting Rotterdam will automatically deselect The Netherlands and only show the barrier’s 
performance value for Amsterdam. Note that the icon of the ‘parent’ organizational unit (The 
Netherlands in this example) becomes black to indicate items related to it are not displayed on the 
diagram anymore, despite its link. 
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Figure 258 – (Un)Toggling performance data on barrier 

 
To select just The Netherlands (or both Amsterdam or Rotterdam), users have to hold the “Ctrl” 
button on their keyboard and then select the organizational unit. The barrier’s performance value 
will show only The Netherlands.  

 
 

Figure 259 – (Un)Toggling performance data on barrier 

2 3 . 6  G L O B A L  –  L O C A L  L I N K I N G  I N  B O W T I E X P  

Similar to the barrier performance feature, global - local linking can also be utilized to demonstrate 
local performance on a global level. 
 
A set of (local) bowties can be linked to a parent (often on global level) bowtie, after which all linked 
element values will be aggregated and displayed on the global bowtie. This will allow for 
autonomous management of local bowties while at the same time the global bowties can be utilized 
to compare all local values. This feature can be used and applied in the standalone version of 
BowTieXP as well as in combination with BowTieServer. The initial concept of global local was 
designed and created with the idea that it will be used with BowTieServer. 
 
Both BowTieServer and BowTieXP will allow the user to make a copy of an already existing bowtie 
and use it as a local version. As the local bowtie will be automatically linked to the global bowtie, this 
will save a significant amount of time. BowTieServer related functionality of this global-local feature 
can be found in the BowTieServer software manual. 
 

Both barrier performance and global local linking can be used to visualize local performance on a global level. 
Choosing between both features depends on the needs of the organization. If local performance is only used to 
differentiate performance (effectiveness) on local level, the barrier performance feature can be sufficient. 
Assurance of the performance can be done by using AuditXP. Bear in mind that the same bowtie will be used as the 
basis for all organizational units. 
 
If the local bowties are used for more autonomous way of managing locations, for instance if every organization 
unit manages their own version of the bowtie, then global – local feature might be a better fit. All local reference 
and meta data can be shown on the linked global bowtie. Often in these situations the performance assurance is 
already covered on local level and effectiveness of barriers is determined on local level as well. This effectiveness 
value will also be displayed on the global bowtie. 
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2 3 . 6 . 1  L i n k i n g  e l e m e n t s  b e t w e e n  g l o b a l  a n d  l o c a l  
b o w t i e s  
Regardless whether a global copy from BowTieServer/BowTieXP is used as the starting point of the 
local bowtie or the local bowtie is designed and linked from scratch, BowTieXP can be used to 
identify the link between elements. Links between elements can be established on following element 
types: 

• Barrier 

• Hazard / Top event 
 
To create a link between a global and local element, a full repository check-out should be performed. 
This will prevent multi-level linking between elements and will also prevent circular linking between 
diagrams. After the full repository has been checked out a new local bowtie diagram can be created, 
or an already existing local bowtie can be edited. 
 
In order to create or edit this link between diagram elements, the local element should be opened 
for editing in BowTieXP. After this either the Hazard / Top Event combination can be linked to its 
global equivalent, this can be performed from the “other” tab within the editing popup. 
 

 
Figure 260 - Linking a new, local hazard 

 
The barrier element can be linked to its global equivalent, this can be achieved from the general tab 
within the editing screen. Bear in mind that a global – local link between a hazard / top event should 
be established first. Based on this information BowTieXP will display a hierarchy of possibly linkable 
elements. To select the relevant element, the highlighted icon should be clicked. The search box 
above the list view can also be used to quickly locate the desired element. 
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Figure 261 - Selecting the related global barrier 

 
If a local copy was created in order to use this as a local variant before the database has been 
checked out, the links are already present and can be edited. This is applicable to both the hazard / 
top event as well as the barriers. On hazard level (both global and local) an icon will indicate that 
these are used either as global or as local hazard / top event. 
 

 
Figure 262 - Existing link between global local hazard / top event combinations (left) or barriers 

(right) 
 

Using display settings, certain local information can be displayed on the global bowtie diagram. (e.g. Showing 
effectiveness as extra info underneath a global barrier will also display local values of the linked barriers.) 

 
If a local copy needs to be created after the database has been checked out, this can be performed 
within BowTieXP. To do so, after checking out, in the tree view, right click on the hazard which will 
serve as the global bowtie and choose “Add local implementation Hazard”. After this, a pop-up will 
show allowing for selection of information which needs to be copied to the local version of the 
bowtie. Confirming this process by clicking on “OK” will lead to a new bowtie diagram being created. 
As the full bowtie is copied, all elements in the local diagram are also linked to their counterparts in 
the global diagram. This diagram will have a “LOCAL” prefix and will be placed in the same bowtie 
group as the parent. The local copy can now be moved to the correct location. 
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Figure 263 - Creating a local copy of a global bowtie 

2 3 . 7  M A R K D O W N  F O R M A T T I N G  

Long description fields support a simple markdown formatting. This means that with simple code, the 
text in description boxes can be formatted and clarified with headers, bold text, italics, simple tables, 
hyperlinks and even images. 
 
For example, typing a word between “/” symbols will make the word appear in the BowTieServer 
web UI appear in italics. To create a header, the “#” symbol with a space can be placed before a line 
of text. It will then be interpreted as a level 1 header. 
 
While working in the description boxes in BowTieXP, you will only see the code form of the 
formatting. Currently, the only way to see the formatted version of the code is to run the Barrier 
Overview report, which can be found in the right-click menu on barriers. 

2 3 . 8  W I K I  P A G E S  

There may be a lot of documentation available that is related to BowTie elements, in particular to 
barriers. Documents such as procedures, more elaborate descriptions and explanations, legal / audit 
standards could be relevant to consult. With the wiki pages, this information can be stored in wiki 
form and uploaded onto BowTieServer. The information can then be chunked into sections, chapters, 
paragraphs etc. and these can then be linked to individual barriers. This way, very specific parts of 
information can be linked to individual barriers. Therefore, when information is required, the right 
bit of information is easily accessible, and it is no longer necessary to leave through a large 
document. 
 
The wiki pages support the before mentioned markdown formatting, so can include images, tables 
and other forms of simple formatting. 

2 3 . 9  A C T I O N S  A N D  T O - D O  I T E M S  

The sticky notes in BowTieXP are called Actions when BowTieXP is used as a standalone. However, 
with the introduction of BowTieServer the differences between Actions from BowTieXP and Actions 
from BowTieServer becomes difficult to differentiate. Therefore, Actions in BowTieXP are called ‘To-
do items’ and ‘Actions’ from BowTieServer remain Actions. This can be changed at all times in the 
BowTieServer ‘Language’ section under Admin.  
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24  
AUDITXP ADD-ON 

2 4 . 1  W H A T  I S  T H E  A U D I T X P  A D D - O N ?  

AuditXP is an add-on for the BowTieXP software package. It is used to generate barrier related audit 
questionnaires or surveys. The add-on allows you to easily generate questions concerning barriers 
and management systems. These single questions can then be compiled into surveys (a selection of 
questions), which can be exported to Excel as a fill-out form. After importing the audit findings, the 
results can be visualized in the bowtie diagrams. 
 

 

Figure 264 - PDCA cycle 

 
Auditing is a valuable way of gaining insight into barrier quality/effectiveness, to get early warnings 
before incidents occur. With the audit add-on, we provide a tool to close the Deming circle (PDCA 
cycle). After defining the barriers in your safety management system (i.e. the plan stage) and 
implementing them (i.e. the do stage), a check is required to ensure the quality of the barriers. 
Relying on barriers that are in reality inadequate can be dangerous. In addition, a thorough 
examination of the barriers during the check stage facilitates the generation of relevant 
recommendations later on (i.e. act stage). 

2 4 . 2  T H R E E  A D V A N T A G E S  O F  T H E  A U D I T  A D D - O N  

Three main advantages of using AuditXP are:  
1. Risk based auditing. Create an audit scope by looking at the risk scenario, and report on results 

from a risk based perspective. 
2. Analyze dependency effects. Visualize how a poorly performing management system can have 

large effects throughout the bowtie. 
3. Visualize results. Audit results are directly plotted on the bowtie using intuitive graphs, 

instantly highlighting problem areas. The visual representation facilitates expert judgments on 
overall barrier quality. It also provides an up-to-date feedback on the current barrier quality 
status. 
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Figure 265: Visualize audit results on barriers 

2 4 . 3  C R E A T E  Q U E S T I O N S  O N  D I F F E R E N T  ' B O W T I E  L E V E L S '  

With AuditXP, you can generate surveys that directly relate with elements that are defined on the 
bowtie diagram. The surveys can be directed at three levels of elements: 
 

1. Barrier level 
2. Management system level (activities and documents) 
3. General questions (e.g. on organizational structure) 

 
On the barrier level, the auditor is questioning whether the integrity of barrier meets the predefined 
requirements (e.g. is it in place? Is it working?). 
 
On management system level, the underlying management system can be assessed. This level covers 
activities such as training and maintenance, but also whether documentation is up to par (e.g. 
manuals, procedure documents).  
 
The third level covers questions that cannot be linked to any specific element in the bowtie, but 
cover more high-level structural or general questions. Questions typically cover the existence of 
complete systems (e.g. if there is a housekeeping system defined) or general subjects (e.g. the way 
personnel communicate or the state of housekeeping). 

2 4 . 4  T H E  G E N E R A L  W O R K F L O W  

The general workflow of AuditXP is as follows: 
 

1. Define or import questions. 
2. Associate the defined questions with barriers and/or activities. 
3. Create a survey, a selection of questions. 
4. Create fill out forms for respondents. 
5. Feed the filled out forms (the answers) back into BowTieXP. 
6. View and interpret the results. 

 
All the audit data is stored within the bowtie Case File. 
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2 4 . 5  T H E  A U D I T S  T R E E  V I E W  N O D E  

All audit data is stored under the audits node in the BowTieXP Tree view. There can be multiple 
audits within the audit module. An audit is a collection of questions and a collection of surveys 
(questionnaires, consisting of a subset of questions from that audit). To create a new audit, right click 
the audit node and select new audit. Like in the figure below. 
 

 

Figure 266 - The audits node 

 
When you select a new audit, the add audit window appears. In this window, indicate a name and 
basic purpose/usage for the audit. In case you are using AuditXP for risk-based auditing, please select 
Normal Audit as a basic purpose/usage. The option SIR Incident Questions is for setting up the 
Incidents module in BowTieServer, please refer to the BowTieServer Manual. 
 

 

Figure 267 - The add audit window 

 
Once you created the new audit, two containers are automatically added: One for the questions and 
one for the surveys of that audit. 
 

 

Figure 268 - The add audit window 



 

©  W O L T E R S  K L U W E R  |  C G E  R i s k  2 0 2 0  
C O N F I D E N T I A L  A N D  P R O P R I E T A R Y  

 

B O W T I E X P  S O F T W A R E  
M A N U A L  

 

P A G E  2 0 5  

 

2 4 . 6  D E F I N I N G  Q U E S T I O N S  

 

Figure 269 - Creating questions 

 
Defining questions within BowTieXP is done by right clicking on the questions node of audits 
container and selecting New Question. The editor will then pop-up: 

 

Figure 270 - Editing a question 

 
Questions should be choice questions. 

The questions created in AuditXP should be choice questions. This means that only a limited set of 
answers can be defined. The possible answers should be in a logically keyed order – from most 
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positive to most negative or vice versa. This means that a question like “Which country are you 
from?” cannot be asked in a question, because the answers do not range from positive to negative. A 
list of countries is a nominal scale, whereas AuditXP only deals with ordinal scales. From the set of 
possible answers, the respondent can select only one answer. 

 

Questions can be defined hierarchically. 

Just like activities and document links, questions can be defined hierarchically (nested). This has been 
added for convenience and grouping purposes only. The surveys themselves will only consist of a flat 
list of selected questions. 

 
2 4 . 6 . 1  D e f i n i n g  a n s w e r s  
Use the ENTER key to go to a new line in the answers field.  

The possible answers are each defined on a separate line in the “ordinal answer values list” field. To 
accomplish this ENTER must be used to go to a new line in this edit field.  

 

Positive, neutral and negative answers 

AuditXP assumes that the top half of the answers is positive and the bottom half is negative. It is 
possible to alter the negative or positive value in the ordinal answer value list, for instance by having 
negative answers first, by selecting ‘negative answer appears first in ordinal list’ under ‘Answering 
Key’. Ensure that the answer options you add to a question are in line with this interpretation. See 
the table in chapter 24.10.3, How to read the positive/negative bar charts on page 217 for examples. 

 

Use @ to change the center of the answer scale 

By default, AuditXP will take the exact middle of all the answers and use that to determine what is 
positive and negative. This middle point can be biased by including an @ sign as the first character on 
a line. Make sure it is the first character. Placing an @ anywhere else will result in unexpected 
results. 

For example: 

Poor  Totally disagree 

@  Disagree 

Acceptable  Somewhat disagree 

Good  @Neutral 

Very good  Agree 

 

In the example above, the middle will be between Poor and Acceptable. In the second example, 
Neutral will be the middle. 

In the advanced section for each question, there is one additional option: Most negative answer will 
determine overall result. This option will make sure that if there are multiple answers, the most 
negative answer will be used as the overall result. This can be convenient if one is not interested in 
the average result, but only in the outliers. 

2 4 . 7  A S S O C I A T I N G  Q U E S T I O N S  W I T H  B A R R I E R S  A N D  

A C T I V I T I E S  

Now that the questions have been defined, you can associate the questions with existing bowtie 
barriers and/or activities. This can be done by dragging the question to the target barrier or activity, 
or by adding the question to the barrier or activity in the questions tab in the barrier editor. To help 
you make a selection in the ‘Questions’ tab, there is a filter box to type text to filter the questions on. 
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Figure 271 - Assigning questions to a barrier with the editor 

 
Note that this works the same way as linking other items such as document links to bowtie elements. 
 
 

 

Figure 272 - Assigning questions using drag and drop 

 
 
The assigned questions can be displayed beneath the barrier shape as extra information, by using the 
eye-icon ( ) and selecting questions. See chapter 8, Configuring the diagram on page 89 for more 
details on how to configure the diagram. 
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Figure 273 - Showing questions as extra info on barriers 

2 4 . 8  C R E A T I N G  S U R V E Y S  

The set of questions can quickly become very large, and in most instances, you will not be seeking 
answers to every defined question – the time needed to gather all the answers will become 
prohibitive. In addition, some questions you will probably want answered at a different frequency 
than others. 
 
For this reason, you will select a subset of all available questions, and this subset will be answered. 
Such a subset is known as a survey. 
 
To create a new survey, you go over to the audits node in the Tree view, right click the surveys node 
and choose “New Survey”. The editor is popped up: 
 

 

Figure 274 - Adding a new survey 
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Figure 275 - The survey editor 

 
You will need to supply a code and name and can supply an optional description.  
The view results part will initially show nothing because no respondents have contributed yet to this 
survey. The questions in this survey can be assigned on the questions tab page. 
 

 

Figure 276 - Assigning questions to a survey 
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To help you make a selection, there is a filter box to type text to filter the questions on. There are 

also three dropdowns, which will allow you to use the bowtie as the selection mechanism for the 

questions. For example, in Figure 276 you see the first column says ‘Assigned to Barrier’, the second 

says with ‘Accountable’ and the third has ‘Driver’. This means that the list of questions is currently 

filtered to only display questions that are linked to barriers where the accountable is Driver. This 

filter can be used multiple times to make combinations of criteria. 

 
After entering a code and name for the survey and the questions are assigned, you can press the 
apply button. Now the export and import buttons will be enabled. This is covered in the next 
sections. 
 
When the survey form is saved, the survey will be added to the Tree view. It will be visible like this: 
 

 

Figure 277 - Tree view with a new Survey 

 
The questions linked to this survey are visible under the questions node.   

2 4 . 9  C R E A T I N G  F I L L  O U T  F O R M S  F O R  R E S P O N D E N T S  

A set of answers from a respondent is known as a fill out in the software. It consists of a date, a 
respondent’s name, and an organizational unit and of course a set of answers and answer remarks. 
For each question, there can be one answer and a remark. 
 

 

Figure 278 – Adding a new fill-out 
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Figure 279 - Creating a new fill-out 

 
Adding a set of answers into the software is fine if you are the only respondent, but if you might not 
have your computer handy or would like to gather answers from many respondents, this will not 
work. That is why there are other ways of getting the data into BowTieXP. 
 
The primary way is by means of Excel sheets – you might have noticed the import/export buttons on 
the survey editor. We will discuss those in the next section. 
 
Another way is to couple the audits module to another external system. This can be done by means 
of the BowTieXP API, which allows programmers to manipulate btf files directly. This is beyond the 
scope of this manual, but contact us for details on options on how to integrate with your external 
audit system and use BowTieXP for visualization of the results. 

 
2 4 . 9 . 1  E x p o r t i n g  a n d  i m p o r t i n g  f i l l  o u t s  t o  a n d  f r o m  
M i c r o s o f t  E x c e l  
After the surveys have been composed by selecting relevant questions, an Excel sheet can be 
automatically generated. This sheet consists of all the questions, criteria and answer keys defined by 
the user and provides a quick dropdown menu.  
 
The auditor can simply select the applicable answer key. After that, the sheet can be imported back 
into BowTieXP for quick analysis and visualization of the results. 
 
To do this, on the survey editor there are two buttons for exporting to and importing from Excel. The 
export button will create a Microsoft Excel workbook in which you can enter answers and remarks to 
each question. Using the import button, you can then import the filled out sheet, and the results will 
be stored in a new fill-out in the Tree view. 
 
This allows you to send the survey to potentially many people, and receive the answers back via e.g. 
email. You can then import them all at the press of a button. 
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To export and import an Excel sheet, double click a Survey or right-click a survey and select ‘Edit 
Survey’. In the ‘Edit Survey’ window, it is possible to select ‘Export Fill Out’ or ‘Import Fill Outs’ 
 

 

Figure 280 – Importing and exporting Excel fill outs 

 
Note: you can also drag the filled out Excel sheet onto the Scrap book and into the Tree view from there. 

 

 

Figure 281 - Fill out in Microsoft Excel 
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2 4 . 1 0   V I E W I N G  R E S U L T S  

The relevant answers returned can be viewed graphically: 

• On the survey editor form in the results pane. 

• On the barrier editor form on the audit results tab page (only answers related to that barrier). 

• On the activity editor form on the audit results tab page (only answers related to that activity). 

• On the barrier shapes in the diagram (by using the Audit Filter). 
 
On the editor, the results of a particular survey are displayed as positive/negative bar graphs, one bar 
per question. Right click on a single bar and select ‘View details’ to show the details of all answers 
given for that question. In addition, the number of fill outs received for the Survey is shown. It is also 
possible to filter on a specific survey, organizational unit, date, fill outs or the results (for instance to 
only show negative results). 
 

Note: Throughout this document, the bar graphs use the green color on the right-hand side to indicate positively 
keyed answers, and red on the left-hand side to indicate negatively keyed answers. However, these colors are not 
optimal for people born with color blindness. That is why in the application the positive and negative colors can be 
configured in the BowTieXP options screen. 

 

 

Figure 282 - Viewing survey results in the survey editor 
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Figure 283 - Detailed overview of question results 

 

 

Figure 284 - Viewing audit results in the barrier editor 

 

To see results displayed on the bowtie. The Audit filter needs to be turned on. Go to Filters in the 

toolbar and select Audit filter (see Figure 279). 

 

 

Figure 285 - The audit filter on the bowtie 
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Figure 286 - Showing audit results on the diagram 

 
Clicking on a bar of a graph will show the answers given in a separate dialog form. You can also 
configure the diagram to show only results from a specific survey and a specific respondent (fill out). 
There is also a date filter and a filter to show a specific section of results. It is also possible to filter 
the audit results for a specific organization unit. 
 

Note: The organizational unit filter overrides the survey filter. If you have a survey of an organizational unit that is 
not in the bowtie group, it will not show those results on the bowtie. 

 
2 4 . 1 0 . 1  A g g r e g a t i o n  o f  a u d i t  r e s u l t s  
Aggregation of audit results allows you to show the sum of all the answers of your questions on a 
barrier. This can help reduce the amount of information shown on your barriers when the audit filter 
is selected.  
 
To keep the aggregation of audit results manageable, we have to create multiple layers according to 
the parent-child structure of the Tree view. Some of these layers will not actually be real questions, 
but they will simply be there to ‘host’ the answers of the individual questions for us.  
 
To make an aggregation of audit results, right click on Audits in the Tree view and select ‘new 
question’, this question will be a ‘host question’. Note that this will not be a real question, the only 
reason we’re doing this is because the software demands a parent-child structure. Fill in a name and 
code, but nothing else, and press OK.  
 
On this new ‘host question’, right click and select ‘new question’ again to make the actual set of 
questions that you are interested in. In Figure 287 – An example of a parent-child structure for 
aggregation, as an example, we’ve created a ‘host’ question called ‘Maintenance Activities’. Under 
that ‘host question’ we’ve assigned three individual questions.  
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Figure 287 – An example of a parent-child structure for aggregation 

 
To get answers for these questions, walk through the survey steps described in chapter ‘24.8 Creating surveys’.  
Note: in this example, the 3 individual questions are not assigned to a barrier. To show the aggregated answers, drag the 
‘host question’ (e.g. ‘Maintenance Activities’) we made earlier to a barrier and turn the Audit filter on. The result should look 
something like this:  
 

          

Figure 288 – Assigning a group question to a barrier 

 
As illustrated by the Sigma sign ∑ 3, instead of having 3 different questions & answers on a barrier, 
which would take up more space, we now have only the sum or aggregation of the audit results on 
the barrier. Clicking on the answer will show another window, as seen in Figure 289 - Showing 
detailed aggregated audit results, displaying all the different answers the ‘host question’ consists of: 
 

 

Figure 289 - Showing detailed aggregated audit results 

 
It is of course also possible to show both the aggregation as well as the individual answers on a barrier. However, this would 
not make much sense. If you want to show aggregation of audit results on a barrier which already has individual questions 
linked, we suggest to temporarily remove all the individual questions. You can do this by right clicking, selecting edit barrier, 
going to the questions tab and remove any excess questions.  

 
2 4 . 1 0 . 2  I n t e r p r e t a t i o n  
In essence, BowTieXP is a qualitative tool and so is the question framework. All the different answers 
are counted and displayed as clear as possible, but it is up to the BowTieXP user to draw any 
conclusions and take corrective measures where needed.  
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2 4 . 1 0 . 3  H o w  t o  r e a d  t h e  p o s i t i v e / n e g a t i v e  b a r  c h a r t s  
 

Example question and resulting 
graph: 

description meaning 

 
 

Single answer 
Somewhat positive answer 

Single answer  

 
 

Single answer 
Most positive answer 

Single answer  

 
 

8 answers (n=8) 
Even distribution between negative 
and positive answers 

Uncertainty 

 
 

Representing 8 answers (n=8) 
Mostly negative answers  

Negative tendency 

 
 

Representing 8 answers (n=8) 
Answered all most positively 
 

Fully positive 

 
 

Representing 8 answers (n=8) 
Mostly neutral answers 
 

Neutral tendency 

 
 

Representing 8 answers (n=8) 
All answers are all centered / fully 
neutral 
 

Fully neutral 

 

No answer data available Not answered 
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2 4 . 1 1   A U D I T X P  I N  C O M B I N A T I O N  W I T H  B O W T I E S E R V E R  

2 4 . 1 1 . 1  A d d i n g  a n  a u d i t  ( A u d i t  m o d u l e  i n  B o w T i e S e r v e r  
o n l y )  
There are three different ways of adding a new audit when you are using the audit functionality in 
combination with BowTieServer: 

1. Entire database check out 
2. Add audit check out 
3. Add new audit remotely 

Note that option three is probably the easiest. 

 

E n t i r e  d a t a b a s e  c h e c k  o u t  

 To do this, follow these steps and see Figure 290. 
1. Connect with BowTieServer (please see the BowTieServer Software Manual on how to do this). 
2. This brings up the server explorer, where we can select what we want to check out. 
3. Select ‘Open and checkout the entire contents as writeable’ in the lower left bottom of the 

window 
4. Select ‘Open from database’ 
5. From this point, the process of creating an audit is the same as described in sections 24.5, The 

audits Tree view node. 
 

 

Figure 290 - Entire database check out 

 

A d d  a u d i t  c h e c k  o u t  

It is not always possible to check out the entire database, since other people might be or need to edit 

other entities of the database at the same time, for example someone is adjusting another audit or a 

group of bowties. The option of ‘add audit check out’ can be useful when an entire check out is not 

possible, and you intend to add multiple audit objects. 

 

To do this, follow these steps and see Figure 291. First, connect with BowTieServer using ( ) 

(please see the BowTieServer Software Manual on how to do this). 

12. Select ‘Open selected items from the list above’ in the lower left bottom of the screen 
13. Select the radio button in ‘Add’ column in the Audits node of the window. 

 
Note: if the “Add” column is not visible, please click the menu icon ( , in the top right-hand corner, under your 
user name) and choose to display the “Add” column. 
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14. Select ‘Open from database’ 
15. Now we can freely add new audits to the audits Tree view node. From this point, the process 

of creating an audit is the same as described in chapter 24.5, The audits Tree view node. 
 

 

Figure 291 - Add audit check out 

 

A d d  n e w  a u d i t  r e m o t e l y   

It is not always possible to check out the entire database, since other people might be or need to edit 
other entities of the database at the same time, for example someone is adjusting another audit or a 
group of bowties. The option of ‘add new audit remotely’ can be useful when an entire check out is 
not possible.  
 
To do this, follow these steps and also see Figure 292, Figure 293 & Figure 294 for reference. Connect 

with BowTieServer using ( ) (please see the BowTieServer Software Manual on how to do this). 
1. Select ‘Open selected items from the list above’ in the lower left bottom of the screen (Figure 

292) 
2. Right-click the audits node and select ‘Add new audit remotely’. 
3. Enter a name for the new audit select ‘OK’ (Figure 293). 
4. Select the edit radio button for the newly created audit (Figure 294). 
5. Select ‘Open from database’. 
6. From this point, the process of creating an audit is the same as described in chapter 24.5 The 

audits Tree view node. 
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Figure 292 – Add new audit remotely (1/3) 

 
 

 

Figure 293 -Add new audit remotely (2/3) 
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Figure 294 - Add new audit remotely (3/3) 

 
2 4 . 1 1 . 2  L o n g  f o r m a t  s u r v e y s  ( A u d i t  m o d u l e  i n  
B o w T i e S e r v e r  o n l y )  
The audit module in BowTieServer has extended audit possibilities. Not only in the form of reports, 
but also by means of the long format surveys. This enables the user to extend an audit question with 
sub questions named ‘work instructions’.  
 
The questions created in AuditXP should be choice questions with an ordinal scale. With the long 
format surveys, it is possible to extend the audit questions with work instructions to also ask for 
instance open-ended questions and questions with a nominal answering scale. 
 
For instance, an audit question might be “Is lane departure warning hardware installed on all 
company vehicles?” An ordinal choice based AuditXP audit answer possibilities could be ‘Yes’ and 
‘No’. From the set of possible answers only one answer can be selected by the respondent and 
remarks can be added. 

 

With work instructions, we can add a set of sub questions that can have different answering inputs. 
The work instructions for this audit question might be: 

• “Which type of LDWS is installed?” 

• “Is the LDWS calibrated?” 

• “What is the certification type of the LDWS?” 

• “What is the expiration date of the certification of the LDWS?” 
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In BowTieServer, the main audit question (in the example above: “Is lane departure warning 
hardware installed on all company vehicles?”) will be posed first. After which the work instructions 
are presented. Once the work instructions are filled in, a judgement can be given by the user on the 
main audit question. Attachments can be inserted as well, for instance to provide additional 
information or evidence. 

 

A d d i n g  w o r k  i n s t r u c t i o n s  

To set up the long format survey with work instructions on an audit questions, double click the 
question to which you would like to add work instructions to. Subsequently select the tab ‘Work 
instructions’ and select the icon ‘Add.’ to extend the audit question with a work instruction. 

 

Figure 295 - Adding a work instruction in the ‘Work instructions’ tab 

 
When ‘Add’ is selected, you will be prompted with an ‘Edit work instruction’ window. There are 
multiple ways of presenting work instructions answering inputs for an audit questions by selecting 
‘Input type’. 
 
When input type ‘Text’ is selected, the respondent is able to insert text. Check the box ‘Allow 
multiple lines’ to provide the user with an opportunity to extend the text answer input in the box 
over multiple lines. 
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Figure 296 - Input type 'Text' 

 
When input type ‘Choice’ is selected, the user can create choice based answer values. Check the box 
‘Allow multiple lines’ to allow for checking multiple boxes. If the box is unchecked, the respondent 
can only insert one answer using a radio button. 
 

 

Figure 297 - Input type 'Choice' 

 
When input type ‘List’ is selected, multiple work instruction columns can be added with a ‘Text’ or 
‘Choice’ based input by selecting ‘Add’.  
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Figure 298 - Input type 'List' 

 
When ‘Add’ is selected, you will be prompted with the ‘Edit work instruction column’ window. It is 
possible to add ‘Text’ or ‘Choice’ based answer values for the work instruction column in the ‘Edit 
work instruction column’ window. 
 

 

Figure 299 - Input type 'Text' for the work instruction column 
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Figure 300 - Input type 'Choice' for the work instruction column 

 
Select ‘OK’ to add the work instruction or work instruction column to the audit question. 

 

E n a b l i n g  t h e  l o n g  f o r m a t  s u r v e y  

Once work instructions have been added to an audit question, and the audit questions have been 
added to a survey, the long format survey with the work instructions need to be enabled. To enable 
the long format survey, check the box ‘Use long question format’ in the ‘Edit Survey’ window. The 
‘Edit Survey’ window can be opened by double clicking a survey. 
 

 

Figure 301 - Enabling the long format survey 
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25  
COMPLIANCE FRAMEWORKS 

This section covers how to set up the compliance frameworks and how to link them to barriers. The 

compliance frameworks are part of the audit module. BowTieServer also supports the compliance 

functionality with some additional dashboards. 

2 5 . 1  C O N C E P T  I N T R O D U C T I O N  

To use the compliance frameworks functionality effectively, it is important to understand the 
underlying idea and concept that was used during the design of this feature. This will be explained in 
the following section. 
 

 
Figure 302 - Compliance framework concept with example 

 
The feature was introduced to bridge the gap between bowties (i.e. barrier-based risk management) 
and the world of compliance assurance. There are many standards, covering wide subjects ranging 
from quality control to safety management. Some of these are considered best practices, where 
others even have legal implications. However, compliance standards are usually not foolproof plans 
for the implementation of a safety management system. A safety management system is typically 
designed to manage the current operation, the compliance frameworks are then used to check 
whether the designed system conforms to the standard. 
 
In this module, we assume that most of standards (if not all) can in essence be broken down into a 
collection of ‘control objectives’. These control objectives can be seen as statements that describe a 
requirement that the organization’s management system needs to be capable of. To check whether 
the control objective is met by the company, it must first be determined which part of the 
management system takes care of this objective. Once it is clear which part of the system is 
responsible, it must also be verified whether that system is effectively implemented and functional.  
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In the example shown in  
Figure 302, the aviation related BARS standard (http://flightsafety.org/bars/) has a control objective 
that describes the requirements for a bird control unit. This objective is realized in the barrier “bird 
control program” and perhaps in additional activities such as “cut hedges and tall grass” which can be 
associated with a different barrier. In turn, barrier-based audits can be linked to the barrier. This then 
shows us the performance of that barrier, which in turn helps us to make a decision on whether this 
objective has been effectively implemented or not. 
 
So, by looking at which barriers and activities within the organization take care of a control objective, 
and by looking at the performance of those activities and barriers we can draw a conclusion on 
whether the objective has been effectively met. 
 
This concept has various advantages. First, the feature visualizes how the control objectives of one 
(or multiple) compliance standards are intended to be realized through the barriers and related 
activities. If a control objective can be mapped on a BowTie, it demonstrates that a barrier system 
has been defined that takes care of that objective. If an objective cannot be mapped, this means that 
either no system has been defined that takes care of that objective or that this objective cannot be 
directly mapped onto the barrier-based model. This process can visualize how standards and 
legislative requirements map on bowtie diagrams and increase the understanding of why certain 
barriers are important. 
 
Secondly, it can help to reduce the audit workload. In this model, it is possible to link multiple 
standards onto the same set of bowties. It is very likely that one barrier realizes requirements from 
multiple different standards. Traditionally, compliance with standards is checked with a specific audit 
for that standard. If a barrier represents multiple objectives from multiple standards, this often 
means that the barrier has to be audited for every standard in which it is mentioned. This can lead to 
repetitive audits that add little additional insight into the barrier yet create additional audit 
workload. Instead, with this model, multiple standards can be linked to a barrier, but the quality of 
the implementation of that barrier is done by a single set of questions. Therefore, by auditing the 
quality of the barrier, we can derive through the barrier whether the standard is complied with. 

2 5 . 2  S E T T I N G  U P  C O M P L I A N C E  F R A M E W O R K S  

In general, compliance frameworks can be set up and used in the following two steps: 
 

1. Create / import the control objectives 
2. Link the control objectives to the barriers 

 
These will be explained in the following sections. 

 
2 5 . 2 . 1  C r e a t i n g  /  i m p o r t i n g  c o n t r o l  o b j e c t i v e s  
A new compliance framework can be added to the BowTieXP casefile under the “Compliance 
Frameworks” node. This can be done by right clicking the node and defining a new name for the 
framework. 
 

http://flightsafety.org/bars/
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Figure 303 - Add compliance framework 

 
A compliance framework contains two collections that can be defined as shown in Figure 304: 
 

- Maturity levels: Many standards come with their own set of maturity levels. These are used 
to indicate how well an objective is realized (i.e. complied with) within the organization. 

- Objectives: These are the actual statements that are described in the standard that the 
organization must comply with. 
 

 

 

Figure 304 - Defining objectives and maturity levels 

 
Objectives can also be imported from Excel sheets using the Import External Data option in the File 
menu. 

 
2 5 . 2 . 2  L i n k i n g  O b j e c t i v e s  t o  B a r r i e r s  
Once the Objectives are defined in the file, they can be linked to their relevant barriers. This can be 
done like any link collection by dragging and dropping the objectives from the Tree view to the 
barriers. Alternatively, the Objectives tab on the barrier editor can be used (similar to other link 
collections), or the Assigned to Barriers tab on the Objective. 
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Figure 305 – E.g. drag/drop objectives to assign (1 of 3 assignment methods) 

2 5 . 3  I N T E R P R E T I N G  C O M P L I A N C E  F R A M E W O R K S  

An overview of all objectives and related barriers can be found in the Case Overview. This overview 
shows all objectives and whether they have been assigned to barriers. By double clicking on an 
objective, the audit results of all linked barriers can be displayed.  
 

 

Figure 306 - Case Overview for compliance frameworks 

 
In the objective editor, the tab “audit results” shows all audit results of all barrier and activities onto 
which this objective has been linked. This information can then be used to decide to which maturity 
level this objective has been established. Once assigned, the maturity level will also be displayed in 
the corresponding column in the case overview. 
 
Another overview of states can be seen on BowTieServer, which is described in the BowTieServer 
manual. 
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26  
LOPA (LAYERS OF PROTECTION ANALYSIS) 

This chapter describes how the LOPA (Layer Of Protection Analysis) module is used in BowTieXP 
version 10.0 or higher. Note that LOPA is commercially distributed as a separate BowTieXP addon. 
Prior to v10 LOPA was offered as a separate plugin but as of v10.0 of BowTieXP the LOPA 
functionality has become part of the software package. 

2 6 . 1  L O P A  A C T I V A T I O N  

To be able to perform LOPA analysis a valid BowTieXP product code must be obtained that includes 
and activates the internal LOPA module. The LOPA module can be activated on BowtieXP Standard or 
advanced License. The BowTieXP product code should be entered in the BowTieXP product activation 
screen: 
 

 

Figure 307: BowTieXP product activation 

 
To check whether the LOPA module has been loaded and activated a restart of the software might be 
required before the LOPA module can be used. For other types of activation such as group locked or 
site locked activation, refer to the BowTieXP Installation reference in the regular BowTieXP manual. 
 
Once the LOPA module is loaded and activated, the text “LOPA” should show up in the BowTieXP 
application status bar (down under left) after the program starts. Also, in the Help -> About… form of 
BowTieXP it should show “LOPA” as an enabled feature. 

2 6 . 2  L O P A  E L E M E N T S  

The LOPA module adds LOPA specific fields on the editors of several BowTieXP elements. 
LOPA data entry and result fields are present on a special LOPA tab in the edit forms of the following 
objects: 
 

- Hazard/Top Events:  
o Enter target frequencies,  
o Show LOPA results 

- Consequences: 
o Enter acceptable frequencies  
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o Show LOPA results 
- Threats:   

o Enter initial frequencies 
- Barriers:   

o Enter PFD values (that reduce the Threat frequency) 
- Consequence Categories: 

o Enter category default acceptable frequencies 
- Effectiveness: 

o Enter default PFD values for barriers to be used as PFD values when no specific 
PFD values are filled in on a barrier 

- Frequencies: 
o Enter default initial frequency values for Threats to be used as default values when 

no specific initial frequencies are filled in on a Threat  
 
 
The LOPA module also adds specialized LOPA reports, a LOPA classic scenario case overview, LOPA 
display profiles and the LOPA menu items under the BowTieXP menu tools -> options 
 
All editor fields, reports, overviews, display profiles and menu items are described in more detail in 
this manual. 

2 6 . 3  C O N F I G U R I N G  L O P A  S E T T I N G S  

 
 

Figure 308 Configuring LOPA settings 

 
The LOPA settings screen can be opened by clicking menu tools-> LOPA Settings… Several settings 
can be configured/customized here: 
 

- The terminology used for LOPA fields 
- The desired display format for numeric fields. Details can be found here: 

o https://docs.microsoft.com/en-us/dotnet/standard/base-types/custom-
numeric-format-strings 

- Whether to use strict or non-strict field validation 
- The colour scheme used for displaying LOPA results (“Criteria met”, “Criteria not met”, 

“Unknown”) 
 

https://docs.microsoft.com/en-us/dotnet/standard/base-types/custom-numeric-format-strings
https://docs.microsoft.com/en-us/dotnet/standard/base-types/custom-numeric-format-strings
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Note: The terminology for LOPA fields can also be changed in menu Case -> Edit Property Descriptions…. 

 
These LOPA Settings are stored in the current Case File and can also be configured as part of a 
customized BowTieXP template. 
The LOPA terminology and formatting can be exported to- and imported from a properly formatted 
excel sheet for convenience. 

 
2 6 . 3 . 1  S t r i c t  v s .  N o n - S t r i c t  c a l c u l a t i o n  m o d e  
Strict 
In general: when using the “strict” mode all fields need to be filled with sensible values in order to 
come up with a valid LOPA result, otherwise the LOPA results will collapse to “unknown”. Introducing 
a new Threat in the diagram without LOPA fields properly filled will immediately turn the Hazard and 
all Consequence LOPA results to “unknown”. 
 
Non-strict 
When using the “non-strict” mode of the LOPA calculation: 

- Compared to the “strict” mode, other default values are assumed during calculation,  
- Empty “future” field values are assumed to be the same as current values 
- No “unknown” LOPA results show up, the LOPA criteria are always either “met” or “not 

met”. 
 
In the software the “strict” calculation mode is defaulted. To change this, go to Tools - > LOPA setting 
and un-tick (!) the ‘Strict validation using “Unknown” values’ box shown in figure 2 (see above). 

2 6 . 4  L O P A  I N  B O W T I E X P  

In addition to the strict or non-strict interpretation of field values, the LOPA module in BowTieXP 
performs two different ways of calculating results. We call these algorithms the “Bowtie method” 
and the “Classic scenario method”  

 
2 6 . 4 . 1  T h e  B o w t i e  m e t h o d  
Engaging a BowTieXP LOPA display profile will by default show the LOPA results in Bowtie diagrams 
using the “Bowtie method”. This algorithm accumulates the resulting frequencies of all diagram 
Threats on the central Hazard/Top Event. This will result in the total top event frequency. This value is 
then used as a frequency factor in the calculations for each Consequence. This way we’re able to 
display a single LOPA result on the Hazard/Top Event as well as each Consequence. There are several 
“Bowtie method” reports that show the LOPA results using this algorithm. 
 

Note: The LOPA results in the Hazard and Consequence editor tab pages are calculated using the Bowtie method.  

 
2 6 . 4 . 2  T h e  C l a s s i c  s c e n a r i o  m e t h o d  
In the “Classic” LOPA analysis each single Threat -> barrier chain -> Consequence scenario is 
considered. Within a single BowTieXP diagram containing 3 Threats and 5 Consequences, 15 (= 3 x 5) 
of such scenarios can be identified. Each scenario can be calculated using the “classic LOPA method”. 
So, using the classic scenario method, each Consequence can possibly have multiple LOPA results. 
Due to the “cartesian” nature of scenarios within a BowTieXP diagram, the classic LOPA results can 
only be displayed in specialized “classic” reports (available in both Word and Excel, see figure 3) and 
in a real time case overview, rather than displaying the results on the BowTieXP diagram or editor 
pages. 
 

Note: In the classic scenario calculation any LOPA values set on the Hazard/Top Event are ignored 
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Figure 309 LOPA reports for both methods 

 

2 6 . 4 . 3  C u r r e n t  a n d  F u t u r e  f i e l d s  
Several input fields on a LOPA item have a “Current” value field and “Future” value field. The future 
field can be filled in when the future is expected to be different than the current value. Therefore, all 
LOPA results have a current and a future value. When future fields are not filled, LOPA usually 
considers the future value to be the same as the current value during calculation. 

2 6 . 5  E N T E R I N G  N U M E R I C  D A T A  I N  L O P A  F I E L D S  

Most of the LOPA data entry fields in the editors expect a number. It is possible to enter numeric 
data in scientific notation (e.g. 1.2E-3) as well as the normal notation (e.g. 3.141592). Note that while 
entering the number the application accepts only “computer expected” formatting using the dot as a 
decimal separator. Once the number has been entered the field may display in another configured 
format, but it will return to “computer” data entry mode whenever the field is focussed again. 
 

Note: Entering LOPA numeric data: please use a dot as decimal separator and not a comma. 

 
Whenever the data entry in a LOPA field can’t be parsed as a valid number the field background will 
turn orange and the user needs to correct or finish his entry. Note that when a field has an invalid 
entry and the field background is orange, the underlying data value is not changed and remains the 
last correct numeric value. 
 

 

Figure 310 Numeric data entry examples 

 
None of the LOPA fields in the application are mandatory, but sometimes assume a default value in 
the calculation when not filled in. This default however can depend on which LOPA calculation mode 
has been set in the LOPA settings (“strict” or “not strict”), see chapter 26.3.1.  
 

Note:  press “apply” in the editor dialog to view the updated recalculated LOPA results after entering new data 

2 6 . 6  R E C O M M E N D E D  P R A C T I C E  

Although there’s no specific order in which the LOPA fields need to be filled in, we would 
recommend this practice 
 

- Fill in the target frequency on the Hazard/Top Event 
- Fill in the acceptance frequencies on each Consequence 
- Fill in initial frequencies on Threats 
- Fill in PFD values foreach barrier. 
- Examine results. 
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2 6 . 6 . 1  T a r g e t  f r e q u e n c i e s  o n  t h e  H a z a r d / T o p  E v e n t  
 

 

Figure 311 - Setting Top event Target Frequency 

 
Default calculation values when left empty 

 Input Field Strict Non-Strict 

Target frequency Unknown 0 

 
In strict mode: not filling in a field value for “target frequency” will cause all consequences to 

collapse to “unknown” also. 

 
2 6 . 6 . 2  A c c e p t a b l e  f r e q u e n c i e s  a n d  c o n d i t i o n a l  
m o d i f i e r s  

  

Figure 312 - Setting acceptable consequence frequency 
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Default calculation values when left empty 

Input Field Strict Non-Strict 

Acceptable consequence frequency Category default frequency if filled in 
otherwise Unknown 

Category default frequency if filled in 
otherwise 0 

Conditional modifier 1 1 

Future conditional modifier Current Conditional modifier value Current Conditional modifier value 

 
It is possible to add a probability to the consequence in the ‘Conditional modifier’ field. Conditional 
modifiers within the LOPA method allow you to take factors like luck into account to estimate the 
probability that an event will actually lead to damage or harm. Common conditional modifiers are 
probability of occupancy, ignition and fatality. The comments box of the consequence can be used to 
describe the basis for the conditional modifier. It is also possible to fill in the expected conditional 
modifier in the future if it differs from the current value. 

 
2 6 . 6 . 3  T h r e a t  i n i t i a l  e v e n t  f r e q u e n c y ,  e n a b l i n g  f a c t o r  

 

Figure 313 – Initial frequency on threat 

 
Default calculation values when left empty 

Input Field Strict Non-Strict 

Initial frequency Threat Frequency default value. When 
this is also empty: Unknown 

Threat Frequency default value. When 
this value is also empty: 0 

Enabling factor 1 1 

Future initial frequency Initial frequency  Initial frequency 

Future enabling factor (Current) Enabling factor (Current) Enabling factor 

 
It is possible to add a probability to the threat in the ‘Enabling factor’ field. An Enabling Factor is 
something that cannot directly cause the next event but must be present for the scenario to proceed. 
For example: when the threat is ‘Strong winds’ and the top event ‘Fall of scaffold’, the enabling factor 
is ‘Presence of personnel on scaffold’. The initiating frequency is then the probability of strong winds 
and the enabling factor is the probability of presence of personnel on scaffold. These numbers will be 
multiplied by the software.  
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Note: The Enabling Factor is by default ‘1’ (100%) in the bowtie, indicating that the threat can cause the top event 
on its own.  

 
Exclude from LOPA 
A Threat and its barrier chain can be excluded from taking part in any LOPA calculation, by checking 
the box “Exclude from LOPA” (see Figure 7). This will also hide the Threat using the LOPA display 
profiles and hide any scenarios involving this Threat in classic calculations. 
 
In strict mode: When the Threat is part of the LOPA calculation (so not excluded) and the initial 
frequency as wells as default frequency values are not filled, the hazard/top event and all 
consequences will collapse to “unknown” values. 

 

2 6 . 6 . 4  B a r r i e r  P r o b a b i l i t y  o f  f a i l u r e  o n  d e m a n d  ( P F D )  
v a l u e s  
The PFD value is the Probability of Failure on Demand of the barrier. For safety instrumented systems 
it is equivalent to the SIL (Safety integrity level) level. The range of acceptable values is from  

1 (no effect, same as barrier not present) down to  
0 (always available and will always work and stop the scenario) 

Note that each barrier must be an IPL - Independent Protection layer. This requires the barrier to be 
fully independent and have no common failure modes with other barriers and must be enough to 
stop the event chain from progressing - if it works as intended. 
 

Note: LOPA calculations can be performed on the elements of a bowtie diagram provided that the scenario barriers 
are logically independent of each other (IPL). 

 

  

Figure 314 - Setting the PFD for a barrier 

 
Default calculation values when left empty 

Input Field Strict Non-Strict 

Current PFD The Default PFD value for the Barriers’ 
assigned effectiveness. When this value is 

also left empty: Unknown 

The Default PFD value for the Barriers’ 
assigned effectiveness. When this value is 

also left empty: 1 (no reduction) 

Future PFD Current PFD  Current PFD 

 
In strict mode: When a threat barrier’s PFD is left empty its threat frequency will be unknown and 
the hazard, and all consequences will collapse to “unknown”. When the barrier is on the 
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consequence side, only the involved consequence will collapse to “unknown” result when the PFD is 
left empty. 

2 6 . 7  C A L C U L A T I O N   

Whenever a change is committed to the casefile data a LOPA calculation automatically is executed.  
In BowTieXP a change can be committed by clicking “Apply” or “OK” in the editor windows. 

 
2 6 . 7 . 1  B o w t i e  m e t h o d  o f  c a l c u l a t i o n  
a) Multiply each threat’s Initial event frequency with the enabling factor (if present) and with all PFD’s 

from the barriers on that line to get a residual event frequency for each threat. Below example 
illustrates this: 
1E-2 * 0.5 * 0.2 = 1E-3 

 

Figure 315 – Calculation of the Current Top Event frequency per threat 

 
b) The current top event frequency for each threat/initiating event will be summed to get the Total 

current top event frequency, visualised on the hazard-top event pair. That frequency is compared 
against the acceptable top event frequency, and the LOPA will tell you if the acceptance criteria is 
either met or not.  
 

 

Figure 316 Display LOPA results on the Hazard/Top Event 

 
c) Each consequence frequency is calculated by starting with the current total top event frequency 

and multiplying it with the barrier PFD’s on a consequence line, and finally with the conditional 
modifier, if present. (For consequence frequencies calculated per scenario, see chapter  26.14  
Classic LOPA report.) 

d) The calculated frequency of the consequence will be compared to the acceptable consequence 
frequency and LOPA will tell you whether the acceptance criteria is met or not. 

e) The same is done for the future situation, using all the future calculation values instead of the 
current values. This results in acceptance criteria either being met or not in the future. 
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Note: When determining if acceptance criteria are met, a small error is allowed to compensate for floating-point 
rounding errors. The actual frequency is allowed to be larger than the acceptable frequency by a margin of 

acceptable frequency × 10^-5
. 

 
Note: Escalation factors and escalation factor barriers are not included in the LOPA calculation. 

 
2 6 . 7 . 2  F u t u r e  f i e l d s  
The current frequency/enabling factor/conditional modifier/IPL fields show the calculated current 
level of protection. The future frequency/enabling factor/conditional modifier/IPL field allow you to 
compare the current frequencies to a predicted frequency given an expected or hypothesized change 
 

Note: A barrier we currently plan to implement would get a current PFD of 1, and the future PFD will be the expected 
probability of failure. A PFD of 1 means no contribution / reduction. 

 

2 6 . 7 . 3  G a p  r a t i o  

Other than the current and future calculation BowTieXP also calculates the gap ratio either on the 

top event or on the consequence. The gap ratio equals the following formula: 

Gap ratio = target frequency / current frequency. 

2 6 . 7 . 4  L O P A  c a l c u l a t i o n s  a n d  B o w T i e X L  

As LOPA calculations can be changed on a frequent basis intially, due to performance issues, LOPA 

calculated outcomes were not available for further manipulation using BowTieXL. In the current 

version of the software this is different. The calculated outcomes of the LOPA values are displayed 

amongst different BowTieXL sheets however, all values are read-only. After values have changed 

thought LOPA, the sheets should be manually refreshed in order to present the most recent LOPA 

values. 

Just like in the past, the reason for this are potential performance issues as lopa changes would 

impact calculations on different sheets within BowTieXL limiting the software to operate as intended. 

2 6 . 8  L O P A  D I S P L A Y  P R O F I L E S  

The LOPA module adds two standard display profiles to the file. The normal “LOPA” profile shows 
just the current situation, whereas the “LOPA – Future” profile shows both the current and future 
situations.  
 

The LOPA display profiles can be added / restored to their defaults by executing menu Tools -> Add/Reset LOPA 
display profiles. For instance, when they are not present yet in your casefile. 

 
In BowtieXP Advanced edition these profiles can be edited in the same manner as any other display 
profile within BowTieXP.  
 

 

Figure 317 – Where to find LOPA display profiles 
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Engaging the LOPA display profiles will temporarily hide Threats excluded from calculations and also 
will hide any escalation factors and their barriers, since LOPA performs calculations of the main 
barriers only. 

2 6 . 9  F R E Q U E N C Y  D E F A U L T S  F O R  T H R E A T S  

Optionally you can use Frequencies to to standardise a default initial frequency for Threats having 
that frequency assigned. This is done like this: 
 
Go to BowTie Lookup tables > Frequencies and right click > New / Edit Frequency. In the Lopa tab an 
appropriate value can be entered. 

 

 

Figure 318 - Edit default frequency values 

 
Note that the values entered here are only apply to Threats having the edited/created frequency 
assigned and that have no further LOPA specific initial frequencies filled in. 

2 6 . 1 0   B A R R I E R  P F D  D E F A U L T S  B A S E D  O N  A S S I G N E D  

E F F E C T I V E N E S S  

Optionally you can use Effectiveness to standardise a default PFD value for Barriers having that 
Effectiveness assigned and that have no further LOPA specific PFD values filled in. 
 
Go to BowTie Lookup tables > Effectiveness and right click > New / Edit Effectiveness. In the Lopa tab 
an appropriate value can be entered. 
 

 

Figure 319 - Assiging default PFD values on effectiveness 
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Note that the values entered here are only apply to Barriers having the edited/created effectiveness 
assigned and that have no further LOPA specific PFD values filled in. 

2 6 . 1 1   C O N S E Q U E N C E  C A T E G O R Y  A C C E P T A N C E  C R I T E R I A  

Optionally you can use consequence categories to standardise acceptance criteria for different kinds 
of consequences. This is done like this: 
 
Go to BowTie Lookup tables > Consequence Categories and right click > New / Edit Consequence 
Categories. In the Lopa tab an appropriate value can be entered. 

 

 

Figure 320 - Edit acceptable category frequency 

 
Now when editing a consequence, you can choose the applicable category from the drop down: 
 

 

Figure 321- Assigning a consequence category to a consequence 

 
The LOPA tab on the consequence will show the acceptable category frequency, which comes from 
the consequence category. 
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Figure 322 - Acceptable category frequency applied to consequence 

 
This category frequency will be overridden if you manually put in an acceptable consequence 
frequency on the consequence.  

2 6 . 1 2   R E P O R T S  A N D  O V E R V I E W S  

There are a number of reports available for the LOPA module. Some reports follow the bowtie 
method calculations and others follow the classic LOPA approach. The difference is that the bowtie 
method calculates the frequency of the consequence given all the threats, while the classic LOPA 
calculates the frequency of a specific scenario line, thus the frequency of the consequence given one 
threat (see chapter 2.3 for further background). 
 

 

Figure 323 - Consequence frequency calculation via bowtie method 

 
Consequence frequency of ‘Crash into other vehicle or motionless object’ = 
(Residual event frequency of ‘Intoxicated driving’ + Residual event frequency of ‘Blowout (tire)’) * .5 
* .001 = 7.53E-12 
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Figure 324 - Consequence frequency calculation via Classic LOPA: part 1 

 
Consequence frequency of ‘Crash into other vehicle or motionless object’ caused by ‘Intoxicated 
driving’ =  
Residual event frequency of ‘Intoxicated driving’ * .5 (PFD) * .001 (PFD) = 3E-14 
 

 

Figure 325 - Consequence frequency calculation via Classic LOPA: part 2 

 
Consequence frequency of ‘Crash into other vehicle or motionless object’ caused by ‘Intoxicated 
driving’ =  
Residual event frequency of ‘blowout (tire)’ * .5 (PFD) * .001 (PFD) = 7.5E-12 

2 6 . 1 3   S T A N D A R D  R E P O R T S  

The two reports ‘BowTie Method Overall’ and ‘LOPA scenario overview and segments (BowTie 
method) per Hazard’ follow the calculation of the consequence frequency via the bowtie method. 
These reports include the top event frequency and the top event target frequency. 
 
The report ‘BowTie Method Overall’ is an Excel report in which each bowtie is concisely described 
per Excel sheet. The report ‘LOPA scenario overview and segments (BowTie method) per Hazard’ is a 
report in which parts of the bowtie are described separately. Each threat to top event is described 
and the top event to each consequence. The descriptions include a diagram depicting the part of the 
bowtie being described.  

2 6 . 1 4   C L A S S I C  L O P A  R E P O R T S  

The three reports ‘LOPA Classic Scenario Analysis’, ‘LOPA classic summary with related open Actions’ 
and ‘LOPA Riskassessment summary sheet, opens in XL’ show the calculations per line (one threat to 
one consequence). Please be aware that if you use these reports, you should adjust the target 
frequency to be the frequency for a threat leading to the consequence and not for the occurrence of 
the consequence. For example if you state for a specific consequence that it may only occur at a 
frequency of .001, and you have two threats, you can pick a target frequency of .0005 for the first 
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line and thereby also a target frequency of .0005 for the second line, so the total frequency of both 
lines is .001. 
 
The Classic LOPA report only works when there are consequences in the bowtie diagram. If you have 
a bowtie which has a left side only, you can use the standard reports to get the classic LOPA 
approach, by looking at the current top event frequency of each threat.  

2 6 . 1 5  C L A S S I C  L O P A  C A S E  F I L E  O V E R V I E W  

To view the Realtime Lopa results and gaps of all classic 
scenarios within a Case File open the “Lopa classic scenario 
overview”. You can open this overview window by going to 
the menu view -> windows -> case overview, or by clicking 
on the case overview toolbar button on the main 
application toolbar. 
 
 
 
 
 
 
 
 
 

2 6 . 1 6  L E G A C Y  P L U G  I N  D A T A  C O N V E R S I O N  

As of BowTieXP 9.4, the legacy LOPA plugin will not load and work anymore, only the internal module 
that uses native field properties instead of the plugins’ “user data fields”. Note that all LOPA reports 
and overviews take their data from the new fields rather than form the legacy data. BowTieXP 9.4 
supports converting the legacy filled in data to the new situation as follows: 
 

- Detect whether the Case File contains legacy plugin data and if so: 
o Copy all legacy input data to corresponding new fields 
o Optionally delete all legacy user data and key definitions 
o Perform a LOPA re-calculation 
o Adapt/add the legacy display profiles 

 
This conversion process must be manually performed from the menu Tools -> Lopa legacy data 
conversion… 
The menu-item will only be there when there’s actually any LOPA legacy data present in the current 
open Case File. 
 

 

Figure 326 Data conversion menu item 
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Figure 327 Conversion dialog 

 
Sometimes parts of the Case File might be marked as “read only” (e.g. hazards), This will prevent the 
read only entity from being converted. Also, when there’s read only data present the old legacy user 
data fields cannot be deleted. 
 
Undo 
When not satisfied with the conversion results, it is possibly to “Undo” the entire conversion this by 
pressing CTL+Z. 
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27  
INTRODUCING BOWTIEXL 

This chapter introduces BowTieXL and discusses the general architecture. 

2 7 . 1  I N T R O D U C T I O N  

To meet customer demand of having the possibility to create quantitative and semi-quantitative 
analyses, built on the bowtie model, BowTieXL has been developed. 
 
BowTieXL introduces a Microsoft Excel compatible spreadsheet into BowTieXP, which exposes the 
majority of the information in the Case File as tabular data in this spreadsheet. This allows you to use 
that data to do spreadsheet calculations based on that data, and feed the results back into your 
bowtie model. 
 

 

Figure 328 - Screenshot of BowTieXL 

 
Apart from being able to do calculations based on the bowtie model data, you can also use BowTieXL 
to: 

• Store reference information in spreadsheets, which are stored in the Case File, 

• Add notes and calculations which serve as underpinning of the analysis in the Case File, 

• Add general reference information into the Case File, 

• Use the tabular representation of the bowtie model data to quickly edit data in bulk, 

• Use Excel formulas to create custom aggregated displays of data on the diagram, 

• And much more… 
 

Note: If you intend to use BowTieXL in combination with BowTieServer, please be aware that BowTieServer does 
not store the spreadsheets but does store user data. BowTieServer also does not recalculate any formula. Please 
contact CGE Risk support for details on what this means for your specific case. 
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2 7 . 2  A S S U M E D  K N O W L E D G E  

This chapter assumes the reader has a basic knowledge of working with Microsoft Excel. The 
following topics are assumed to be known: 
 

• Basic formulas, working with single cells and ranges  
 =A1+B2 
 =SUM(A1:A5) 

• Absolute and relative cell references  
 A1, $A1, $A$1 and Sheetname!A1 
 what the $ modifier does and how Excel treats it when copying your formulas 

• Named ranges 

• The Excel IF function 
 
It also helps if you are already familiar with: 

• Hiding and unhiding sheets 

• Sheet and cell protection 

2 7 . 3  D I S P L A Y I N G  T H E  S P R E A D S H E E T  

To view the spreadsheet, select View → Windows → Spreadsheets from the menu. The spreadsheets 
will be displayed. 

 

Figure 329 - How to display the spreadsheets 

 
You can also bring them up using the keyboard combination of Control+Shift+X. 
 

 

Figure 330 - The spreadsheets 
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This spreadsheet should be familiar - it is Microsoft Excel compatible in most regards - most keyboard 
shortcuts are there, the mouse actions are the same, formulas are identical. The formula bar and cell 
reference bar work the same. 
 
Some of the toolbar buttons will also be familiar, but some will not. We will describe them here. 
 

Button Function 

 and  Disable and enable entire spreadsheet - this is used to speed up BowTieXP if 
the spreadsheet is not needed. 

 
 

Save the built-in workbook as an xls or xlsx file. 

 Save and open the built-in workbook in Microsoft Excel. 
 

 Open and replace the built-in workbook.  
 

 Add or remove escalation factors from spreadsheet. 
 

 Add a new sheet. 
 

 Delete the current sheet. 
 

 Rename the current sheet. 
 

 Move sheet left or right 
 

Button Function 

  Print 
 

  Print Preview 
 

  Cut 
 

  Copy 
 

  Paste 
 

  Sort Ascending 
 

  Sort Descending 
 

 100% Zoom 
 

  Show Managed Sheets 
 

  Refresh 
 

Button Function 

 Calibri Font 
 

 11 Font Size 
 

  Bold 
 

  Italic 
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  Underline 
 

  Align left 
 

  Align center 
 

  Align right 
 

  Borders 
 

  Font color 
 

  Background color 
 

  Set hex color definition 
  
Note that the number of options is much smaller than in Microsoft Excel - BowTieXP only offers a 
basic set of editing functions. 
 
We recommend exporting the sheet to Excel and editing it from there if you are working on a big 
complicated spreadsheet. You can do this with these two buttons: 
 

   Saves the built-in spreadsheet to disk under a name of your choosing and open it in Excel. 
 

 Replace the built-in spreadsheet with a file on disk (usually the one you exported and edited 
in Excel). 
 
When saving the sheet to disk, note that all the managed sheets (see below) containing almost ALL 
data in your entire BowTieXP btf Case File is present in those sheets!  
 
This data is not immediately visible as the sheets are hidden and protected by default, to prevent you 
accidentally editing them and cluttering up your display with all these sheets. 

2 7 . 4  T A B U L A R  R E P R E S E N T A T I O N  O F  C A S E  F I L E  D A T A  

By default, all you see when displaying the spreadsheets is a single empty sheet. All the Case File data 

is hidden. To show it, you need to press the following toolbar button: . A drop down will appear 
which allows you to show and hide the sheets managed by BowTieXP: 
 

 

Figure 331 - Displaying spreadsheets 
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Clicking a checkmark will display the corresponding sheet. Note that your sheets, the so-called user 
sheets are always visible.  
 

Note: Some information is currently unavailable as tabular data but might be added in the future. If you are missing 
data, please contact support@cgerisk.com. 

 
Let’s open the test Case File and unhide the effectiveness sheet: 
 

 

Figure 332 - Tabular representation of effectiveness values 

 
Please note that BowTieXL controls these sheets - you cannot modify them, except for the light-
yellow cells. Editing these will actually change the definition of the item, and you will see the item 
update where it is visible, such as in the Tree view or the diagram. 
  

Color Meaning 

Yellow Heading 
Gray Not editable 
Pale Yellow Editable 
Orange Not yet editable, will be implemented in a future version 

 
Let us look at the threats spreadsheet, in the threat diagram sheets: 
 

 

Figure 333 - Tabular representation of threats 

 
Please see how the parent hazard is filled in: Those cells contain the sheet and cell reference of 
where to find the parent hazard of each threat.  
 
You can see the parent hazard for the first threat is "Hazard!$B$2". If we look at the hazard sheet: 
 

mailto:support@cgerisk.com
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Figure 334 - Part of the hazards sheet 

 
We see that "Hazard!$B$2" refers to 5.4.4.1, "Heating chemicals in the Catalyser Heater". How we 
can use these sheet and cell references in calculations, we will show later on. 

2 7 . 5  E D I T I N G  V I A  T H E  S P R E A D S H E E T  

Editing items is as easy as modifying cells in Excel. You can copy, paste, type, and do any of the 
normal cell modifications you can do in Excel, except now you are directly editing your bowtie data. 
 
Bulk adding of data from external data sources such as e.g. Excel is a breeze - simply copy and paste. 
 
Note that you cannot remove or add items to a sheet directly - you cannot add and delete rows. 
There is a simple workaround for that: add a whole bunch of items in the Tree view by using copy 
and paste, then paste over those in the spreadsheet, and delete the excess items. 

2 7 . 6  U S E R  D E F I N E D  D A T A  

In order to leverage the usefulness of the bowtie model data, BowTieXL introduces the addition of 
user-defined data fields to all objects in the Case File. For example, we can add numerical frequency 
fields to barrier effectiveness, allowing us to calculate with this value via barriers.  
 
Custom data is defined per object type. If we define a field called 'Frequency' on any effectiveness 
value, that field is immediately available on all effectiveness values.  
 
Adding custom data is done by means of the editor. It now has a tab, called 'User Data", which allows 
us to add, edit and delete these extra fields. 

 

Figure 335 - User data editor 

 
The "Add Key" button allows us to define an extra field on a type. Once we define a new key name on 
a type, e.g. barriers, each barrier will now have this field.  
 
The delete key removes a field. Note that this will remove whatever is filled in on any object of the 
same type! 
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The rename key allows you to change a key name. 
The Key default value allows you to add a standard value that is added to each new item. This is 
useful if each new element should automatically get certain formulas. 
 
Another way of looking at what we are doing when we add user data, is that we are adding columns 
to the spreadsheet. Look at the effectiveness spreadsheet: 
 

 

Figure 336 - Tabular representation of effectiveness values with custom data 

 
As you can see in the user data editor, we have defined a key called "Frequency" on effectiveness 
values, and you see that column in the sheet all the way to the right. 

2 7 . 7  S H O W I N G  U S E R  D A T A  O N  T H E  D I A G R A M  

User data fields can be shown on the diagram by selecting the field to show in the 
Diagram→Diagram Options. Here you can choose which user data field to show on which type. This 
is limited to the elements in the bowtie. For instance, user data that is added to an effectiveness 
value cannot be displayed on the bowtie, whereas user data on a barrier can be displayed. 

2 7 . 8  F O R M U L A S  I N  U S E R  D A T A  

When showing user data on the diagram, and if a user data value contains a formula (starts with an 
'=' equals sign), the formula is interpreted and the results are displayed. This allows you to bring 
calculation results from the spreadsheets back into the bowtie diagram. 
 
The formulas are evaluated in context of the managed sheet for the type - formulas on barriers are 
evaluated in the BowTieControl sheet, formulas on threats on the Threat sheet. 
 
In the next chapter, we will take a deeper look into what we can use this for. 

2 7 . 9  C O L O R I N G  U S I N G  U S E R  D A T A  

If a user data contains a html color code, it can be applied to the shape it is on. Html colors are color 
definitions look as follows: 
 
 #rrggbb 
 
Where rr is the amount of red, gg is the amount of green, and bb is the amount of blue. These 
numbers are in hexadecimal. 
 
If you are not familiar with hexadecimal notation, you can use the built-in color picker to choose and 
apply a color: 
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Figure 337 - Selecting an html color code for a cell 

 
After selection, the color is applied, and the code is put into the cell. 
 
There are many references on the internet about html color codes, such as http://html-color-
codes.info/.  
 
In the next chapter, we will show how to use this in depth, such as creating color lookup tables. 
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28  
CALCULATING WITH BOWTIEXL 

Now that we have a basic understanding of what BowTieXL comprises, we delve into best practices 

for calculating with the bowtie data. 

2 8 . 1  I N T R O D U C T I O N  

Calculating with BowTieXL is not hard if you have a good working knowledge of Microsoft Excel 
formulas. 
 
Assuming you are familiar with concepts such as cell references, relative (e.g. D14) and absolute (e.g. 
$D$14), summing and adding of ranges, and the IF function you should have little trouble getting 
started quickly. 
 
One important concept we will work a lot with is the concept of indirect cell references, which we 
will explain next. 
 

Note: If you intend to use BowTieXL in combination with BowTieServer, please be aware that BowTieServer does 
not store the spreadsheets but does store user data. BowTieServer also does not recalculate any formula. Please 
contact CGE Risk support for details on what this means for your specific case. 

2 8 . 2  I N D I R E C T  C E L L  R E F E R E N C E S  

In order to do calculations in Excel, it is preferable to have all the information we need in a single 
table. However, the information in BowTieXL is spread out over many tables in many sheets, linked 
together by means of cell references. 
 
Look at the barriers sheet: 
 

 

Figure 338 - Barriers sheet (some columns left out) 

 
In order to do meaningful calculations, we need to bring information together. We need to be able to 
use "Effectiveness!$B$4" cell references, and bring properties of that effectiveness value into our 
own worksheet. 
 
Conceptually, what we want to do is as follows: 
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Figure 339 - Following cell references to the wanted information 

 
Step 1, blue arrow: From a cell reference in our worksheet, we need to go to the barriers sheet to 
the specified cell, and get the name of the barrier. 
 
Step 2, green arrow: We need to get a cell from a different column in the barriers sheet, to bring the 
barrier's effectiveness into our sheet. 
 
Step 3, red arrow: We need to go to the effectiveness sheet, and bring the effectiveness code into 
our sheet. 
 
Step 4, turquoise arrow: We need to get a cell from a different column in the effectiveness sheet, 
and bring it into our sheet. 
 
Now we should end up with our sheet looking like this: 
 

 

Figure 340 - Sheet with reference info brought in 

 
Column B is the cell reference to the wanted barrier. 
Column C is the result of step 1, the blue arrow: the barrier name. 
Column D is the result of step 2, the green arrow: the barrier's effectiveness cell reference. 
Column E is the result of step 3, the red arrow: the effectiveness code. 
Column F is the result of step 4, the turquoise arrow: the effectiveness frequency. 
 
With this sheet, it is straightforward to e.g. calculate the average effectiveness frequency. 
 
Now onto the formulas on how to accomplish this: Microsoft Excel, and therefore BowTieXL, offers a 
couple of functions designed to do exactly what we set out in this section. 
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2 8 . 2 . 1  T h e  I N D I R E C T  f u n c t i o n  
The INDIRECT function allows us to treat a textual cell reference as an actual cell reference.  
 
Look at this demonstration: 
 

 

Figure 341 - Workings of the INDIRECT function 

 
In Cell B2, we have the location of interest, in this case the text value D4. By means of the INDIRECT 
function, we can get at the value in the cell we specified - we turn the text value into a reference.  
 
This is can be seen in cell B3. The formula in B3 is =INDIRECT(B2), and the value displayed is "Mike", 
the value present in cell D4. 
 
This works for all possible cell references, such as: 

• just a cell coordinate, e.g. B3 

• sheet + cell reference, e.g. Sheet2!D24 

• filename + sheet + cell reference, e.g. [D:\test.xlsx]Sheet1!E5 
 
Note that for the last reference to work, the target file has to be open, or you will get a #REF error. 

 
2 8 . 2 . 2  T h e  O F F S E T  f u n c t i o n  
Getting the contents of the cell we specified is nice, but gets us only half-way - we would only get the 
indicated column, so we need a way to shift to the right from the reference. The OFFSET function 
comes to the rescue. 
 
The offset function allows us to step away from a reference in either direction. Usually we want to 
move to the right to get at the different properties of e.g. an effectiveness value. 
 

 

Figure 342 - Workings of the OFFSET function 

 
As you can see in the above screenshot, we stepped one column to the right to get the age of the 
person we selected. 

2 8 . 3  S E T T I N G  U P  T H E  T E S T  C A S E  F I L E  F O R  A N  E X A M P L E  

As an example, we will add a value called 'Frequency' to each effectiveness value, and calculate the 
average barrier effectiveness frequency for each threat. 
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Note: This sample does not carry any real-world meaning, but only serves as an example on how to do calculations. 

 
1. Open the test Case File (File → Open test case). 
2. Select the 'Very Poor' effectiveness value.  
3. Select the User Data tab in the editor. 
4. Click Add Key. Enter 'Frequency' as the key name. Press Enter. 
5. Double click the newly added line to edit it. Enter '2' as the value. Press enter to commit. 
6. Edit the rest of the user values and apply the following values: 

 
Effectiveness Frequency 

Very Poor 2 
Poor 4 
Good 6 
Very Good 8 

 
 
If you go to the spreadsheets, show the diagram reference sheets, and look at the effectiveness 
sheet it should look as follows: 
 

 

Figure 343 - Desired effectiveness frequencies 

 
The test Case File is now set up for the examples in this chapter. 

2 8 . 4  O N E - O F F  C A L C U L A T I O N S  

The easiest method of doing calculations is by copying and pasting or referencing the relevant data 
from the different sheets, and calculating what is needed.  
 
As an example, we will calculate the average effectiveness frequency of the barriers of the first 
threat in the test Case File we prepared earlier. 
 
By peeking at the barriers worksheet, we see that there are four barriers on the first threat, and we 
are interested in their names and effectiveness values, which reside in columns C and J. Therefore, 
we reference those: 
 

Note: Be sure to notice the formula displayed in the top of the screenshots. 

 

 

Figure 344 - Effectiveness values brought in 
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In the next column, we want to fetch the frequency field we defined for each effectiveness value, 
and for that we need to INDIRECT the cell reference and OFFSET it by 7 columns (counted by hand in 
the effectiveness sheet): 
 

 

Figure 345 - Effectiveness frequency brought in 

 
Take note of the formula of C2, which you can see, in the formula bar, just as we discussed. 
 
Now we can calculate the average, and some nice colors and borders, and end up with: 
 

 

Figure 346 - Average effectiveness frequency calculated 

 

2 8 . 5  B U I L D I N G  D Y N A M I C  S H E E T S  

In the previous sections, we discussed the basics of building a sheet. They were easy to set up, but 
also fragile because changes in the sheets can break your formulas. For example, with different 
versions of BowTieXP, some columns might shift, or users can reorder user data field columns 
themselves. If you do not anticipate this, it can mean broken formulas or worse, undetected 
references to the wrong data. To avoid this, we will dive into making sheets dynamic so they are less 
fragile. 

 
2 8 . 5 . 1  T h e  M A T C H  f u n c t i o n  t o  f i n d  c o l u m n s  
One of the main reasons why sheets break is shifting columns. To avoid this, we can find column by 
name instead of by direct reference. 
 
Let us assume we want to find the effectiveness value that belongs to a barrier. 
 

1. OFFSET NUMBERS: we create a table where we list the horizontal coordinate for each 
column. We do this by using MATCH to find a User data key in a range using three columns: 
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Figure 347 – Match function usage example 

 
The first two columns are put in manually. In the third column, we use this formula:  
 

=MATCH(A2,INDIRECT(B2),0) 
 
What this formula does is look for A2 in a range. A2 is Effectiveness in this case.  
We get the range by using INDIRECT on B2. This translates the text that is in B2 into an actual 
range. 
The last addition is 0, which makes sure that MATCH searches in the correct way (search for 
match_type to find out more). 
 
This makes sure that even if the Effectiveness column shifts, all of the formulas that 
reference Effectiveness shift with it. 
 

2. Now that we have the dynamic offset, we can build a formula to create a reference that will 
keep working: 
 

 

Figure 348 – Create dynamic reference 

 
In the rest of the spreadsheet, column E just lists the barriers for easy reference using 
=BowTieControl!C2 
In column F we manually put a reference to the first column of the BowTieControl sheet. 
Column G looks up the effectiveness value reference for each barrier using: 
 

=OFFSET(INDIRECT(F2),0,$C$2-1) 
 
We will break it down into steps.  

• First, OFFSET is used to move to the Effectiveness column and return the Effectiveness 
reference.  

• To do this, we first use INDIRECT(F2) to start us of in the first column of the BowTieControl 
sheet.  

• Then we do not want a vertical offset, so the second parameter is 0.  

• The third is our dynamic horizontal offset $C$2. The dollar signs are there because we do 
not want the reference to that cell to change when we copy it down.  

• Lastly, you see we decrease the reference by 1. This is because if the effectiveness is in 
column 12, and we offset it by 12 starting from the first column, we will actually end up in 
column 13. Therefore, we decrease it by one to make sure everything is correct. 

 
There were a couple of things shown in this section, but remember that the most important point is 
how to make an offset that will keep working even when columns change position. 
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2 8 . 5 . 2  C a l c u l a t i n g  u s i n g  t h e  c u r r e n t  r o w  i n  u s e r  d a t a  
Because user data can be moved around due to reordering, inserting and deleting of barriers and 
other items, you cannot just reference B2, B3, B4, as those will no longer point to the current row. 
 
To fix this, there is a simple trick: We can return the current row number using the ROW() function. 
Using that we can build an address which we can use with INDIRECT(). 
 
For example, on the Threats sheet we can use either of the following: 
 
="Threat!"&ADDRESS(ROW(), 2) returns e.g. Threat!$B$2 
="Threat!$B$"&ROW()   returns the same :) 

 
2 8 . 5 . 3  D e t e c t i n g  c h a n g e  i n  a  c o l u m n  o f  v a l u e s  
It can be valuable to do a calculation across all the barriers on a threat or consequence. This section 
will explain how to do that. 
 
First, we make a list with all the barriers and include a column with threat and consequence 
references. Then we have a column with, in this case, a barrier criticality value for each barrier (we 
will not go into how to do this here, look at the other sections for more details). The magic happens 
in the last two columns. 
 

 

Figure 349 – Detect change using count formulas (1/2) 

 
In column E, we want to have a counter that increases until the next threat or consequence line. 
Essentially, the formula says: if the current cell is equal to the previous cell, increment the count by 
1, in any other case reset it to 1: 
 

=IF(AND(B2=B1, C2=C1),E1+1,1) 
 
The AND statement is to make it work for both the threat and consequence lines. If either a threat or 
consequence is not the same, we reset the counter. 
 
In column F, we use that counter to tell us when a new line starts, and how many barriers were on 
that line. Column F essentially says: if the next cell is larger, do nothing, in any other case, perform 
some action. This will result in the cell remaining empty as long as the counter is increasing. 
However, as soon as the counter is reset, we perform some action. In this example, we do a sum of 
all the criticality values. 
In F4, we see the formula actually displaying something:  
 

=IF(E3>E2," ",SUM(OFFSET(D2,0,0,-E2))) 
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The logic goes like this: 
 
If E5 is greater than E4: 
 Do nothing. 
Else: 
 Sum a range. 
 
We get this range by using OFFSET. In this case, OFFSET starts at D4 and does not change its start 
position (hence, the two zero parameters). The next parameter indicates how high the selection 
needs to be, since we can specify multiple cells to be selected by OFFSET. In this case, we say -E4, 
because we want to go up by the number of barriers on the line, which can be found in E4. 
 

 

Figure 350 – Detect change using count formulas (2/2) 

 

2 8 . 5 . 4  R e m o v i n g  # N / A  v a l u e s  
Sometimes values have not been filled in, which can cause formulas to give a #N/A value. This is ugly 
and likely not what we want to show. We can catch it by including another column that tests for 
#N/A values. 
 

 

Figure 351 – Spreadsheet where #N/A values are shown 

 
In this example, we have column A with results, but some of the results result in an error #N/A. To 
deal with this gracefully, we add another column B called Tested result, where we put the following 
formula: 

=IF(ISERROR(A2),"No data",A2) 
 
This tests if A2 contains an error, and if that is the case, it will put “No data” in the cell. If the cell 
does not contain an error, it will just put in the value for A2. 

 
2 8 . 5 . 5  C o m p a c t i n g  a  c o l u m n  o f  v a l u e s  
After following section 0 where we calculate across all the barriers on a line, we get a list of values 
with spaces in between them. This is a pattern we see a lot, and users often want to remove the 
whitespace and get a single list of values. This section describes a way to compact a list of values with 
blank cells. See this example: 
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Figure 352 – Spreadsheet where blank cells are shown 

 
This sheet calculated whether each threat and consequence was sufficiently controlled. This leads to 
columns I, J and K. There is a lot of whitespace, so we want to compact it. The core formula is 
VLOOKUP in columns M and O. The formula is quite straightforward: 
 

=VLOOKUP(Threat!B2,I:K,3,FALSE) 
 

We search for the first threat name (Threat!B2) in columns I to K (I:K), and return the value in the 
third column. FALSE indicates that it should look for an exact match. 

2 8 . 6  E X C E L  R E F E R E N C E  

These are some commonly used functions that we use in BowTieXL. Descriptions taken from 
techonthenet.com. 
 

Formula Description 

IF( condition, [value_if_true], [value_if_false] ) Normal If statement. Can be used for all 
kinds of conditional statements. 

ISERROR( value ) Returns True if the value is an error value. 

ISNUMBER Returns True if the value is a number 

INDIRECT( string_reference, [ref_style]) Returns the reference to a cell based on its 
string representation. 

ADDRESS( row, column, [ref_type], [ref_style], 
[sheet_name] ) 

Returns a text representation of a cell 
address. 

OFFSET( range, rows, columns, [height], [width] ) Returns a reference to a range that is offset 
a number of rows and columns from 
another range or cell. 

ROW( [reference] ) Returns the row number of a cell reference. 

COLUMN( [reference] ) Returns the column number of a cell 
reference. 

VLOOKUP( value, table_array, index_number, 
[not_exact_match] ) 

Performs a vertical lookup by searching for a 
value in the left-most column of table_array 
and returning the value in the same row in 
the index_number position. 
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MATCH( value, array, [match_type] ) Searches for a value in an array and returns 
the relative position of that item. 

TEXT( value, format ) Returns a value converted to text with a 
specified format. 

CONCATENATE( text1, text2, ... text_n ) Allows you to join 2 or more strings 
together. 

2 8 . 7  F A Q S  

Q: Excel's auto fit row height is not working. 
Q: Excel's wrap text not working. 
A: Ensure the cell's formatting is set to "general", not to "text". 
IncidentXP and BowTieXP together 
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29  
INCIDENTXP AND BOWTIEXP TOGETHER 

2 9 . 1  I N T R O D U C T I O N  

After an incident of large enough impact, incident investigation and analysis is done. These 
investigations lead to recommendations on how to adjust our management system so they will be 
prevented in the future.  
 

 
 
Similar to audits, incident analysis is a valuable way of gaining insight into barrier 
quality/effectiveness. It is a lagging indicator, but a useful one nonetheless. Information about real 
world failure of barriers is difficult to gain and very valuable. 
 
By relating the barriers in incident analysis with the barriers in the proactive risk assessments, we are 
offering another tool for helping close the Deming circle. After defining the barriers in your safety 
management system (i.e. the plan stage) and implementing them (i.e. the do stage), a check is 
required to ensure the quality of the barriers. Relying on barriers that are in reality inadequate can 
be dangerous. In addition, a thorough examination of the barriers during the check stage facilitates 
the generation of relevant recommendations later on (i.e. act stage).  
 
The coupling of incident analysis with risk analysis also works in the other direction. By having the 
proactive risk assessments on hand during the investigation, identification of the involved barriers is 
made simpler and recommendations will probably be more compatible with the safety management 
system, allowing quicker and more effective adoption. 
 

Note: Please refer to the IncidentXP software manual for more details on how to enter incidents into the software. 
Please also refer to our theory guide on more details on how incident analysis, but also audits tie into bowties. 

 
In practice, this translates to the following software options: 

1. Relating of bowtie barriers to incident barriers. 
2. Allowing you to visualize incidents on bowtie diagrams (including some reports). 
3. Allowing re-use of bowtie barriers and events on your incident analysis diagrams. 
4. Offering Case File overviews to explore the relation between incidents and bowties. 
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2 9 . 2  R E L A T I N G  O F  B O W T I E  B A R R I E R S  W I T H  I N C I D E N T  

B A R R I E R S   

To relate barriers between bowties and incident diagrams, you must first ensure you have both in 
the same file. Use the import function or the Scrap book to get all diagrams into a single file. 
 
The next step is to position the two diagrams we are going to relate side by side, or on top of each 
other.  
 

Note: a large monitor will help a lot on this process. 

 
We open both diagrams, and then grab the tab and drag the window to the right position. 
Reorganizing the windows is described in chapter 6.7, How to configure your main window on page 
56. 
 
See the screenshots below for two ways to organize your windows: 
 

 

Figure 353 - Incident diagram and bowtie diagram side-by-side 

 

 

Figure 354 - Incident diagram and bowtie diagram on top of each other 
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Once we have this window arrangement, associating the barriers is done by means of drag and drop. 
Simply drag the barrier from the bowtie diagram onto the barrier you want to relate it to on the 
incident diagram and the association is made. 
 

Note: if the barrier you are trying to drag starts repositioning, try holding down the ALT key.  

 
The ALT key switches from dragging to reorder to dragging to drag an item out of the diagram. 
 

 

Figure 355 - Linking bowtie barriers with incident barriers 

 
If you need to remove an association between two barriers, double click the incident barrier. On the 
barriers tab you can remove the offending bowtie barrier: 
 

 

Figure 356 - Linking incident barriers to bowtie barriers 

 
Note: if you used bowtie elements while building your incident diagram, associations will already be present. When 
you copy and paste a barrier from a bowtie into an incident, BowTieXP automatically associates them for you. 
Likewise, if using the “from bowtie” drop down button when building “templated” incident diagrams. 
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2 9 . 3   A D D  I N C I D E N T  E V E N T  F R O M  B O W T I E  

An incident could have the same sequence of events that you have identified in the bowtie. In this 
case, you might want to select a threat, the top event and a consequence from the bowtie into your 
incident analysis diagram. You can do this by creating an incident analysis diagram via Case File → 
incidents → new incident and fill in the pop-up screen. Once you have the incident analysis screen, 
you can select a threat, top event, or consequence using the icon ‘Add event from bowtie’ icon. A list 
of all bowties within the same file appears. If you select, for example the top event, it appears into 
your screen.  
 

 

Figure 357 - Add incident from bowtie 

 
When an item from the bowtie is in your screen, you can continue from there by clicking on the 
bowtie item. The barriers and escalation factor barriers in between the threat-top event and top 
event –consequence will automatically appear in the incident diagram. If you do not want the 
escalation factors in your diagram, you can turn this off by deselecting Tools → Options → Behavior 
→ Include EF barriers when creating edges from bowtie template. 
 

 

Figure 358 Selecting events from bowtie 

2 9 . 4   V I S U A L I Z I N G  I N C I D E N T S  O N  B O W T I E  D I A G R A M S  

Once the links between the bowtie barriers and the incident barriers have been made, we can show 
the barriers failure statistics and failure details in the bowtie diagram. Failure details include the 
barrier failure state, the Tripod causation paths and the BSCAT causations. These diagrams are 
known as incident bowties. 
 
To enable this view, you select the incident filter from the filters drop down on the bowtie diagram 
toolbar: 
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Figure 359 - Enabling Incident Filter 

 
Once selected, the incident filter toolbar will be displayed, allowing you to fine-tune what will be 
shown. You can choose to show data from all incidents or from a specific incident. 
 
Here is a sample of a Tripod Beta diagram linked onto a bowtie diagram: 
 
 

 

Figure 360 - An incident bowtie with Tripod causation paths 

 
Here is a sample diagram showing a BSCAT incident on a bowtie diagram: 
 

 

Figure 361 - An incident bowtie with BSCAT causations 

 
You can choose which incident diagram you would like to display. 
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Figure 362 - Incident filter (incident selection) 

 
You can choose to show all bowtie elements, or limit the bowtie to only the paths involved in the 
incident(s). This is arranged in the filter strength: 
 

 

Figure 363 - Filter strength 

 
You can change various general settings, applicable to all kinds of incident data: 

• Whether to show the number of incidents the barrier was linked to. 

• Whether to show the percentage failure of the linked barriers. 

• Whether to show the number of incident barriers the barrier was linked to. As incidents tend 
to be more specific (where bowties are more general/abstract), it will happen that a single 
bowtie barrier will be linked to multiple incident barriers. This count reflects that. 

• Show the different counts of how (and if) the barrier has failed, such as broken, missing, 
unreliable. 

• Whether to include draft incident diagrams. 
 

 

Figure 364 - Incident filter (general settings) 

 
Some settings are not applicable to all incident diagram types. For example, certain aggregated lists 
are not available in Tripod Beta. 
 
Some settings are only applicable to BSCAT and BFA: 

• Whether or not to show the free text description for failure reasons 

• Whether or not to show the assigned items from the SCAT lists (show links option) 
o If we want to see the actual item, or only the main category (show top level links only) 
o If we want to see the full description, or just the code 



 

©  W O L T E R S  K L U W E R  |  C G E  R i s k  2 0 2 0  
C O N F I D E N T I A L  A N D  P R O P R I E T A R Y  

 

B O W T I E X P  S O F T W A R E  
M A N U A L  

 

P A G E  2 6 9  

 

o If we want to see how often an item was linked in total or not 
 

 

Figure 365 - Incident filter (BSCAT / BFA setting) 

 
Some settings are only applicable to Tripod Beta: 

• Whether to show Tripod Causation paths. 
▪ If we want to see the whole causation path or only the BRF code 

 

 

Figure 366 - Incident filter (Tripod settings) 

 
It is also possible to filter on a specific date/time frame or on an organizational unit. The latter is 
mainly relevant in combination with BowTieServer. For date ranges, a number of presets can be 
selected, or a specific period can be specified using the custom date range setting. 
 
 

 

Figure 367 - date range filter 
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It is also possible to filter incidents results per organizational unit if the incident is linked to an 
organizational unit. For more information on this please see 0 Organizational units grouping.  
 
 

 

Figure 368 - Organizational unit filter 

2 9 . 5   R E - U S I N G  B O W T I E  B A R R I E R S  O N  I N C I D E N T  A N A L Y S I S  

D I A G R A M S  

It is possible to copy a bowtie barrier and paste it into your incident diagram. It will be automatically 
converted for you. At the same time, BowTieXP will make an association between the original bowtie 
barrier and the incident barriers, so you do not have to do that later on manually. 
 
In the same way, if you are creating your incident diagram using either templated BSCAT or 
templated Tripod Beta, you are re-using your bowties. Also in this instance will a link be 
automatically made for you. 

2 9 . 6   I N C I D E N T  G R O U P I N G  I N  T H E  T R E E  V I E W  

The incident diagrams are displayed in the Tree view. The incidents can be sorted per year, quarter 
or month, category, type or tier. 
 
In the Tree view, you can configure the incident categories, types and tiers. You may want to sort 
your incidents according to these categories, types and tiers, which is possible by clicking on the icon 
next to ‘default filtering’.  
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2 9 . 7   C A S E  F I L E  O V E R V I E W  

There is one Case File overview dedicated to how bowties are related to incidents. It is the “bowtie 
linked elements in incidents” overview. It shows how elements between the diagrams are related, 
where they are located and what the various failure states are. 
 

 

Figure 370 - Case File overview (Bowtie linked elements in incidents) 

  

Figure 369 Incident grouping 
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30  
INSTALLATION REFERENCE 

In this chapter, we walk you through the steps to install BowTieXP.  

3 0 . 1  T E C H N I C A L  S P E C I F I C A T I O N S  

BowTieXP is a regular desktop application, which runs on the hardware of the end user. It adheres to 
all Microsoft specifications and only requires domain user rights to be run. Note that a 64 bits 
operating system is required since the software version 10 of BowtieXP. 
 
BowTieXP adheres to all Microsoft specifications and only requires regular user rights to be run - 
important for corporate network environments. 
 
BowTieXP can be provided as an msi installer for deployment with network tools like Microsoft 
Systems Management Server. 
 
BowTieXP stores information in a file-based compressed XML database. It does not require database 
software to be installed. Even large BowTieXP files typically stay under 1 Megabyte of size. Even if 
hundreds of BowTieXP files are stored, storage requirements on a network file share should stay well 
under 1 gigabyte. 
 
Configuration information is stored on disk in the user’s profile, in both the local and the roaming 
part. Some system-wide data is stored in the all users profile (Program Data on Windows 7 and 
above). The registry is used for file extension association and protocol handler association. If 
possible, these are made system wide in HKLM. If access to HKLM is denied, the HKCU hive is used. 
Citrix and Terminal Server environments are supported, but do place constraints on the allowed 
software activation type. 

 
3 0 . 1 . 1  S u p p o r t e d  o p e r a t i n g  s y s t e m s  
BowTieXP can run on Windows 7 and newer. Note that a 64 bits operating system is required since 
the software version 10 of BowtieXP. 

 
3 0 . 1 . 2  O S  p r e r e q u i s i t e s  
BowTieXP requires the .NET framework 4.7 or 4.8. If you run BowTieXP and the .NET framework is 
too old, BowTieXP will tell you so. You can then download and install it: 
 
https://dotnet.microsoft.com/download/dotnet-framework/thank-you/net48-web-installer    
 
Note that Windows 10 Creators Update (1703) and later come with a new enough version of the 
framework already installed out of the box. 

 
3 0 . 1 . 3  H a r d w a r e  r e q u i r e m e n t s  
If your computer meets the Windows recommended system requirements, BowTieXP will work. For 
intensive use, more RAM and CPU speed is recommended. 
 

https://dotnet.microsoft.com/download/dotnet-framework/thank-you/net48-web-installer
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You must have a minimum screen resolution of 1024x768 and a color depth of 16 bits. But 
considering the graphical nature of BowTieXP – the bigger your screen the better. 
 
BowTieXP can interoperate with all Microsoft Word and Excel versions. The supported Visio versions 
are 2000, 2002, XP (2003), 2007, 2010, 2013 and 2016. 
 
If you want to use the (deprecated) SharePoint add-on, there are also requirements on your 
SharePoint server. 

3 0 . 2  T H E  M I C R O S O F T  . N E T  F R A M E W O R K  

BowTieXP requires the .NET framework 4.7 or 4.8. If you run BowTieXP and the .NET framework is 
too old, BowTieXP will tell you so. You can then download and install it: 
 
https://dotnet.microsoft.com/download/dotnet-framework/thank-you/net48-web-installer    
 
Note that Windows 10 Creators Update (1703) and later come with a new enough version of the 
framework already installed out of the box. 

 
3 0 . 2 . 1  I s  t h e  f r a m e w o r k  a l r e a d y  i n s t a l l e d ?  
You can simply install BowTieXP and try to run it. If the framework is missing, you will be notified and 
can install it then. 

 
3 0 . 2 . 2  I n s t a l l  t h e  f r a m e w o r k  f r o m  t h e  M S  d o w n l o a d s  
s i t e  
Browse to: https://dotnet.microsoft.com/download/dotnet-framework/thank-you/net48-web-
installer    
 
Then download and run the installer. Note the above link is for version 4.8 – newer 4.x versions may 
already exist. 

3 0 . 3  I N S T A L L  B O W T I E X P  

Browse to: 
 
http://www.cgerisk.com/downloads/bowtiexp/ 
 
Download and run the BowTieXP installer (.msi). 
 
Click through the wizard using the next button until the installation is finished. Note that you will 
need to check the checkbox to indicate you agree with the end-user license agreement in order to 
continue the wizard. 
 
If you do not want to install BowTieXP through the Microsoft Installer (.msi), you can also choose 
manual installation: 
 

1. Browse the downloads page to find the BowTieXP executable (.exe).  
2. Unzip the zip file you just downloaded. 
3. Copy the executable in any location you want and run BowTieXP from there. 

 

Note: You will need to extract the software from the .zip archive before it will run correctly! If you receive an error 
message, please check to see if you have done this. 

https://dotnet.microsoft.com/download/dotnet-framework/thank-you/net48-web-installer
https://dotnet.microsoft.com/download/dotnet-framework/thank-you/net48-web-installer
https://dotnet.microsoft.com/download/dotnet-framework/thank-you/net48-web-installer
http://www.cgerisk.com/downloads/bowtiexp/
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3 0 . 4   A C T I V A T I N G  T H E  S O F T W A R E  

See section 2.3, Activating BowTieXP, on page 11 on page for instructions on standard host locked 
activation. 
 
See section 30.7, BowTieXP site activation on page 274 for details on mass activation using active 
directory groups. 

3 0 . 5  E U L A  A N D  R E L E A S E  N O T E S  

After activating BowTieXP and starting for the first time, you will have to agree to the end-user 
license agreement. Please read this legally binding document carefully, as you cannot use BowTieXP 
without full agreement. If you agree to the terms and conditions in the license agreement, click the ‘I 
Do Agree’ button to start using BowTieXP. If you do not agree, BowTieXP will exit. 
 
Next, the release notes will be displayed. They contain the latest information about BowTieXP, which 
may have not made it into the official documentation. By selecting HelpRelease Notes they can be 
redisplayed.  

3 0 . 6  F I L E  E X T E N S I O N  R E G I S T R A T I O N  

 

Figure 371 - File association prompt 

 
BowTieXP automatically tries to keep the file association to .btf files in order. If BowTieXP detects 
something wrong with it, you are prompted if you would like to restore it. Note that you can check to 
never be asked again. In that case, BowTieXP remembers your choice and automatically applies it the 
next time. 

3 0 . 7  B O W T I E X P  S I T E  A C T I V A T I O N   

BowTieXP can be configured to activate all members of a global or universal domain user group. This 
is known as site activation.  
 
This has the following advantages: 

1. Only one code for all users – can be installed along with the application by IT. 
2. IT can reassign licenses by add/removing users from the group. 

 
Site activation has the following disadvantages: 

1. Only activates computers/users that are members of the domain. 
2. IT needs to create and maintain the group of licensed users. 

 
The group must be a global or universal security group. Distribution groups cannot be activated.  
 
The site activation process is as follows: 
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Figure 372 - Site activation process 

 
First, choose the user group to activate. BowTieXP creates a site id for this group, which must be sent 
to CGE Risk so they can create an activation code for you. After entering this activation code into 
BowTieXP, it is activated and will run. 
 
Note that the site id can also be retrieved in a different manner, and the codes can be entered in a 
different manner. These alternate methods for site activation are described below the sections that 
show you the process to follow in the user interface – just keep on reading. 
 
Now we proceed with the steps to take using the user interface: 

 
3 0 . 7 . 1  S h o w i n g  s i t e  a c t i v a t i o n  o p t i o n s  
BowTieXP can be configured to activate all members of a global or universal domain user group. This 
is known as site activation. Click the blue link label to show site activation options. 
 

 

Figure 373 - The product activation codes dialog box 

 
If BowTieXP is already activated, the activation dialog box is not shown on startup. You can bring it 
up via the Help menu - click the “product activation codes” option.  

 
3 0 . 7 . 2  C h o o s i n g  a  g r o u p  t o  a c t i v a t e  
The computer administration department must create a dedicated group to hold all the users that 
are licensed to use BowTieXP. By doing this, it is easy to reassign licenses between users. 
 
Choose this group from the drop-down: 
 

 

Figure 374 - Choosing the group to activate 
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N o t e :  i f  y o u  h a v e  a  v e r y  l a r g e  n u m b e r  o f  g r o u p s ,  t h i s  c a n  
t a k e  v e r y  l o n g .  I n  t h a t  c a s e ,  c l o s e  B o w T i e X P ,  a n d  y o u  c a n  
g e t  t h e  i n f o r m a t i o n  w h i c h  C G E  R i s k  r e q u i r e s ,  v i a  t h e  
c o m m a n d  l i n e .  S e e  s e c t i o n  3 0 . 7 . 5 ,   
Getting a site id  on page 276 below. 

 
3 0 . 7 . 3  S e n d i n g  t h e  s i t e  i d  t o  C G E  R i s k  
After selecting the user group to activate, the site id for the selected group is shown. 
 

 

Figure 375 - The group to activate has been chosen 

 
The “selected site id” should be sent to CGE Risk so an activation code can be generated.  
 
Note that if your group is not listed, it is probably not of the correct type. It must a global or universal 
security group. 

 
3 0 . 7 . 4  E n t e r i n g  t h e  a c t i v a t i o n  c o d e  
After receiving the activation code, it can be entered into the dialog to activate BowTieXP. 
 

 

Figure 376 - BowTieXP with a valid site activation code 

 
Note that you do not need to select the group again – just entering code is enough. 
 
Note also that you must be a member of the intended group for this to function; otherwise, access to 
the software will be denied and the newly entered activation code will not be saved. 
 
Third, note that after changing group memberships, users will need to log off and on again for these 
membership changes to take effect. Changes made on the AD server can take several hours to take 
effect. This is because active directory servers synchronize on a schedule of two hours by default. 

 
3 0 . 7 . 5  G e t t i n g  a  s i t e  i d  u s i n g  t h e  c o m m a n d  l i n e  
Sometimes the user interface can be a bit of a bothersome manner to retrieve the site id and enter 
the activation code. This will especially be the case when a very large number of groups exist in your 
network. In this case, it can be easier to use a different way to retrieve the necessary information. 
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Internally, BowTieXP uses the SID (Security Identifier) of the group you want to activate to lock itself 
to. Using the GUI, all that is happening is you are presented with a nice manner in which to choose a 
group and send us the SID. 
 
Another way to give CGE Risk the group security identifier to generate an activation code for is by 
means of the command line, by using the wmic tool, which is built into Windows: 
 

 

Figure 377 - Command prompt 

 
Open a command prompt and issue the following command: 
 

wmic group where name='BowTieXPUsers' get sid 
 
Where you replace BowTieXPUsers with your own group name. Please mail the output to CGE Risk. 

 
3 0 . 7 . 6  D i s t r i b u t i n g  y o u r  a c t i v a t i o n  c o d e  
Instead of having every activated user, enter the activation code, you can also deploy it with the 
software.  
To this end, CGE Risk will send you a file called “activation.dat” which contains your license code. 
 
If this file is placed next to the bowtie.exe file, it will be read automatically when the software starts. 
 
Note that if you deploy your code via a .dat file next to the exe, the activation code dialog box will 
remain empty. You are completely bypassing that dialog box (it looks at a different place for the 
code).   
 
If your code does not work when placed next to the exe, you can get diagnostic output by manually 
entering it into the dialog box. Only then will you see any errors. 
 

N o t e :  P l e a s e  r e a d  c h a p t e r  3 0 . 7 . 8 ,   
How to manage multiple editions of BowTieXP on page 278 about managing multiple codes and the 
behavior BowTieXP has when multiple codes are encountered. 

 
3 0 . 7 . 7  a c t i v a t i o n . d a t  f i l e  f o r m a t  
The .dat file we send you will probably be an XML file. Inside the <ActivationCode> tag is the actual 
code. 
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For convenience at large site installations, we have added another file format for activation.dat files 
which allows multiple codes per file and allows you to add comments as well. 
 
Here is an example file: 
 
; BowTieXP activation codes for our site: 

12345678 ABCDEFGH  ; Advanced BowTieXP License for DOMAIN 

12345678 ABCDEFGH  ‘ Another license 

 

; Now some licenses: 

 

12345678 ABCDEFGH 

 
Each line can be blank or contain an activation code and/or a comment. Activation codes and 
comments are separated by a semicolon character.  

 
3 0 . 7 . 8  H o w  t o  m a n a g e  m u l t i p l e  e d i t i o n s  o f  B o w T i e X P  
There are multiple editions of BowTieXP: 

• BowtieXP Standard (for regular users) 

• BowtieXP Advanced (contains many advanced features) 

• BowTieXP and IncidentXP (Allows Incident Analysis) 

• Audits add-on 

• Spreadsheets add-on 

• etc. 
 
All editions are run using the same executable. The activation code signals what edition will be 
started. 
 
Each edition of BowTieXP can be activated for a specific AD domain user group. It is often easiest to 
create a specific AD user group for each BowTieXP edition that will be used.  
 
For example: 

• ‘BowTieXPUsers’ 

• ‘BowTieXPAdvancedUsers’ 
 
After creating a new user group, an activation.dat file can be generated based on the group SID.  
 
Multiple activation files can be placed next to the executable. Each activation file’s filename should 
start with the string “activation” should have a “.dat” file extension. For example: 
 
CORRECT 

• Activation-Std.dat 

• Activation-Adv.dat 

• Activation-Nav.dat 
 
INCORRECT 

• Activation-Std.txt  (wrong file extension) 

• Std-Activation.dat  (does not start with “activation”) 
 
Note that the first file found which activates BowTieXP will be the file that gets used – BowTieXP will 
not keep searching for a “better” license, so it is up to you to ensure that the “best” license is tried 
first by giving it a filename that is alphabetically earlier than the other license files.  
 
When using the new style activation.dat files you should place the “best” license codes first in the file 
– they are tried first.  
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3 0 . 7 . 9  S t o r i n g  a c t i v a t i o n  d a t a  o n  t h e  n e t w o r k  

 

Note: Available since BowTieXP version 9.0.8 for regular codes and since 9.0.11 for plugin codes. 

 
By default, as well as in the examples above, the activation information is stored on the computer 
along with the software. The codes are present on all your computers.  
 
This would mean that updating the activation data would require redeploying of the application to 
update the activation files. Note that activation files need to be updated if e.g.: 

• Your feature set changes, because you purchased an add-on module 

• The number of licenses changes, so the maximum number of users in a group is changed. 

• Etc. 
 
If redeploying to update codes is problematic, note that it is also possible to configure BowTieXP to 
copy those files from the network. You can do this by placing an activation.dat file next to the 
bowtie.exe executable which contains the following text: 
 

; Copy activation files from the network: 
CopyFrom = \\someserver.intranet.domain.com\sharedfolder\some\folder 

 
In this manner, you can configure a regular path with a drive letter or a UNC path from where 
BowTieXP can copy activation code files.  
 
On startup, BowTieXP will read the activation.dat file next to the exe and read the configured 
network path to copy code files from. Those are then cached in %APPDATA%, in case the network 
could be unavailable in the future. 
 
With this configuration, you only need to update the codes in the central network location, if they 
ever change. 
 
Files copied must conform to the following pattern: 

• activation*.dat   For regular activation codes 

• pluginactivation*.dat  For plugin activation codes 

3 0 . 8  L A R G E  S C A L E  D E P L O Y M E N T  

BowTieXP/IncidentXP has been regularly deployed on large worldwide scale (hundreds of installs) 
without problems.  
 
Deployment of the software consists of two parts: 

• Installation 

• Activation 

 
3 0 . 8 . 1  I n s t a l l a t i o n  
The installation of the software is very simple – it consists of a single executable file (.exe) without 
external dependencies (apart from the .NET framework).  
 
During training sessions, we distribute the software on USB stick. This works as admin rights are not 
required to run the software. It runs straight of the USB stick. If the user so prefers, he can copy the 
software onto his desktop and it will run from there. 
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For actual installation, we also offer an msi that does a minimal set of actions: 

• Copy the exe to the program files folder 

• Add a start menu entry 

• Add a desktop shortcut 

• Registers itself in the “add & remove programs” control panel applet. 
File extension registration is done on start of the software. 
 
This msi is easily scripted by means of msiexec or by capturing the changes to the system. A sample 
script is included below. 

 
3 0 . 8 . 2  A c t i v a t i o n  
After getting the exe onto the system, the software has to be activated.  
 
For large-scale deployments, group activation is advised. All the licensed users are made members of 
a dedicated AD global or universal group. The SID (globally unique numerical group ID) of the group is 
the basis for an activation key, which allows everybody who is a member of that group to run the 
software. 
 
This key can be deployed along with the software in the scripted installation. If placed within a text 
file called “activation.dat”, and placed besides the exe, it will be automatically picked up. 
 
Group activation also has the advantage of allowing the customer to do license reassignment without 
our intervention – just substitute the user in the group. 

 
3 0 . 8 . 3  S a m p l e  i n s t a l l a t i o n  s c r i p t  
Below is a sample installation script (usable in software such as SCCM / SMS), which also copies the 
activation key into the correct directory: 
 
msiexec.exe /i "%~dp0BowTieXP-10.0.0.msi" /qb 
copy "%~dp0activation.dat" "C:\Program Files\BowTieXP\activation.dat" /y 

 

3 0 . 9  A C T I V E  D I R E C T O R Y  G R O U P  M A N A G E M E N T  

It is possible to give permission to regular users (users without domain admin permissions) to change 
the membership of specific AD security groups.  
 
This allows the IT department to delegate control of these groups to non-IT staff within the 
organization, offloading the IT department from tasks such as group membership. 
 
This section explains how to do this, from both an admin perspective (how to set it up), as well as 
from an end-user perspective (how to modify group membership). 

 
3 0 . 9 . 1  A d m i n :  d e l e g a t e  A D  g r o u p  m a n a g e m e n t  
In order to allow a non-admin user to modify the members of a group, the user requires read and 
write permission on the group object.  
 
In the example below, we will allow the user called “Demo User” to control who is a member of an 
Active Directory global security group called “BowTieXPUsers”. 
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1. As a domain admin, log onto a computer or domain controller with Active Directory Users 

and Computers (ADUC) installed. 

2. Open Active Directory Users and Computers (ADUC). 

3. Find the group you want to delegate membership management of (BowTieXPUsers). 

4. Right click the group and choose Properties: 

 

Figure 378 - AD Group right click 

5. Select the Security tab and choose Add: 

 

Figure 379 - AD Group properties 

6. Enter the user or group name to delegate permission to (Demo User) and click “Check 

Names” to ensure it was entered correctly. If so, the name will become underlined. 

 

Figure 380 - AD Group check names 

7. If the name is okay, press the OK button. The newly added username should be selected in 

the permission list, and we can now check the write permission checkbox. Ensure both the 

Read and Write permissions are checked: 
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Figure 381 - AD Group permissions 

8. Click OK to apply the changes. 

You are now done, and in the example above, the Demo User now has permission to modify the 
group membership of the BowTieXPUsers group. 
 
Please note: in general, permissions are best managed via groups, and never directly via user 
accounts, and as such, it is advised to create a group to hold the users who can modify the group 
membership (the manager group), grant the read and write permissions on the target group to this 
manager group, and add the managers to the manager group. 
 
Additionally, note that if you manage permissions via groups, and you make changes to group 
members, that those members might need to log off and back on again to refresh their membership 
and allow the new permissions to take effect – just like with BowTieXP AD group activation. 

 
3 0 . 9 . 2  R e g u l a r  u s e r :  H o w  t o  c h a n g e  g r o u p  m e m b e r s h i p s  
In order to review or modify the group members of an active directory group, we need to find the 
group in active directory.  
 

1. To do so, open a Windows (File) Explorer window. 

2. Click on the network node in the navigation tree on the left. 

3. Now click on the “Network” tab in the ribbon at the top. 

4. In the Network tab in the ribbon, there is an option called “Search Active Directory”: 

 

Figure 382 - Search Active Directory 
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 Note the location of the mouse, above the button, in the “Network” tab in the ribbon. 
 

5. Click the “Search Active Directory” button, and enter the group name to manage: 

 

Figure 383 - Search AD find now button 

6. If the group was found, it will appear in the find results: 

 

Figure 384 - Found AD group 

7. Double click the group to view or edit it: 

 

Figure 385 - AD Group properties 

Here you can use the add and remove buttons to change the group memberships. If you do not have 
permission, the buttons will be disabled (grayed out). 
 
Note: you can also bring up the “Search Active Directory” dialog by means of the following command 
line, e.g. for entry into Start / Run:  
 

rundll32 dsquery,OpenQueryWindow 
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3 0 . 1 0   P L U G I N  I N S T A L L A T I O N  

BowTieXP has support for plugins. Plugins are small pieces of computer code that extend BowTieXP 
with custom functionality, allowing CGE Risk to add customer functionality (as long as it falls within 
the possibilities offered by the plugin architecture / interface. 
 
One example of a plugin is our LOPA plugin, which extends BowTieXP with on-the-fly LOPA 
calculations on the bowties. See our LOPA plugin manual for more details.  
 

 Note: from version 10.0 onwards LOPA is no longer a plugin and is instead built-in, please contact 
support@cgerisk.com for more information.  

 
Plugins are delivered in files with a “.btpp” extension (short for BowTieXP Plugin Package). 
 
To install a plugin we take the following steps: 

• Download the plugin package from our web site. 

• Double click the btpp file. This will install the plugin. You will get a confirmation window like 
this: 

 

 

Figure 386: Plugin installation confirmation 

 

• You can now check everything went ok by going to Help -> Manage Plugins: 
 

 

Figure 387: Manage Plugins 

3 0 . 1 1   P L U G I N  A C T I V A T I O N  

Some plugins require an activation code, just like BowTieXP. The process is the same, except that you 
can have multiple activation codes for multiple plugins. Please note that plugins have the same host 
and site ids as BowTieXP. Make sure to send it along when you request your plugin activation code. 
 
To add a new plugin activation code: 

1. Navigate in the menu bar to Help -> Manage Plugins. 

mailto:support@cgerisk.com
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2. The Lopa plugin still needs to be activated with an activation key. To do this, I can select the 
plugin and click ‘Add an activation code’. This will give a popup where a valid activation key 
can be entered. 

 

 

Figure 388: Plugin requiring activation 

 
3. Once the activation key is added, it will be displayed in a dropdown. Right clicking a key will 

allow you to delete it if necessary. 
 

 

Figure 389: Managing plugin activation keys 

 
4. A restart of the software might be required before the plugin can be used. 

 
3 0 . 1 1 . 1  P l u g i n  a c t i v a t i o n  f o r  g r o u p  l o c k e d  c o d e s  
If you are doing a group locked activation, and want to deploy codes by means of a dat file, you can 
do the same for plugins. Please request your plugin activation code in a dat file from us, and we will 
supply one. This dat file will be picked up when placed next to the bowtie.exe executable, just like for 
regular activation codes. The name of this dat file must match the “pluginactivation*.dat” pattern. 

3 0 . 1 2   A C T I V A T I O N  F I L E  S E A R C H  L O C A T I O N S  

BowTieXP searches for activation files in the following locations: 
 
Program data:  %PROGRAMDATA%\Governors\BowTieXP\activation.dat 
User profile local app data: %LOCALAPPDATA%\Governors\BowTieXP\activation.dat 
Next to the executable: Wildcard pattern activation*.dat 
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31  
KEYBOARD SHORTCUTS 

3 1 . 1  G E N E R A L  

Keyboard shortcut Description 
Alt + 1 Navigate Back 
Alt + 2 Navigate Forward 
Alt + 4 Reports 
Alt + A Apply changes without closing the Edit window 
Alt + B Open from BowTieServer 
Alt + C Case menu 
Alt + D Diagram menu 
Alt + E Edit menu 
Alt + F File menu 
Alt + F1 Release notes 
Alt + H Help menu 
Alt + O Cancel BowTieServer checkout 
Alt + T Tools menu 
Alt + V View menu 
Ctrl + 1,2,3,4,5,6 Expand levels for current diagram 
Ctrl + Alt + C Copy bowtie diagram to clipboard 
Ctrl + D Import from external file 
Ctrl + F1 About 
Ctrl + H Text replace 
Ctrl + I Import from bowtie file 
Ctrl + L Open most recent file 
Ctrl + N New file 
Ctrl + O Open file 
Ctrl + S Save 
Ctrl + Shift + 1,2,3,4,5,6 Expand levels for all diagrams 
Ctrl + Shift + A Display options 
Ctrl + T Open Test File 
Ctrl + Y Redo 
Ctrl + Z Undo 
F1 Online help 
F11 Full screen 
F5 Refresh diagram 
F9 Choose UI language 
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3 1 . 2  W I N D O W S  

Keyboard shortcut Description 
Ctrl + Shift + B Bowtie Diagram 
Ctrl + Shift + C Case Overview 
Ctrl + Shift + E Editor (Deprecated) 
Ctrl + Shift + F Find results 
Ctrl + Shift + F12 Default window layout 
Ctrl + Shift + I Incident Diagram 
Ctrl + Shift + L Listview 
Ctrl + Shift + M Relationship Diagram 
Ctrl + Shift + N Incident Timeline Diagram 
Ctrl + Shift + O Overview 
Ctrl + Shift + Q Quality Checks 
Ctrl + Shift + S Scrap book 
Ctrl + Shift + T Tree view 
Ctrl + Shift + X Spreadsheets 
Ctrl + Shift + Z Color Legend 
F12 Switch to layout B 

 

3 1 . 3  S E L E C T I O N  A C T I O N S  

Keyboard shortcut Description 
Ctrl + B Show usage references 
Ctrl + C Copy selection 
Ctrl + Shift + R Repeat paste special 
Ctrl + Shift + V Paste special 
Ctrl + V Paste on selection 
Ctrl + X Cut selection 
Delete Delete selection 
F2 Edit selection 
Insert Add new item 

 

3 1 . 4  T R E E  V I E W  

Keyboard shortcut Description 
* (on numeric keypad) Expands the selected node and all children recursively. 
/ (on numeric keypad) Collapses the selected node and all children 

recursively. 
Left arrow Collapse the currently selected node. 
Right arrow Expand the currently selected node. 

 
  



 

©  W O L T E R S  K L U W E R  |  C G E  R i s k  2 0 2 0  
C O N F I D E N T I A L  A N D  P R O P R I E T A R Y  

 

B O W T I E X P  S O F T W A R E  
M A N U A L  

 

P A G E  2 8 8  

 

32  
FREQUENTLY ASKED QUESTIONS 

3 2 . 1  G E N E R A L  Q U E S T I O N S  

3 2 . 1 . 1  Q :  C a n  I  b e  k e p t  u p  t o  d a t e  a b o u t  n e w  r e l e a s e s ?  
Yes, just send an email to bowtiexp-releases-join@lists.cgerisk.com  to subscribe to the mailing list. 

3 2 . 2  I N S T A L L A T I O N  Q U E S T I O N S  

3 2 . 2 . 1  Q :  C a n  I  I n s t a l l  a n d  r u n  B o w T i e X P  o n  A p p l e  M a c  
( O S X ) ?  
The BowTieXP software is built for the Microsoft Windows operating system. Unfortunately, 
BowTieXP is not Apple Mac (OSX) compatible. Macs nowadays do have the ability to run Windows 
software on them. There are two main ways to go about that: 
 

1. Actually, install Microsoft Windows on your Mac using Boot Camp. You can switch between 
Windows and OSX, but it requires rebooting.  
(https://www.apple.com/support/bootcamp/) 

 
2. Emulate Microsoft Windows via a program such as Parallels.  

(https://www.parallels.com/eu/products/desktop/). 
 
Our advice is to run BowTieXP on the Microsoft Windows operating system (not emulated) as we 
support this option and it works best, but we have seen clients successfully use BowTieXP on their 
Mac by emulating Windows using products such as parallels. 
If cross platform support and device support is of interest to you, you might want to make your 
bowties easily accessible for viewing by (all) the employees in your organization by using our web 
viewer – a part of BowTieServer. The web viewer (for viewing only, not editing) is independent of 
operating system, as it is a web solution which runs on your browser. Therefore, it runs on Microsoft 
Windows, Apple Mac OSX, but also your iPads 

 
3 2 . 2 . 2  Q :  C a n  I  i n s t a l l  B o w T i e X P  o n  a  s e r v e r ?  
That depends on what is meant exactly – see the questions below regarding network shares and 
Terminal Server / Citrix. 

 
3 2 . 2 . 3  Q :  C a n  B o w T i e X P  r u n  o f f  a  n e t w o r k  s h a r e ?  
This is not advised, but yes, you can, provided that the network share is always available. 
If the software is running, and the network share becomes unreachable, the software will crash. 
Because of this, we do not recommend it. 

 
3 2 . 2 . 4  Q :  C a n  B o w T i e X P  r u n  u n d e r  T e r m i n a l  S e r v e r  o r  
C i t r i x  S e r v e r ?  
Yes, BowTieXP is fully compatible with Terminal Server and we have reports from customers it runs 
flawlessly on Citrix. You will need a group locked activation – host locked activation is not supported 
in this scenario. 

mailto:bowtiexp-releases-join@lists.cgerisk.com
https://www.apple.com/support/bootcamp/
https://www.parallels.com/eu/products/desktop/
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3 2 . 2 . 5  Q :  D o e s  B o w T i e X P  s u p p o r t  v i r t u a l i z a t i o n ?  
This depends on what is meant with virtualization: 
 

• If with virtualization you mean running the software on a remote server and showing the 

app via the network (also known as desktop virtualization/VDI), then the answer is yes –for 

Microsoft Terminal Server.  See the questions about Terminal Server and Citrix. 

 

• If virtualization refers to portable application generators like Spoon studio or VMware 

ThinApp, the answer is no, but this does not mean it will not work – just that we cannot 

support that scenario. Should any issues present, we will of course try to resolve those, but 

we cannot guarantee we can – some of those applications do some very complex things to 

the software. We know, we used some of those tools for previous BowTieXP versions. 

3 2 . 2 . 6  Q :  W h a t  r i g h t s / a c c e s s  d o e s  B o w T i e X P  n e e d  o n  
t h e  c o m p u t e r  t o  r u n  /  c a n  B o w T i e X P  b e  u s e d  i n  a  n o - t o u c h  
d e p l o y m e n t  s i t u a t i o n  /  i s  a  p o r t a b l e  v e r s i o n  a v a i l a b l e ?   
BowTieXP requires only regular user rights to function. BowTieXP adheres to the Microsoft standards 
about where to store data. In practice, this means: 
 
Configuration files are stored in the user’s application profile (in 
%APPDATA%\Governors\BowTieXP).  
 
Activation data is stored in the local part of the profile (%LOCALAPPDATA%\Governors\BowTieXP). 
 
If BowTieXP has admin rights, it will store activation data in the all users profile / application data 
path (%ALLUSERSPROFILE%\Governors\BowTieXP). 
 
If allowed, a registry entry will be added to HKCR for the file association and protocol handler. The 
association is stored in HKLM if allowed, else in HKCU. 
 

3 2 . 2 . 7  Q :  H o w  c a n  I  d e p l o y  a c t i v a t i o n  k e y s  a l o n g  w i t h  
t h e  a p p l i c a t i o n  /  w h e n  s c r i p t i n g  t h e  a p p l i c a t i o n ?  
You can place the codes in a text file names activationcodes.dat and place that next to the exe. They 
will be picked up automatically.  Note that all files which start with activation and end with .dat 
(activation*.dat) are tested. The first working code that is found is used. 
 
Note that instead of deploying the codes with the executable, you can also tell BowTieXP to copy the 
codes from a central network share (UNC path). See chapter 30.7.9 on page 279 for details. 
 
Plugin activation codes can also be placed next to the exe. The files must conform to the 
pluginactivation*.dat search pattern. 
 
If you have entered a code into BowTieXP, you can copy the activation codes file (“activation.dat”  or 
“pluginactivation.dat”) from one of the below folders and copy it next to the exe: 

• %PROGRAMDATA%\Governors\BowTieXP\ or  

• %APPDATA%\Governors\BowTieXP\ 
That ensures the format of the file is correct. Note that plugin activation files must be in the XML file 
format. 
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3 2 . 2 . 8  Q :  A c t i v a t i n g  a l l  t h e  l i c e n s e s  w e  b o u g h t  o n e  
c o m p u t e r  a t  a  t i m e  i s  t o o  m u c h  w o r k .  I s  t h e r e  a n  
a l t e r n a t i v e ?  
Yes – if your computers are domain computers you can activate the software by making the users 
members of a dedicated active directory group.  
 
The group has to be a global or universal security group. A code is generated for this group. The code 
works for all members of that group.  
 
The code contains a maximum number of users. If there are more users in the group than the 
maximum, the software will not run. 

 
3 2 . 2 . 9  Q :  G r o u p  l o c k e d  -  i f  I  c h a n g e  t h e  n u m b e r  o f  
l i c e n s e d  u s e r s  o r  t h e  t y p e  o f  l i c e n s e ,  d o  I  n e e d  t o  u p d a t e  
e a c h  c o m p u t e r ?  
It depends on your BowTieXP version. In the latest versions of BowTieXP (9.0.8 and newer), you can 
configure BowTieXP to copy code files from a central location (network UNC path). See chapter 
30.7.9 on page 279 for details. 
 
For older versions of BowTieXP, yes – when you purchase additional licenses, you will be issued a 
new activation code. This code has to be deployed to every computer where BowTieXP is installed. 
This can be done by IT updating the scripted installation package or by mailing the users so they can 
enter the new code manually. 

 
3 2 . 2 . 1 0  Q :  W h a t  a r e  t h e  s t e p s  t o  c r e a t e  t h i s  g r o u p -
l o c k e d  a c t i v a t i o n  c o d e ?  
This is also covered in-depth in our software manual.  
Short list of steps: 

1. Create group in AD 

2. Make all licensed users members of this group 

3. Send group SID or site id to us 

4. We respond with an activation key 

Here are the detailed instructions for doing so: 
 

1. Create a user group in Active Directory to hold the licensed accounts: e.g. "BowTieXPUsers". 
This can be done on a domain controller using the “Active Directory Users and Computers” 
MMC applet.  

 
2. Add all the user accounts that will be licensed into the group.  

 
3. We will need the group SID/site id (internal numerical group code) in order to calculate an 

activation code for this group. We will store this code into a small text file called activation.dat, 
which must be placed next to the BowTieXP executable so it can be found.  

 
The next step is retrieving this SID/site id. This can be done via BowTieXP, unless the number 
of groups on the server is very large. Then we recommend using the command line.  

 
A. Via BowTieXP: Start BowTieXP. The activation dialog will appear. If not, go to Help->Activation 

Codes. Click the blue link to show site licensing options also. Select the BowTieXPUsers group 
from the drop down. Send the site id to us. 
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B. Via the command line. Open up the command line and issue the following command for your 

own BowTieXP users group: 
 

wmic group where name='BowTieXPUsers' get sid 
 

and mail the SID (S-1-5-21-....) back to us.  
 

4. After receiving the code, we will create an unlock code for you and send this back in a small 
text file, called activation.dat, which must be placed next to the BowTieXP executable. After 
this, all members in the group should be able to run BowTieXP. 

 
Tips for testing:  

• Make sure the test user is actually a member of the group (this is often forgotten), 

• Group membership changes take effect after log-off and log-on.  

 
3 2 . 2 . 1 1  Q :  W i l l  g r o u p  a c t i v a t i o n  s t i l l  f u n c t i o n  i f  m y  
c o m p u t e r  i s  w i t h o u t  n e t w o r k  a c c e s s  f o r  a  l o n g  p e r i o d ?  
Yes. 

 
3 2 . 2 . 1 2  Q :  I  a m  t e s t i n g  B o w T i e X P  g r o u p  a c t i v a t i o n  b u t  I  
g e t  t h e  f o l l o w i n g  e r r o r :  “ A c t i v a t i o n  c o d e  d o e s  n o t  m a t c h  
a n y  o f  t h e  c u r r e n t  u s e r ’ s  g r o u p  m e m b e r s h i p s ” .  
Ensure the current user is a member of the activated group. You can verify this by letting BowTieXP 
show you the current user’s group membership. 

 
3 2 . 2 . 1 3  G r o u p  a c t i v a t i o n  i s  n o t  w o r k i n g ,  w h a t  s t e p s  c a n  I  
t a k e  t o  f i g u r e  o u t  w h a t  i s  w r o n g ?  
Group activation problems usually boil down to one of these three problems, where (b) is the most 
common problem.  
 
a) The group is not of the correct type  

The group is not a security group, but something else, such as a distribution group or an 
Azure AD group. 
 
The group must be a regular Microsoft Active Directory security group.  
 
If you accidentally created a distribution group, you can change the type without having to 
recreate the group. Please be careful to NOT recreate the group – it will get a new SID.  
 
Note that Azure AD is something completely different then ‘normal’ Active Directory and cannot 
be used for activation. 

 
b) The user is not a member of the group, or Windows has not refreshed the group list 

First of all, double check the user is a member of the group (e.g. in Active Directory Users and 
Computers). 
 
Second, you might need to wait for a while. Larger AD installations might have multiple servers. 
Those typically synchronize changes every two hours. 
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Third, you might need to log off and log back on again (or just reboot).  At logon, Windows makes 
a copy of all the security groups you are a member of, and uses this until you log off2.  
 
You can verify what Windows thinks of your current group membership using the command line: 
 
 GPRESULT /V 
 
And scroll back up for the security groups and look for the group you used for activation. 

 
If the group is not listed, you’ll need to check: 

(1) If the user is a member in e.g. Active Directory Users and Computers. 
(2) Make sure the AD servers are synced (i.e. wait for two hours). 
(3) Log off and log back on again. 

 
Note: If people working remotely, chances are the AD servers might not be reachable during log 
on. Typically, we see that VPN connections are opened after user logon. In that case you can try 
to define a system wide VPN connection and make sure it is connected already at the logon 
screen.  

 
c) The SID or SITE ID is incorrect, or the code is incorrect 

This can happen because e.g.: 

• The group was deleted and recreated with the same name 

• There was an error in the SID or SITE ID given to CGE Risk 

• CGE Risk copied the SID or SITE ID wrong or sent you the wrong one 
 

Verify the SID by retrieving it by name, and make sure it is the same as the SID you sent to CGE 
Risk. You can retrieve the SID by name on the command line: 
 

wmic group where name="BowTieXPUsers" get SID 
 
If you sent CGE Risk a SITE ID and not a SID, please note that the SITE ID contains the SID as well 
as the current number of group members. Therefore, the SITE ID can be different from time to 
time. Send it to CGE Risk to examine if it contains the same SID. 
 
You can also ask CGE Risk to verify if the code actually matches the SID – we can of course also 
make mistakes. 

 
3 2 . 2 . 1 4  Q :  T h e  u s e r  i s  a d d e d  t o  t h e  g r o u p  i n  a c t i v e  
d i r e c t o r y ,  b u t  B o w T i e X P  d o e s  n o t  p i c k  u p  t h i s  c h a n g e .  
There are several reasons why the change might not have taken effect yet: 

• Active directory servers need to synchronize before changes are applied. The default 

schedule is two hours. Wait at least this long and try again or ask the AD admins to force a 

sync. 

• The group membership info for the current user is only updated when logging on. Please log 

off and back on again to update the user’s group memberships (the security ‘token’). 

• If the activated group is a distribution group BowTieXP will not see it. Ensure it is a security 

group. You can double check this in AD users and computers by viewing the group 

properties. Security groups are the default group type. 

 
2 Windows does this so you can disconnect from the network and still keep working normally. 
This is also why the group must be a security group. Only security groups are cached in this way. 
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3 2 . 2 . 1 5  Q :  A c t i v a t i o n  e r r o r :  A c t i v a t i o n  c o d e  d o e s  n o t  
m a t c h  t h e  a c t i v a t e d  o r  c u r r e n t  h o s t  i d .  
Before you entered the activation key, the hardware was changed. Perhaps a laptop docking station 
was attached or detached.  
Solutions: 

1. Restore the original hardware situation. You need to close and open BowTieXP after 

changing this. 

a. If the docking station is connected, unplug the docking station and try again.  

b. If it is disconnected, try connecting it.  

2. If that does not work: Select “lock to this computer with an old host id”.  

a. If the box is empty: enter the original host id sent to us in the activated host id box.  

b. If it is not empty: Try clearing it. 

3. If both fail: Contact us for a new key. 

3 2 . 2 . 1 6  Q :  H o w  c a n  I  s c r i p t  t h e  i n s t a l l a t i o n ?  
The msi can be with the regular command line options: 
 

 msiexec.exe /i <msifile> /qb 
 
 If you want to also deploy the dat license file, you might need to capture changes to create a 
deployment script, or manually make sure the dat file is placed next to the exe. Another option is for 
end-users to enter it manually. Note that BowTieXP has no dependencies other than having the .NET 
Framework 4.7 or 4.8 installed. Deployment is xcopy deployment; all the msi does is: 

1. Copy the bowtie.exe file to C:\Program Files\BowTieXP\ 

2.  Add a shortcut to the start menu and the desktop. 

A sample script could look like this: 
 

msiexec.exe /i "%~dp0bowtiexp-10.0.0.msi" /qb 
copy "%~dp0activation.dat" "C:\Program Files\BowTieXP\activation.dat" 
/y 

 
The variable %0 in a batch script is set to the name of the executing batch file. The ~dp special syntax 
between the % and the 0 basically says to expand the variable %0 to show the drive letter and path, 
which gives you the current directory containing the batch file. 

 
3 2 . 2 . 1 7  Q :  W h a t  p r e r e q u i s i t e s  /  d e p e n d e n c i e s  d o e s  
B o w T i e X P  h a v e ?  
BowTieXP requires the .NET Framework 4.7 or 4.8 to be installed.  

 
3 2 . 2 . 1 8  Q :  C a n  I  d e p l o y  t e m p l a t e s  a l o n g  w i t h  t h e  
s o f t w a r e ?  
Yes, just place the btf files in a directory called “Templates” located next to the executable. They will 
be automatically picked up and built-in templates will be automatically hidden. 
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3 2 . 2 . 1 9  Q :  C a n  I  i n s t a l l  m u l t i p l e  v e r s i o n s  s i d e  b y  s i d e ?  I  
n e e d  t o  s u p p o r t  f i l e s  t h a t  m u s t  s t a y  i n  a n  o l d  f i l e  f o r m a t .  
Some people, for example consultants, need to run different versions of BowTieXP side by side in 
order to keep files in the file format their clients use. We have made sure that you can run different 
versions side by side, and from version 3.6.4 and onwards, we have added some more support in the 
software for this scenario: you can view the version in which a file was last saved. 
 
To view in which version a file was last saved, open it in BowTieXP and choose File->Properties. 

 
For example, assume we see that the file was written using a 3.6 version. Since all 3.6 versions share 
the same file format, we can edit this file using the latest 3.6 version and send it back to the person 
we got it from, and they will be able to read it without having to upgrade to the latest version. 
 
In order to run different versions of BowTieXP side by side, all we have to do is to download the 
different versions we want and make sure to grab the versions for manual installation (the zip files).  
 
All BowTieXP versions needed to support every file format version ever released, are available on the 
download page located at http://www.cgerisk.com/downloads/bowtiexp/index-all.php.  
 
Let us show by means of an example (the 2.3.0 file) how to install the correct version. We need 
BowTieXP 2.3.0 to edit this file without upgrading the file format. Go to the download page and 
locate 2.3.0. 
 
Download the executable (“in a zip file, for manual installation”). This zip file contains the bowtie.exe 
version 2.3.0. Unzip it to a suitable location, such as your desktop. You probably want to rename it to 
reflect the version number. 
 
After starting the older BowTieXP version, you might be confronted with an activation dialog. Contact 
us for an older key – we can put this into a small file called activation.dat that is automatically picked 
up by BowTieXP, so you do not need to enter the key manually. Just make sure the file is located next 
to the executable. 

 
3 2 . 2 . 2 0  Q :  H o w  d o e s  t h e  a u t o  u p d a t e  w o r k ?   
The behavior of the auto-update depends on the way in which BowTieXP was installed.  
BowTieXP can be installed in two ways: 

1. Via the msi 

2. By placing the exe somewhere on the system  

If an update is available, the following will happen if the user requests it / clicks the notification: 
 
In the first case (msi installed), BowTieXP will download the msi and ask Windows to install it, 
upgrading the old installation. Windows will ask for admin credentials if the current user is not an 
administrator. 
 
In the second case (installed from zip file), BowTieXP will download the new exe and replace the 
current one. If the user has no write access to the exe no attempt will be made (i.e. the update check 
is notification only, auto-upgrade is not possible). 

 
3 2 . 2 . 2 1  Q :  H o w  c a n  I  d i s a b l e  t h e  a u t o - u p d a t e ?  
To disable the auto-update, the read-only bit on the file can be set. This will disable all upgrade 
functionality. In this case the software will still check for updates (if requested or if the periodic check 
is enabled), but it will only be a notification, no attempt at auto-upgrading is done. 

http://www.cgerisk.com/downloads/bowtiexp/index-all.php
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3 2 . 2 . 2 2  Q :  H o w  o f t e n  a r e  u p d a t e s  a n d  u p g r a d e s  
r e l e a s e d ?  W h a t  i s  y o u r  r e l e a s e  s c h e d u l e ?  
BowTieXP has regular updates, addressing bugs. These versions are recognizable by having the same 
first two numbers but a new third number. E.g. if you have 5.2.2, then version 5.2.3 will have the 
exact same functionality but less bugs. The same goes for versions 5.2.4, 5.2.5 etc. 
 
Once or twice per year, we also bring out a new version with new functionality. The version with new 
functionality will have a new file format to accommodate the new features. To indicate this, we 
change the first and/or second version numbers. E.g., we go from 5.0 to 5.2. 
 
If keeping up with the new versions is a challenge, it is advisable to pick a version to stay with for a 
longer time. Only when users are running into bugs or if critical bugs are discovered and fixed, should 
a new version with fixes be deployed. To prevent this, it is advisable to wait a while when a new 
version with new functionality is released before deploying it, allowing more time for bugs to be 
fixed before that version is deployed. 

 
3 2 . 2 . 2 3  Q :  I  g e t  a n  e x c e p t i o n  a b o u t  “ n o  m o r e  f i l e s ”  o n  
s t a r t u p  w h e n  t r y i n g  t o  r u n  B o w T i e X P  d e p l o y e d / v i r t u a l i z e d  
w i t h  A p p - V  
We have seen this problem when during scripting; one of the directories used by BowTieXP was 
monitored and should have been excluded. In that case the directory that should have been excluded 
was: 
 

%APPDATA%\Governors\BowTieXP\Backups 
 
After excluding this directory, the software worked correctly. See here for someone with a similar 
problem, but for a different software product (not related to us): 
 
http://www.danieletosatto.com/2010/09/09/fix-rssowl-virtualized-with-microsoft-app-v-fails-to-
launch-after-the-first-attempt/  

 
3 2 . 2 . 2 4  Q :  P l u g i n s  d o  n o t  s e e m  t o  l o a d  b u t  a r e  p l a c e d  i n  
t h e  r i g h t  l o c a t i o n .  
Please check to see if you are running BowTieXP from a network location. Plugins can only be loaded 
from the local hard disk, not from a network drive. 

3 2 . 3  Q :  S O F T W A R E  Q U E S T I O N S  

3 2 . 3 . 1  Q :  C a n  I  c o n v e r t  d i a g r a m s  t o  p d f ?  
Yes – either copy the diagram to the clipboard, paste in Word/Excel/Visio 2007 or higher. You can 
save the file as a pdf from Office. 
 
Another option is to print to a pdf printer, but in our experience, the Office route offers better image 
quality. 

 
3 2 . 3 . 2  Q :  W h i c h  O f f i c e  v e r s i o n s  d o e s  B o w T i e X P  
s u p p o r t ?  
We support all office versions higher than Office 2000.  

 
3 2 . 3 . 3  Q :  W h i c h  V i s i o  v e r s i o n s  d o e s  B o w T i e X P  s u p p o r t ?  

http://www.danieletosatto.com/2010/09/09/fix-rssowl-virtualized-with-microsoft-app-v-fails-to-launch-after-the-first-attempt/
http://www.danieletosatto.com/2010/09/09/fix-rssowl-virtualized-with-microsoft-app-v-fails-to-launch-after-the-first-attempt/
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We support Visio 2002 and higher. See paragraph 13.4 for Visio diagram exporting details. 

 
3 2 . 3 . 4  Q :  C a n  I  s a v e  f i l e s  t o  a n  o l d e r  f i l e  f o r m a t ?  
This is unfortunately not possible. You might be able to convert a file back to an older version by 
means of the Scrap book – the Scrap book has somewhat better forward compatibility because the 
Scrap book exchange file format is being kept as constant as possible.  
 
Unfortunately, after the introduction of BowTieServer, some Scrap book file format changes had to 
be made. Introducing a new file format always leads to the situation where “old” versions of the 
software will not be able to read the “new” Scrap book file format. The “old” Scrap book format is 
supported up to versions 6.2.7 of BowTieXP. The new Scrap book exchange format was introduced in 
version 6.2.8 of BowTieXP. 
 

Note: be sure to use the latest version of the target version (i.e. if you need to convert to file format 4.2, be sure to 
use the latest 4.2 version in this case 4.2.9). 

 
For example, here are the steps to take to down-convert a file from v5.2 to v5.0 

1. Open 5.2 and 5.0 side by side and ensure you are running BowtieXP Advanced. Ensure the 

Scrap book is visible in both. Open 5.2 on the left, 5.0 on the right. 

2. Open the file to convert in 5.2. Create a new file in 5.0 on the right. Empty ALL the lookup 

table entries in the destination file. 

How to move items from 5.2 on the left to 5.0 on the right: 
a. Drag items from the tree view onto the Scrap book in 5.2 (left) onto the Scrap book. Save 

the Scrap book. In 5.0 on the right, click the load Scrap book button and open the file. 

b. Drag the items in 5.0 (right) to the correct bowtie group in the tree view. 

Note: this mini guide is not verified for completeness / i.e. it might not be an exhaustive list! 

 

3. Transfer the contents of all lookup tables, starting from the top and working your way down. 

Include activities, document links, etc. 

4. Manually recreate the risk matrices. This has to be done by hand. 

a. Recreate the categories. 

b. Recreate the matrices themselves. 

c. Use the copy matrix function where possible. 

5. Terminology. Export the terminology from 5.2 to Excel. Try to import in 5.0. Errors will be 

given, fix each by hand and try until it succeeds. Fixing involves removing lines of terminology 

that 5.0 does not understand. 

6. Transfer all incidents and bowtie groups using the Scrap book. This is done in the same 

manner as the lookups. 

7. Save the spreadsheet if any. Load into 5.0. Check for moved columns and adjust accordingly 

until the calculations are in order again. 

8. Verify completeness using the Case File compare function. 

9. Check the following and transfer manually if needed: 

a. Null value descriptions and colors. 

b. File property fields (File->Properties). 

c. Tree view filter profiles. 

d. Tree view tooltips. 

e. Diagram display profiles. 

f. Verify font settings. 
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g. Header and footer layout. 

Now most items should be transferred.  

3 2 . 4  Q :  S O F T W A R E  P R O B L E M S  

3 2 . 4 . 1  Q :  P r i n t i n g  d o e s  n o t  w o r k / c r a s h e s .  
There are some incompatibilities between .NET and some printer drivers, which unfortunately we 
can do nothing about. If printing does not work for you, please copy the diagram to the clipboard and 
paste in Word, Excel or Visio and print for there. Excel has very good multi-page printing support. 

 
3 2 . 4 . 2  Q :  S t a r t u p  o f  t h e  s o f t w a r e  t a k e s  v e r y  l o n g .  
We have reports from Sophos users that starting the software the first time takes quite long – 
apparently, Sophos wants to take a detailed look. This problem goes away by itself. Otherwise, you 
can whitelist the application in Sophos. 
 
Note: BowTieXP normally starts in a couple of seconds. 

 
3 2 . 4 . 3  Q :  W h e n  o p e n i n g  B o w T i e X P ,  I  g e t  a n  e r r o r  
m e s s a g e  a b o u t  f o n t s .  
Please install the Microsoft European Union Expansion Font Update: 
ttp://www.microsoft.com/en-us/download/details.aspx?displaylang=en&id=16083  

 
3 2 . 4 . 4  Q :  I  c a n  n o  l o n g e r  s a v e  d o c u m e n t s  a s  p d f  i f  t h e y  
h a v e  b o w t i e  i m a g e s  i n  i t  ( O f f i c e  2 0 0 7 )  
This is a known incompatibility with Office 2007 – the images generated by BowTieXP version 5.0 or 
earlier cannot be converted to pdf by the Office 2007 pdf add-in. 
 
This used to work okay but stopped working due to a change in Office, by means of Windows 
Update, and started in April 2012. Office was changed and now no longer can make pdfs of those 
documents. 
 
There are several resolutions, listed in order of preference: 

• Upgrade to Office 2010. Office 2010 does not have this problem. 

• Use an external PDF printer - free ones exist such as http://www.bullzip.com/. 

• Upgrade to BowTieXP v5.2 and redo the graphics.  

 
  

http://www.microsoft.com/en-us/download/details.aspx?displaylang=en&id=16083
http://www.bullzip.com/
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33  
SUPPORT 

3 3 . 1  B O W T I E X P  H E L P D E S K  

For users that have bought BowTieXP with support and maintenance a helpdesk is available. This 
helpdesk assists people that have technical and user-related questions regarding BowTieXP, how to 
install it and how to use it to its fullest extent.  
 
You can reach the BowTieXP helpdesk by e-mail at support@cgerisk.com or by telephone on +31 (0) 
88 1001 350.  
 
Please refer to www.cgerisk.com for our BowTieXP Support & Maintenance Brochure. It explains 
what customers receive when purchasing support & maintenance. 

 

 

 

 

mailto:support@cgerisk.com
http://www.bowtiexp.com/

